Knowledge Worker System Version 2.5 Reference Guide

by
Sandra Kappes

The Knowledge Worker System (KWS) is an automated tool that enables an organization to define the tasks, information resources, and computer applications required to perform their business processes. Essentially, the information within KWS is an on-line process model for an organization. KWS represents process information in a temporal hierarchical task structure. This structure contains information about the tasks that need to be done and when. Anywhere within this structure, procedural details, information resources, and computer applications can be associated with an individual task via steps, attachments, and Do its, respectively. These components provide an organization with help in executing tasks and in some cases with automatic task execution.

This reference guide describes KWS functionality and provides KWS users with detailed instructions on using KWS Version 2.5.
The contents of this report are not to be used for advertising, publication, or promotional purposes. Citation of trade names does not constitute an official endorsement or approval of the use of such commercial products. The findings of this report are not to be construed as an official Department of the Army position, unless so designated by other authorized documents.

**DESTROY THIS REPORT WHEN IT IS NO LONGER NEEDED**

**DO NOT RETURN IT TO THE ORIGINATOR**
USER EVALUATION OF REPORT

REFERENCE: USACERL ADP Report 97/41, Knowledge Worker System Version 2.5 Reference Guide

Please take a few minutes to answer the questions below, tear out this sheet, and return it to USACERL. As user of this report, your customer comments will provide USACERL with information essential for improving future reports.

1. Does this report satisfy a need? (Comment on purpose, related project, or other area of interest for which report will be used.)

   ______________________________________________________
   ______________________________________________________
   ______________________________________________________
   ______________________________________________________

2. How, specifically, is the report being used? (Information source, design data or procedure, management procedure, source of ideas, etc.)

   ______________________________________________________
   ______________________________________________________
   ______________________________________________________

3. Has the information in this report led to any quantitative savings as far as manhours/contract dollars saved, operating costs avoided, efficiencies achieved, etc.? If so, please elaborate.

   ______________________________________________________
   ______________________________________________________

4. What is your evaluation of this report in the following areas?
   a. Presentation: ______________________________________
   b. Completeness: _____________________________________
   c. Easy to Understand: _________________________________
   d. Easy to Implement: _________________________________
   e. Adequate Reference Material: _________________________
   f. Relates to Area of Interest: __________________________
   g. Did the report meet your expectations? _________________
   h. Does the report raise unanswered questions? ___________
i. General Comments. (Indicate what you think should be changed to make this report and future reports of this type more responsive to your needs, more usable, improve readability, etc.)

5. If you would like to be contacted by the personnel who prepared this report to raise specific questions or discuss the topic, please fill in the following information.

   Name: ____________________________
   Telephone Number: ____________________________
   Organization Address: ____________________________

6. Please mail the completed form to:

   Department of the Army
   CONSTRUCTION ENGINEERING RESEARCH LABORATORIES
   ATTN: CECER-TR-I
   P.O. Box 9005
   Champaign, IL  61826-9005
# Knowledge Worker System Version 2.5 Reference Guide

Sandra Kappes

U.S. Army Construction Engineering Research Laboratories (USACERL)
P.O. Box 9005
Champaign, IL 61826-9005

Headquarters, U.S. Army Corps of Engineers (HQUSACE)
ATTN: CEMP-MC
20 Massachusetts Avenue, NW
Washington, DC 20314-1000

Copies are available from the National Technical Information Service, 5285 Port Royal Road, Springfield, VA 22161.

Approved for public release; distribution is unlimited.

The Knowledge Worker System (KWS) is an automated tool that enables an organization to define the tasks, information resources, and computer applications required to perform their business processes. Essentially, the information within KWS is an on-line process model for an organization. KWS represents process information in a temporal hierarchical task structure. This structure contains information about the the tasks that need to be done and when. Anywhere within this structure, procedural details, information resources, and computer applications can be associated with an individual task via steps, attachments, and Do Its, respectively. These components provide an organization with help in executing tasks and in some cases with automatic task execution.

This reference guide describes KWS functionality and provides KWS users with detailed instructions on using KWS Version 2.5.
Foreword

This study was conducted for the Directorate of Military Programs, Headquarters, U.S. Army Corps of Engineers under Military Interdepartmental Purchase Request No. 95168DEA06. The technical monitor was John Sheehy, CEMP-MC.

The work was performed by the Business Processes Division (PL-B) of the Planning and Management Laboratory (PL), U.S. Army Construction Engineering Research Laboratories (USACERL). The USACERL Project Leader was Wayne Schmidt, and Principal Investigators were Sandra Kappes, Beverly Thomas, and Dave Tomlinson. Moonja P. Kim is Acting Chief, CECER-PL-B and L. Michael Golish is Operations Chief, CECER-PL. The USACERL technical editor was Linda L. Wheatley, Technical Information Team.

COL James T. Scott is Commander and Dr. Michael J. O'Connor is Director of USACERL.
## Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Pages</th>
</tr>
</thead>
<tbody>
<tr>
<td>SF 298</td>
<td>1</td>
</tr>
<tr>
<td>Foreword</td>
<td>2</td>
</tr>
<tr>
<td>List of Figures</td>
<td>5</td>
</tr>
<tr>
<td><strong>1 The KWS User Interface</strong></td>
<td></td>
</tr>
<tr>
<td>Overview</td>
<td>1-2</td>
</tr>
<tr>
<td>The KWS Program Window</td>
<td>1-2</td>
</tr>
<tr>
<td>Selecting Multiple Window Items</td>
<td>1-19</td>
</tr>
<tr>
<td>Searching Windows for Text Strings</td>
<td>1-20</td>
</tr>
<tr>
<td>The Messages Option</td>
<td>1-21</td>
</tr>
<tr>
<td>The Notes Command</td>
<td>1-24</td>
</tr>
<tr>
<td>Logging In to KWS</td>
<td>1-25</td>
</tr>
<tr>
<td>Refreshing Information in KWS Windows</td>
<td>1-26</td>
</tr>
<tr>
<td>Printing From KWS</td>
<td>1-26</td>
</tr>
<tr>
<td>Listing the Contents of the KWS Database</td>
<td>1-27</td>
</tr>
<tr>
<td><strong>2 The ToDo List</strong></td>
<td></td>
</tr>
<tr>
<td>Overview</td>
<td>2-1</td>
</tr>
<tr>
<td>The ToDo List Window</td>
<td>2-2</td>
</tr>
<tr>
<td>Manipulating Tasks in the ToDo List</td>
<td>2-4</td>
</tr>
<tr>
<td>Options for Viewing the ToDo List</td>
<td>2-6</td>
</tr>
<tr>
<td><strong>3 Tasks and Steps</strong></td>
<td></td>
</tr>
<tr>
<td>Overview</td>
<td>3-1</td>
</tr>
<tr>
<td>Task Definition</td>
<td>3-2</td>
</tr>
<tr>
<td>The Task Window</td>
<td>3-2</td>
</tr>
<tr>
<td>The Task Manager</td>
<td>3-18</td>
</tr>
<tr>
<td>Cyclic Tasks</td>
<td>3-19</td>
</tr>
<tr>
<td>Predecessor and Successor Relationships</td>
<td>3-24</td>
</tr>
<tr>
<td>Milestones</td>
<td>3-29</td>
</tr>
<tr>
<td>The Graphical Task Manager</td>
<td>3-32</td>
</tr>
<tr>
<td>Steps</td>
<td>3-33</td>
</tr>
<tr>
<td><strong>4 Attachments</strong></td>
<td></td>
</tr>
<tr>
<td>Overview</td>
<td>4-1</td>
</tr>
<tr>
<td>Defining Attachments</td>
<td>4-2</td>
</tr>
</tbody>
</table>
The Attachments Window .................................................. 4-8
Moving, Copying, and Linking Attachments .......................... 4-14
Creating Sensitive Attachments ........................................ 4-17
Attachment File Storage .................................................. 4-18
Searching Attachments ................................................... 4-21
Attachment Access Rights .............................................. 4-23
Workflow ................................................................. 4-24

5 Do Its .......................................................................... 5-1
Overview ......................................................................... 5-2
Do Its ............................................................................ 5-2
Time Agents ..................................................................... 5-9
DoltBase ......................................................................... 5-13

6 Task Palette ................................................................... 6-1
Overview ......................................................................... 6-2
Using the Task Palette .................................................... 6-2

7 Customizing KWS .......................................................... 7-1
Overview ......................................................................... 7-2
KWS Program Window Configuration .................................. 7-2
Font and Data Display Preferences ..................................... 7-3
Attachment Options ........................................................ 7-10
Knowledge Workers and Work Groups ............................... 7-17
KWS Database and File Storage Setup ............................... 7-23
Adding Items to the Tools Menu ......................................... 7-25

Index .............................................................................. Index 1

Distribution
# List of Figures

<table>
<thead>
<tr>
<th>Figures</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1-1</td>
<td>KWS Program Window</td>
<td>1-2</td>
</tr>
<tr>
<td>1-2</td>
<td>Search Window</td>
<td>1-20</td>
</tr>
<tr>
<td>1-3</td>
<td>The New Messages Dialog Box</td>
<td>1-21</td>
</tr>
<tr>
<td>1-4</td>
<td>The Messages Window</td>
<td>1-22</td>
</tr>
<tr>
<td>1-5</td>
<td>The Messages Window Button Bar</td>
<td>1-22</td>
</tr>
<tr>
<td>1-6</td>
<td>The Message Dialog Box</td>
<td>1-23</td>
</tr>
<tr>
<td>2-1</td>
<td>ToDo Window</td>
<td>2-2</td>
</tr>
<tr>
<td>2-2</td>
<td>ToDo Window</td>
<td>2-7</td>
</tr>
<tr>
<td>2-3</td>
<td>ToDo Completed Items Window</td>
<td>2-7</td>
</tr>
<tr>
<td>2-4</td>
<td>ToDo Ongoing Items Window</td>
<td>2-8</td>
</tr>
<tr>
<td>2-5</td>
<td>ToDo Calendar Window</td>
<td>2-8</td>
</tr>
<tr>
<td>2-6</td>
<td>Appointment Dialog Box</td>
<td>2-11</td>
</tr>
<tr>
<td>2-7</td>
<td>Delete? Dialog Box</td>
<td>2-11</td>
</tr>
<tr>
<td>2-8</td>
<td>ToDo Browser Window</td>
<td>2-12</td>
</tr>
<tr>
<td>3-1</td>
<td>The Task Dialog Box</td>
<td>3-2</td>
</tr>
<tr>
<td>3-2</td>
<td>Task Security Dialog Box</td>
<td>3-12</td>
</tr>
<tr>
<td>3-3</td>
<td>Task Group Status Window</td>
<td>3-14</td>
</tr>
<tr>
<td>3-4</td>
<td>Task Description Dialog Box</td>
<td>3-15</td>
</tr>
<tr>
<td>3-5</td>
<td>Task Window</td>
<td>3-19</td>
</tr>
<tr>
<td>3-6</td>
<td>Task Manager Window</td>
<td>3-19</td>
</tr>
<tr>
<td>3-7</td>
<td>Task Structure With Predecessor/Successor Relationships</td>
<td>3-30</td>
</tr>
<tr>
<td>3-8</td>
<td>Defining a Milestone</td>
<td>3-32</td>
</tr>
<tr>
<td>3-9</td>
<td>Milestones Window</td>
<td>3-33</td>
</tr>
<tr>
<td>3-10</td>
<td>Milestone Dialog Box</td>
<td>3-33</td>
</tr>
<tr>
<td>3-11</td>
<td>Graphical Task Manager</td>
<td>3-34</td>
</tr>
<tr>
<td>3-12</td>
<td>Graph Preferences Window</td>
<td>3-41</td>
</tr>
<tr>
<td>3-13</td>
<td>Select Color Window</td>
<td>3-42</td>
</tr>
<tr>
<td>3-14</td>
<td>Step Window</td>
<td>3-43</td>
</tr>
<tr>
<td>3-15</td>
<td>Steps Window</td>
<td>3-44</td>
</tr>
<tr>
<td>4-1</td>
<td>The Attachment Profile Dialog Box</td>
<td>4-2</td>
</tr>
<tr>
<td>4-2</td>
<td>Attachment Access Rights Dialog Box</td>
<td>4-6</td>
</tr>
<tr>
<td>4-3</td>
<td>Attachment Links Window</td>
<td>4-8</td>
</tr>
<tr>
<td>4-4</td>
<td>The Attachments Window</td>
<td>4-8</td>
</tr>
<tr>
<td>4-5</td>
<td>The Attachments Button Bar</td>
<td>4-9</td>
</tr>
<tr>
<td>4-6</td>
<td>Attachment Insert Dialog Box</td>
<td>4-10</td>
</tr>
</tbody>
</table>
4-7 The Delete? Dialog Box for Attachments .......................... 4-11
4-8 Attachment Delete Dialog Box ........................................ 4-11
4-9 Copy Links? Dialog Box ............................................. 4-14
4-10 Attachment Link Relationships .................................... 4-15
4-11 Modify Attachment Links Dialog Box ............................. 4-16
4-12 Attachment Access Rights Dialog Box With Sensitive Box Checked ... 4-18
4-13 Attachment Profile Dialog Box with Media Info... Button .......... 4-19
4-14 Save to Removable Media Dialog Box ............................... 4-20
4-15 Insert Removable Media Dialog Box ............................... 4-20
4-16 Attachment Search Dialog Box ..................................... 4-21
4-17 Attachment Search Results Window ................................ 4-23
4-18 Attachment Access Rights Dialog Box ............................. 4-24
4-19 Workflow Definition Dialog Box ................................. 4-26
4-20 Workflow Process ..................................................... 4-27
5-1 Do It Dialog Box ......................................................... 5-2
5-2 Do Its Window .......................................................... 5-6
5-3 Do It Window Button Bar ............................................. 5-7
5-4 Confirm Move or Copy Dialog Box ................................... 5-8
5-5 KWS TimeAgent Window ............................................ 5-10
5-6 TimeAgent Event Detail Window ...................................... 5-11
5-7 KWS DoltBase Window ............................................... 5-14
5-8 Open DoltBase Dialog Box .......................................... 5-14
5-9 KWS DoltBase Window With an Open DoltBase Database ......... 5-15
5-10 Add DoltBase Dialog Box ........................................... 5-15
5-11 Archive Detail Dialog Box ........................................ 5-16
5-12 View Zip File Window ................................................. 5-18
5-13 DoltBase Properties Dialog Box ................................... 5-19
5-14 Find Dialog Box for Searching a DoltBase ....................... 5-20
6-1 KWS Palette Window .................................................. 6-2
6-2 Open Palette Dialog Box ............................................. 6-3
6-3 KWS Palette Window With an Open Task Palette .................. 6-3
6-4 Task Palette Save As Dialog Box ................................... 6-4
6-5 Task Attributes Dialog Box ......................................... 6-5
6-6 Delete Palette Dialog Box ........................................... 6-5
6-7 Palette Permissions Dialog Box ..................................... 6-7
6-8 Task Dialog Box ....................................................... 6-8
7-1 Font Window ............................................................ 7-3
7-2 Display Field Setup Window ........................................ 7-4
7-3 Page Setup Window ................................................... 7-6
7-4 Print Ids Window ...................................................... 7-7
7-5 Print Field Setup Window ............................................ 7-8
7-6 File Extension Association ......................................... 7-11
7-7 Select File Viewer Window ........................................ 7-12
7-8 Application List Dialog Box ...................................... 7-13
7-9  Knowledge Workers Window ........................................ 7-17
7-10 Knowledge Worker Dialog Box ..................................... 7-18
7-11 Work Groups Containing <user ID> Window ....................... 7-19
7-12 Work Groups Window ................................................. 7-20
7-13 Work Group Dialog Box ............................................... 7-21
7-14 KWS Database Setup Dialog Box ..................................... 7-23
7-15 KWS Databases Window ............................................... 7-25
# Chapter 1 THE KWS USER INTERFACE

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview</td>
<td>1-2</td>
</tr>
<tr>
<td>The KWS Program Window</td>
<td>1-2</td>
</tr>
<tr>
<td>Selecting Multiple Window Items</td>
<td>1-19</td>
</tr>
<tr>
<td>Searching Windows for Text Strings</td>
<td>1-20</td>
</tr>
<tr>
<td>The Messages Option</td>
<td>1-21</td>
</tr>
<tr>
<td>The Notes Command</td>
<td>1-24</td>
</tr>
<tr>
<td>Logging In to KWS</td>
<td>1-25</td>
</tr>
<tr>
<td>Refreshing Information in KWS Windows</td>
<td>1-26</td>
</tr>
<tr>
<td>Printing from KWS</td>
<td>1-26</td>
</tr>
<tr>
<td>Listing the Contents of the KWS Database</td>
<td>1-27</td>
</tr>
</tbody>
</table>
OVERVIEW

To get the most from the Knowledge Worker System (KWS) you must understand the main window, known as the KWS Program Window. All KWS operations are accessible from this window. This chapter provides a description of the KWS Program Window as well as the options and commands within it. In addition, this chapter describes general capabilities provided by KWS. These capabilities include selecting multiple window items, searching for text strings in windows, sending messages to other KWS users, writing quick notes while in KWS, and logging in to KWS.

THE KWS PROGRAM WINDOW

The KWS Program Window is the primary graphical interface between the user and KWS. The Program Window is the first screen that appears after you log in to KWS (Figure 1-1).

![Figure 1-1: KWS Program Window](image)

The KWS Program Window has a Title Bar across the top that displays the User ID of the person currently logged into KWS. The Menu Bar appears just below the Title Bar. It contains several pull-down menus that offer system features and operations relevant to the active window. The Button Bar appears just below the Menu Bar. Each button within the Button Bar will activate a single operation. The available operations depend on which window is active within the Workspace Area directly below the Button Bar. The Workspace Area is the largest display area in the KWS Program Window. The contents of the Workspace Area depend on the selections made from the Menu and Button Bars. By default, the ToDo Calendar Window is displayed in the Workspace Area when you first open KWS.
Directly below the Workspace Area is the Status Bar, which is divided into three regions. The leftmost region displays short descriptions of pull-down menu items. The center region displays the name of the current database connection. The rightmost region displays a number that indicates the position of the currently selected item in the active window, as well as the total number of items listed.

Menu Bar Options

The Menu Bar contains several pull-down menus that offer system features and operations for the active window. Clicking once on the title of any menu item will cause that menu’s options to appear. Clicking elsewhere on the screen will close the menu.

The File Menu

The File Menu contains options that enable you to view KWS-related messages from other users, login to the KWS Database, print the contents of a window, and set preferences for customizing KWS.

Messages

This option opens the Messages Window, which contains system-generated notifications that tell you that another user has assigned a new task to you, deleted an assigned task, or performed some similar action. The Messages Window may also contain user-generated messages. See The Messages Option in this chapter for more detail on this option.

Login...

This option opens the Login Dialog Box, which enables you to log into any KWS database you have been connected to via the Admin Menu, Database, Setup Database Connections option. See Logging in to KWS in this chapter for more detail on this option.

Print

This option is a single action command that sends the contents of the active window to the default printer specified in the Windows Control Panel. KWS will add the current date to the top of the printout. THE GRAPHICAL VIEWS CANNOT BE PRINTED USING THIS COMMAND. To print the graphical views, use the Windows Clipboard (Alt-Print Screen) and a Windows Graphics program such as Paintbrush.

Preferences

This option opens a submenu containing further options for customizing the appearance of the KWS Program Window, setting font and print options, and defining information for manipulating attachments. See Chapter 7, Customizing KWS, for more detail on setting preferences.
Show Status Bar
This option allows you to specify whether the Status Bar will be displayed in the KWS Program Window. If the **Show Status Bar** option has a check mark next to it, the Status Bar will be displayed. If not checked, it will not be displayed.

Show Button Bar
This option allows you to specify whether the Button Bar will be displayed in the KWS Program Window. If the **Show Button Bar** option has a check mark next to it, the Button Bar will be displayed. If not checked, it will not be displayed.

Save Window Configuration
This option allows you to save the current window configuration within KWS. When checked, this action will save the current size and location of all windows in the KWS workspace. These windows will then be displayed each time you log in to KWS until you save a new configuration. The contents of a Graphical Task Manager Window, attachment query windows, and Do It search windows are not saved.

Display Font...
This option allows you to select the font, font style, and font size displayed in your KWS windows.

Printer Font...
This option allows you to select the font, font style, and font size in which the content of text-based KWS windows will be printed.

Printer Page Setup...
This option allows you to set some standard Windows page setup options such as page width and length, margins, headers, and footers.

Application List
This option enables you to define the information KWS requires before it can launch the application program used to create or edit an attachment. See Chapter 7, Customizing KWS, for more detail on this option.

Associations
This option enables you to define Windows File Manager association information. When importing attachment files, KWS uses this information to determine the associated application. See Chapter 7, Customizing KWS, for more detail on this option.
File Viewer

This option allows you to specify the file viewer that KWS will use to view attachments. A File Viewer is a software package that displays the contents of a file as it would normally be displayed in the application that created it. If a File Viewer is not specified, you will not be able to view an attachment without the application package used to create it. See Chapter 7, Customizing KWS, for more detail on this option.

Exit KWS

This option is a single action command that closes the KWS application. It has the same effect as double-clicking on the File Menu Box in the upper-left corner of the KWS Program Window.

The Edit Menu

The Edit Menu contains options that enable you to copy and paste text from KWS windows and to select items within KWS windows.

Copy

This option will copy the selected items to the clipboard.

Paste

This option will insert the contents of the clipboard into the current window.

Select All

This option is a single-action command that causes all items in the active window to be highlighted. Select All is used to perform an operation such as moving or deleting all of the items in a window. Multiple items in a window can be selected by using Select All, and then deselecting specific items by clicking on them.

The Query Menu

The Query Menu contains options that enable you to search attachments, Do Its, tasks, and window text.

Attachment Search

This option opens the Attachment Search Dialog Box, which provides options that enable you to locate attachments by specifying search criteria. See Searching Attachments in Chapter 4, Attachments, for detail on this option.
Do Its
This option displays a submenu containing options for searching Do Its and Time-Contingent Do Its. See Do Its in Chapter 5, Do Its, for detail on this option.

Do It Search
This option opens the Do It Search Dialog Box, which enables you to locate Do Its by specifying search criteria.

Time-Contingent Do Its
This option will start the KWS TimeAgent program. See Time Agents in Chapter 5, Do Its, for more detail on this program.

Tasks
This option displays a submenu containing all of the predefined database queries available within KWS. Selecting a specific query will cause it to execute against the KWS database. The results of the query are displayed in a Task Window.

Search Text in Windows
This option opens a submenu containing options to search for text strings within the active window. See Searching Windows for Text Strings in this chapter for more detail on using this option.

Search
This option opens a Search Dialog Box where you can enter text that you would like to find within the active window.

Search Next
This option searches for the next occurrence of the text string you last entered in the Search Dialog Box.

Search Previous
This option searches for the previous occurrence of the text string you last entered in the Search Dialog Box.

The Task Menu
The Task Menu contains options that enable you to view the processes and milestones defined for your organization in a textual or graphical format.

Task Manager
This option displays the processes defined for your organization in a split-screen window, or Multiple Document Interface (MDI). The MDI enables you to browse through a textual representation of the entire task hierarchy
by moving between the different levels. See The Task Manager in Chapter 3, Tasks and Steps, for more detail on using this window.

**Graphical Task Manager**

This option displays the processes defined for your organization in a graphical format. See The Graphical Task Manager in Chapter 3, Tasks and Steps, for more detail on this option.

**Milestones**

This option opens the Milestones Dialog Box. See Milestones in Chapter 3, Tasks and Steps, for more detail on this option.

**The ToDo Menu**

The **ToDo** Menu options enable you to list the tasks assigned to you that meet specific criteria. See Options for Viewing the ToDo List in Chapter 2 for more details on these options.

**ToDo**

This option opens a ToDo Window that lists tasks that have not been marked as **Finished** and that have been assigned to you and any work group(s) of which you are a member.

**ToDo: Completed Items**

This option opens a ToDo: Completed Items Window that lists tasks that have been marked as either **Finished** or **Overcome by Events (OBE)** and that have been assigned to you and any work group(s) of which you are a member.

**ToDo: Ongoing Items**

This option opens a ToDo: Ongoing Items Window that lists tasks that have not been assigned a due date. This type of task is also called an "**Ongoing Item**" and is displayed with a blank line in the **Date Due** field.

**ToDo Calendar**

This option opens a ToDo Calendar Window that unites your ToDo List and Appointment List with an interactive calendar. The ToDo and Appointment List contents are dependent on the date(s) selected on the calendar. The tasks and appointments with a start date prior to or on the same day as the current date will appear in the ToDo List. In addition, any tasks with a due date earlier than the current date that have not been marked **Finished** or **OBE** will be displayed in red, which indicates that the tasks are late.
**ToDo Graph**

This option opens a ToDo Graph (TDG) Window that displays the tasks in your To Do List in a graphical Gantt chart format.

**ToDo Browser**

This option opens a ToDo Browser Window that lists all tasks assigned to you. This window displays the task information in a split-screen window.

**The Admin Menu**

The Admin Menu contains several options that enable you to view and update information about the knowledge workers and work groups in your organization, modify your KWS database setup, setup the Master Application List, and generate a file that lists a selected task or the entire KWS Database. If you have System Administration Access rights, other options will also be available.

**Knowledge Workers**

This option opens a Knowledge Worker Window that displays a list of all KWS User IDs in an organization. From this window, User IDs can be added, deleted, and modified; Information Profiles can be viewed and updated; and a list of work groups containing a specific User ID can be generated. See Knowledge Workers and Work Groups in Chapter 7, Customizing KWS, for more detail on using this option.

**Work Groups**

This option opens a Work Groups Window. In the upper workspace, a list of organizations in the KWS Database is displayed. In the lower workspace, the Work Groups List for a selected organization is displayed. Work groups can be viewed, edited, and deleted from this window. See Knowledge Workers and Work Groups in Chapter 7, Customizing KWS, for more detail on using this option.

**Database**

This option displays a submenu containing options for setting up a user’s database and attachment connections, performing system administrator operations, and transferring data to another database. See KWS Database and File Storage Setup in Chapter 7, Customizing KWS, for more detail on using this option.

**Master Applications List**

This option enables a user with System Administrator access rights to set up the Master Application List used for accessing attachments within KWS.
Listing of Entire Database
This option generates an ASCII file containing a hierarchical list of all public tasks for your organization. This list includes all processes, their subordinate tasks, and any steps, attachments, and Do Its associated with each task in this list.

Listing of Selected Task
This option generates an ASCII file containing a hierarchical list of a specific task that you have selected in the task window. This list includes all the subordinate tasks and any steps, attachments, and Do Its associated with each task.

The Notes Command
This command opens a Windows Notes file that has been created by KWS. It provides a quick scratch pad for recording information. See The Notes command in this chapter for more detail on this command.

The Tools Menu
The Tools Menu contains options that enable you to access KWS-related applications. The Tools Menu always includes three options: Task Palette, the TimeAgent, and the DoItBase. In addition, you may add items to the menu. See Adding Items to the Tools Menu in Chapter 7, Customizing KWS, for more detail.

Task Palette
This option opens the KWS Task Palette application. See Chapter 6, The Task Palette, for more detail on this option.

TimeAgent
This option opens the KWS TimeAgent application. See Time Agents in Chapter 5, Do Its, for more detail on this option.

DoItBase
This option opens the KWS DoItBase application. See DoIt Base in Chapter 5, Do Its, for more detail on this option.
The Window Menu

The Window Menu contains several options that enable you to change the arrangement of the open windows on the screen, customize data field arrangement, refresh the screen, and view a list of open KWS windows.

Cascade
This option rearranges all open KWS windows in overlapping order, starting from the top-left corner of the KWS Program Window workspace, with the Title Bar of each window visible.

Tile
This option rearranges all open KWS windows in a side-by-side, grid-like pattern, adjusting the size of each window accordingly.

Arrange Icons
This option arranges all KWS icons present in the workspace along the bottom edge of the workspace area.

Close
This option closes the currently active window.

Close All
This closes all open windows in KWS.

Options
This option enables the user to set preferences for displaying information in the active window. It is only available when the active window is a ToDo List, Task, Task Manager, or Graphical Task Manager window. See Display Field Setup in Chapter 7, Customizing KWS, and The Graphical Task Manager in Chapter 3, Tasks and Steps, for more detail.

Display Field Setup
This option enables you to choose which data is displayed within the active window, the order of the data displayed, the width of the data displayed, and whether the text in a data field should wrap around to the next line. See Display Field Setup in Chapter 7, Customizing KWS, for more detail.

Printer Field Setup
This option enables you to decide which data is printed from the active window, the order of the data printed, the width of the data printed, and whether the text in a data field should wrap around to the next line. See Display Field Setup in Chapter 7, Customizing KWS, for more detail.
Refresh
This option refreshes the contents of the active window. This action may be necessary for updating the contents of a window when you return to it after you have made changes to the KWS database in another active window.

Save Changes
This option saves any task modifications that have been made within a graphical task window. Because the graphical view does not immediately post data modifications to the database, it is necessary to manually instruct the system to save your work periodically. This option is only available when the active window is a graphical task window—the Graphical Task Manager to ToDoGraph.

List of Open Windows
A list of all the windows open within KWS is shown at the bottom of the Window Menu options. A check mark is displayed next to the active window. You can change the active window by clicking on the desired window title in this list.

The Help Menu
The Help Menu contains several options that enable the user to access on-line information about KWS and its operating environment.

Contents
This option displays a table of contents for on-line KWS help information. The user can click on a specific item within the table of contents to access more detailed information on that item.

Search for Help on...
This option opens a Search window that enables you to search for on-line KWS help information by entering a text string.

How To Use Help
This option provides information on how to use the KWS help feature.

About KWS...
This option is a single-action command that displays the About KWS Message Box, which contains information about the KWS developers, the KWS contract number, and the current version number.

Button Bar Options
The Button Bar provides quick access to the KWS functions that are available for the active window. The options available in the Button Bar depend on the type of window that is active.
Task Window Button Options

When the active window is a Task Window, a button bar is displayed with buttons titled: Insert, Delete, Modify, Steps, Attach, Do It, Pred, and Succ. See Chapter 3, Tasks and Steps, for more detail on these options.

Insert
This button opens a Task Dialog Box, which enables you to add a new task to the KWS Database.

Delete
This button enables you to remove a task from the KWS Database.

Remember that deleting a task deletes all of its children, Attachments, Steps and Do Its. Use this command with caution.

Modify
This button opens the Task Dialog Box, which enables you to edit task information.

Steps
This button opens a Steps Window, which enables you to access the steps you should complete in order to perform the selected task.

Attach
This button opens the Attachment Window and enables you to access attachments linked to the selected task.

Do It
This button opens a Do Its Window and enables you to access Do Its linked to the selected task.

Pred
This button opens a Predecessor Window and enables you to access the tasks that must be completed before the selected task may be started.

Succ
This button opens a Successor Window and enables you to access the tasks that may not be started until the selected task has been completed.

Message Window Button Options

When the active window is a Message Window, a Button Bar is displayed with buttons titled: Send, Delete, Modify, and Received. See The Messages Option in this chapter for more detail.
Send
This button opens the Messages Dialog Box, which enables you to send a KWS related message to another KWS user.

This option is not intended to replace E-mail messaging. It should only be used for KWS-specific messages.

Delete
This button enables you to remove a message from the Message Window.

Modify
This button opens the Message Dialog Box, which enables you to edit an existing message.

Received
This button enables you to mark a message received.

Attachments Window Button Options
When the active window is an Attachments Window, a button bar is displayed with buttons titled: Insert, Delete, Profile, View, Edit, Export, Copy, and Version. See Chapter 4, Attachments, for more detail on these options.

Insert
This button opens the Attachment Insert Dialog Box, which enables you to create or import an attachment.

Delete
This button enables you to remove the selected attachment from the Attachment Window.

Profile
This button opens an Attachment Profile Window for the selected attachment, which enables you to view or update information for an attachment.

View
This option enables you to view the contents of a selected attachment by launching your file viewer application with the attachment file.

Edit
This button enables you to edit the contents of a selected attachment by launching the application defined in the attachment’s profile with the attachment file.
Export
This button opens a File Save Dialog Box, which enables you to save the attachment to a user-specified file name and location.

Copy
This button enables you to make a new copy of the selected attachment and link it to the selected task within the active Attachment Window.

Version
This button enables you to make a new copy of the selected attachment with the same name and link it to the selected task.

Do Its Window Button Options
When the active window is a Do Its Window, a button bar is displayed with buttons titled: Insert, Delete, Modify, and Execute. See Chapter 5, Do Its, for more detail on these options.

Insert
This button opens the Do It Dialog Box, which enables you to link a Do It to the selected task.

Delete
This button enables you to remove the selected Do It from the active Do It Window.

Modify
This button opens a Do It Dialog Box, which enables you to edit information pertaining to the selected Do It.

Execute
This button launches the selected Do It.

Knowledge Worker Window Button Options
When the active window is a Knowledge Worker Window, a button bar is displayed with buttons titled: Insert, Delete, Modify, and Work Groups. See Knowledge Workers and Work Groups in Chapter 7, Customizing KWS, for more detail on these options.

Insert
This button opens a Knowledge Worker Dialog Box, which allows you to add a new User ID to the KWS Database. This option is only available to users with System Administrator privileges.
Delete
This button will remove the selected User ID from the KWS Database. This option is only available to users with System Administrator privileges.

Modify
This button opens a Knowledge Worker Dialog Box, which enables you to view and edit User ID information. Only a user with System Administrator privileges can modify all User ID information.

Work Groups
This button opens a Work Groups Window that displays a list of all the work groups to which the selected User ID has been assigned.

KWS Database Window Button Options
When the active window is a KWS Database Window, a button bar is displayed with buttons titled: Insert, Delete, and Modify. See KWS Database and File Storage Setup in Chapter 7, Customizing KWS, for more detail on these options.

Insert
This button opens the KWS Database Setup Dialog Box, which enables you to insert a new KWS database definition.

Delete
This button enables you to remove the selected KWS database definition from the KWS Database Window.

Modify
This button opens the KWS Database Setup Dialog Box, which enables you to edit the selected KWS database definition.

The Available Options Menu
The Available Option Menu is a pull-down menu that enables you to access the KWS functions available for the active window. Most of the options in the Available Options Menu duplicate options in the Button Bar. However, due to space constraints, additional options may be included in the Available Options Menu that are not in the Button Bar.

The Available Options Menu is accessible from the Task, Task Manager, Steps, Attachment, Do It, Milestone, Appointment, and Messages windows in KWS. The options included in the menu are dependent on the window type.
To open the Available Options Menu:
Select an item in the window and click once on the right mouse button.

or...
Select an item in the window and press the [Enter] key.

**Task Window Available Options**

The options in the **Available Options** Menu for a Task Window include **Steps, Attachment..., Do It..., Predecessors, Successors, Parent, Siblings, Description, Modify, Delete, and Graph. Parent, Siblings, Description, and Graph** are additional options not included in the Button Bar for the Task Window. The **Attachment...** and **Do It...** options also provide the capability to search Attachments and Do Its.

### Steps
This option opens a Steps Window and enables the user to access Steps associated with performing the selected task. See Steps in Chapter 3, Tasks and Steps, for more detail on this option.

### Attachment...
This option displays a pull-down menu that lists the options: **Edit Attachment List**, and **Search Attachments**.

#### Edit Attachment List
This option opens the Attachment Window, which enables you to access Attachments associated with the selected task.

#### Search Attachments
This option opens the Attachment Search Window, which enables you to enter search criteria for locating attachments. This option is also available from the **Query** Menu, **Attachment Search** option. See Searching Attachments in Chapter 4, Attachments, for more detail.

### Do It...
This option displays a pull-down menu with the options: **Edit Do It List**, and **Search Do Its**.

#### Edit Do It List
This option opens the Do It Window, which enables you to access Do Its associated with the selected task.
Search Do Its
This option opens the Do It Search Window, which enables you to locate Do Its by entering search criteria. This option is also available from the Query Menu, Do It Search option. See Chapter 5, Do Its, for more detail on this option.

Predecessors
This option opens a Predecessor Window, which enables you to access Predecessor tasks associated with the selected task.

Successors
This option opens a Successor Window, which enables you to access successor tasks associated with the selected task.

Parent
This option opens a Task Window that contains the task’s parent and the parent’s sibling tasks. The parent task will be highlighted.

siblings
This option opens a Task Window that contains a list that includes the task and its siblings.

Description
This option displays the Description Dialog Box and enables you to view, enter, or edit a short description of the selected task.

Modify
This option opens the Task Dialog Box, which enables you to edit task information.

Delete
This option enables you to remove a task from the KWS Database.

Remember that deleting a task deletes all its children, attachments, steps, and Do Its. Use this command with caution.

Graph
This option opens a Graphical Task Manager Window with the selected task displayed.
Attachment Window Available Options

The options in the Available Options Menu for an Attachment Window include View, Edit, Export, Copy, Version, Profile, Delete, and Define Workflow. The Define Workflow option is the only additional option not included in the Button Bar for the Attachment Window. See Chapter 4, Attachments, for more details on these options.

View

This option enables you to view the contents of a selected attachment by launching your file viewer application with the attachment file.

Edit

This option enables you to edit the contents of a selected attachment by launching the application defined in the attachment’s profile with the Attachment file.

Export

This option opens a File Save Dialog Box, which enables you to save the attachment to your specified filename and location.

Copy

This option enables you to make a new copy of the selected attachment and link it to the selected task.

Version

This option enables you to make a new copy of the selected attachment with the same title, link it to the selected task, and increment the version number by one.

Profile

This option opens an Attachment Profile Window for the selected task, which enables you to view or update information for the attachment.

Delete

This option enables you to remove the selected attachment from the Attachment Window.

Define Workflow

This option opens the Workflow Definition Dialog Box and enables you to setup a workflow path for the selected attachment.
SELECTING MULTIPLE WINDOW ITEMS

At times you may want to perform an action (e.g., Move, Copy, Delete) on more than one item in a window. KWS provides this capability through the Multiple Item Select Feature.

❖ Selecting Multiple Items in a Window

To select multiple items in a window:

1. Open the window from which you want to select multiple items.

2. While holding the [Shift] key down, click on each item that you want to select. As you select each item, it will be highlighted.

To select all items in a window:

1. Open the window from which you want to select all items.

2. Select the Edit Menu and then the Select All option. All items in the window will be highlighted.

To deselect items in a window:

While holding the [Shift] key down, click on the item that you want to deselect. The item will no longer be highlighted.

❖ Performing Actions on Multiple Items in a Window

When multiple items are selected, the Multiple Item Indicator, a small red square, appears in the upper left corner of the active window.

To perform actions on multiple items in a window:

1. Select the multiple items to which you want to perform an action.

2. Select the action you want to perform.

To drag multiple items to another window:

1. Select the multiple items that you want to drag.

2. Click on the Multiple Item Indicator and while holding the mouse button down drag it to the desired location.

When performing a multiple-item delete, KWS will warn you that multiple items are selected and will ask for confirmation of the deletion. Multiple-item deletes are available in all windows except the Organization window and the Knowledge Worker window. Use cautiously!
SEARCHING WINDOWS FOR TEXT STRINGS

KWS enables you to search for text strings contained within the active window. This capability is useful when you need to find a specific item or items in a window quickly without having to scroll through the window to locate it.

- Searching for Text Strings in a Window

To search for text strings in a window:

1. From the Query Menu, select the Search Text in Window option. A pull-down menu will be displayed with the options Search..., Search Next, and Search Previous.

2. To begin your search, select the Search... option. The Search Dialog Box will be displayed (Figure 1-2).

![Search Window](image)

Figure 1-2: Search Window

3. Enter the text string for which you want to search in the Search For data field.

4. Select the data fields from which you want to search by clicking on the field name in the Search Fields list. To search all fields click within the All Fields checkbox.

5. Limit your search by selecting your desired option in the Find area of the Dialog Box where the options are defined as follows:

   - Next Match: Search those items listed after a selected task.
   - Previous Match: Search those items listed prior to a selected task.
   - All Matches in Window: Search all items in the window that contain the text string.
6. (Optional) Specify whether you want to select the item(s) that contain matching text strings by checking the Select Items With Match checkbox.

7. (Optional) Specify whether you want to clear all previous searches within the window by checking the Clear Previous Searches checkbox.

8. (Optional) Specify whether the search is to be case-sensitive by checking the Match Case checkbox.

9. Click OK. Search results will be displayed in the current window by highlighting the specified text string within the item's title. If you checked the Select Items With Match option, each item with a match will be selected.

THE MESSAGES OPTION

KWS automatically notifies you through the Messages option when there has been a change to the database that may affect you. These system-generated notifications let you know when another user has assigned a task to you, deleted an assigned task, or performed some similar action. In addition, you may use the Messages option to send KWS-related messages to another user.

Each time you log in to KWS, the system checks your message list. If you have new messages, the New Messages Dialog Box will be displayed (Figure 1-3).

![New Messages Dialog Box](image)

Figure 1-3: The New Messages Dialog Box

- **Accessing Messages**

  To access messages:

1. Select **File** from the KWS Menu Bar.

2. In the File Menu, select **Messages**. The Messages Window will be displayed (Figure 1-2) along with its associated button bar (Figure 1-3).
The Messages Window contains the following data fields.

**Date Sent**  The date the message was generated.

**From**  The KWS User ID that generated the message.

**To**  The KWS User ID to receive the message.

**Subject**  A short description of the message contents.

**Message**  The text of the message.

Unread messages are listed in the order of **Date Sent** and are displayed in red. Messages that have been marked **Received**, are at the bottom of the list in the order of **Date Sent** and are displayed in black.

The Messages Window button bar contains the options **Send**, **Delete**, **Modify**, and **Received**. These options are available whenever the Messages Window is active.

The Messages Window also has an associated **Available Options** Menu, which can be accessed by clicking the right mouse button. The menu options are **Modify** and **Delete**.

**Reading Messages**

To read messages:

1. Select the message you want to read.

2. Click the **Modify** button. The Message Dialog Box will be displayed (Figure 1-6).
3. Click **OK**.

![Message Dialog Box]

Figure 1-6: The Message Dialog Box

- **Marking a Message Received**
  
  To mark a message received:
  
  Select the message to be marked received and click the **Received** button.
  
  or...
  
  While reading the message, check the **Received** box in the upper left area of the Message Dialog Box and click **OK**.

- **Modifying a Message**
  
  To modify a message:
  
  1. Select the message to be modified.
  2. Click the **Modify** button. The Message Dialog Box will be displayed.
  3. Enter your desired modifications.
  4. Click **OK** to save.

- **Deleting a Message**
  
  To delete a message:
  
  1. Select the message to be deleted.
  2. Click the **Delete** button. The Delete? Dialog Box will be displayed.
  3. Click **Yes**. The message will be removed from the Messages Window.

- **Sending a Message**
  
  To send a message:
  
  1. Select **File, Messages** from the KWS Menu Bar to open the Messages Window.
  2. Click the **Send** button. The Messages Dialog Box will be displayed.
3. Enter values for the **To**, **Subject**, and **Message** data fields into the Messages Dialog Box.

4. Click **OK**.

This option is not intended to replace E-mail messaging. It should only be used for KWS-specific messages.

**THE NOTES COMMAND**

KWS provides quick access to a Windows Notepad document via the Notes command. This feature is useful when you need a quick scratchpad to record information while working within KWS. This document will not be linked to a specific task; the Attachment option is available for that purpose.

- **Accessing Notes**

  **To access the Notes option:**

  Select **Notes** from the KWS Menu Bar. Windows Notepad will open.

  If this is the first time you selected the **Notes** command, a new file will be created for you and given a name generated from your KWS User ID. Otherwise, your previously created file will be displayed. This file is stored on your workstation and is only accessible from that workstation when you log in using your KWS User ID.

  Because the **Notes** command uses the Windows Notepad, if you have a Notes file open and then click any KWS window, your Notes file will be placed behind the KWS Program Window but will remain open. If you select the **Notes** command in KWS again while your Notes file is still open, Notepad will open your last **saved** version of your Notes file. So be careful not to open multiple instances of Notepad with the **Notes** command. To determine if you already have Notepad open, you can use the standard Windows key sequence [CTRL-ESC] to view a list of open applications.

- **Modifying Notes**

  You may enter and edit text into your Notes file using the Windows Notepad commands and features. When you want to exit, save your information by using the File, Save command within Notepad and exit by using the File, Exit command. If you attempt to exit Notepad without saving your file, Notepad will display a message asking you if you want to save.
LOGGING IN TO KWS

- **Starting KWS**
  
  To start KWS:
  
  Double-click the KWS icon in your Windows Program Manager. The KWS application will open with the Knowledge Worker System Login Dialog Box displayed in the KWS Program Window.

- **Logging in to KWS**
  
  You must have a KWS User ID and password before you can log in to KWS. If you do not have these, see your KWS System Administrator.

  **To log in to KWS:**
  
  1. Start KWS. The KWS Login Dialog Box will be displayed.
  
  2. Select the KWS database to which you want to log in by clicking the small right arrow to the left of the **Database** field and selecting from the list provided.
  
  3. Enter your **User ID** and **Password**.
  
  4. Click **OK**.

  Your System Administrator can enable you to automatically log in to KWS when you start the application. For security reasons, this is not necessarily a good approach, because anyone will be able to log in with your User ID by starting KWS from your workstation.

- **Letting Another User Log In to KWS**

  You may let someone else log in to KWS from your workstation without exiting KWS. By doing this, you will no longer be logged in, but you may log in again in the same manner.

  When you are logged in to KWS and you then let another user log in, all of the KWS windows that you have open will remain open after the new login. Any windows opened by the new log in User ID will be associated with the new User ID. However, your remaining windows will still be associated with your User ID. If the new user accesses your open windows, the information retrieved in them will be the same as if you were logged in. For example, suppose you are logged in with your User ID and have your ToDo Calendar Window open. If you let another user log in and they open their ToDo Calendar window, the ToDo items assigned to them will be listed. If the new user then opens a Task Window; assigns a task to your ID; accesses your open ToDo Calendar; and refreshes the list, the new task will appear in your ToDo list. This capability is very useful when building process models. However, at any other time it is recommended that you close all of your open windows before allowing another user to login.
To log in as another user while KWS is open:

1. Select **File** from the KWS Menu Bar.

2. Select **Login** from the **File** Menu. The KWS Login Dialog Box will be displayed.

3. Select the KWS database to which you want to log in by clicking the small right arrow to the left of the **Database** field and selecting from the list provided.

4. Enter your **User ID** and **Password**.

5. Click **OK**.

**REFRESHING INFORMATION IN KWS WINDOWS**

At times, you may need to update the information displayed in an open KWS window. For example, if you assign a new task to yourself in the Task Manager and then return to your ToDo List, the new task will not be displayed until you update the information. This update is referred to as “refreshing” information.

**Refreshing Windows**

To refresh information in an active KWS window:

1. Select the **Window** Menu in the KWS Menu Bar.

2. Select **Refresh** from the **Window** Menu.

**PRINTING FROM KWS**

You can print from any text-based window within KWS. This includes all windows except the graphical task windows. To print the contents of graphical task windows, use the Windows Clipboard [ALT-Print Screen] and a Windows Graphics program. You may also change your print font, the data fields to be printed, and your page setup. See Chapter 7, Customizing KWS, for more details on setting these options.

**Printing Text From a KWS Window**

To print text from a KWS window:

1. Select the window from which you want to print.

2. Select **File** from the KWS Menu Bar.

3. Select **Print** from the **File** Menu. The contents of the active window will be printed on the default printer specified in the Windows Control Panel.
LISTING THE CONTENTS OF THE KWS DATABASE

You may generate an ASCII text file that contains a hierarchical list of all the tasks in your database or a selected task. This list includes all the subordinate tasks and any steps, attachments, and Do Its associated with each task. If you wish, you may then modify or print this file using any word processing application.

❖ Listing All Tasks in the KWS Database

To list all the tasks in your KWS database:

1. Select Admin from the KWS Menu Bar.

2. Select Listing of the Entire Database from the Admin Menu. A message box will warn you that, if you have a large database, this action might take a long time and ask you if you want to continue.

3. Click Yes. A window will be displayed where you may enter the name of the file to generate.

4. Enter the name of the file or accept the default value and click OK. The database will be listed to the specified file.

❖ Listing a Selected Task in the KWS Database

To list a selected task in the KWS database:

1. Select the task that you want to list.

2. Select Admin from the KWS Menu Bar.

3. Select Listing of a Selected Task from the Admin Menu. A window will be displayed where you may enter the name of the file to generate.

4. Enter the name of the file or accept the default value and click OK. The task will be listed to the specified file.
Chapter 2 THE TODO LIST

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview</td>
<td>2-2</td>
</tr>
<tr>
<td>The ToDo List Window</td>
<td>2-2</td>
</tr>
<tr>
<td>Manipulating Tasks in the ToDo List</td>
<td>2-4</td>
</tr>
<tr>
<td>Options for Viewing the ToDo List</td>
<td>2-6</td>
</tr>
</tbody>
</table>
OVERVIEW

The window used most often within KWS is the ToDo List Window. This window provides a personalized list of all the tasks you need to perform. The tasks listed in your ToDo List are entered into KWS via the Task Manager as part of your organization’s process model. The tasks that are displayed in your ToDo List depict the subset of your organization's process model that is assigned to you. The ToDo List is dynamic, with the contents changing as tasks are completed, time progresses, and new tasks are added.

This chapter describes the features of the ToDo List window, how to manipulate tasks in the ToDo List, and the various methods for displaying your ToDo List.

TODO WINDOW

The tasks assigned to you are displayed in a ToDo Window (Figure 2-1).

![Figure 2-1: ToDo Window](image)

The tasks in the ToDo Window are organized by the tasks’ Date Due values, with the earliest dates listed first. They are also color-coded to indicate tasks that are late or of critical priority. Late tasks are red. Critical priority tasks are blue. All other tasks are black.

The ToDo Window displays information also about each task's type and status via the Symbol Fields. Access to the resources required to perform the tasks is provided through icons in the Indicator Columns or buttons in the ToDo Window button bar. These features are described in the following sections.

The Symbol Fields

On the left side of the ToDo Window are two Symbol Field columns that indicate the Task Completion Status and Task Type of each task. The Task Completion Status Symbols are displayed in the first column and the Task Type Symbols are in the second column.
Task Completion Status Symbols

The Task Completion Status Symbols indicate the completion status of a task: **Started**, **Finished**, or **OBE**. If none of these symbols appears, the task status is, by default, **Not Started**.

- **S** Started
- ✔ Finished
- O Overcome By Events

A grayed **S**, ✔, or O can appear next to a task. When a Task Completion Status Symbol appears in gray, it indicates that the task is a Work Group task (one assigned to more than one User ID). A grayed symbol will appear next to the task if at least one group member, but not all, have marked the task status. If all User IDs in the Work Group mark the task with the same status, the symbol will appear in black.

Task Type Symbols

The Task Type Symbols indicate special categories of a task as follows:

- **P** Private Tasks
- Φ Cyclic Tasks
- T Tasks Transferred to me by another User ID
- Θ Tasks Transferred by me to another User ID

Multiple Symbols

A task may have one Task Completion Symbol and one Task Type Symbol assigned to it. For example, a **Private** task that has been marked **Started** will display the two-character symbol **SP**.

Indicator Columns

On the right side of the ToDo Window, four Indicator Columns may contain icons. These icons are graphical references that, when present, indicate that a task has additional resources associated with it. You may click on the icon to access the resource. These additional resources are child tasks, attachments, Do Its, and steps. The icons that represent these resources are as follows:
Task has one or more child Tasks

Task has one or more Attachments

Task has one or more Do Its

Task has Steps

The Symbol Menu

This is a pull-down menu that enables you to change task completion status directly from the ToDo Window.

Accessing the Status Symbol Menu

To open the Status Symbol Menu:

1. Select the desired task and place your cursor in the Status Symbol column on the left side of the ToDo List.

2. Click the left mouse button. The Symbol Menu will appear with the options Not Started, Started, Finished, and OBE.

3. Select the desired option or click anywhere outside of the Status Symbol Menu to exit without setting the Task Completion Status.

MANIPULATING TASKS IN THE TODO WINDOW

You should execute all of your tasks from the ToDo Window. Even though it is possible to access the same information from the Task Managers, these should only be used for building and updating the organization's process model. From the ToDo Window, you can change task status, access task resources, add tasks, and modify task information.

Accessing Child Tasks, Steps, Attachments, and Do Its

To access child tasks, steps, attachments, and Do Its:

Click the right mouse button on the desired resource icon in the Indicator Column of the ToDo Window.

or...

Select the desired task and click the appropriate button from the ToDo Window Button Bar.

With either method, the window for the desired resource will be displayed.
Modifying Tasks

A user may change task information for the tasks in their ToDo List. However, the information that can be changed depends on the task permissions assigned to the user.

To modify a task from the ToDo Window:

1. Select the desired task and click the Modify button from the ToDo Window Button Bar. The Task Dialog Box for the task will be displayed.

2. Make the desired changes in the Task Dialog Box and click the OK button.

Changing Task Status

Two methods change Task Status from the ToDo Window. The quickest method uses the Status Symbol Menu. The other uses the Task Dialog Box.

To change Task Status using the Status Symbol Menu:

1. Select the desired task and place the cursor over the Status Symbol Column on the left side of the ToDo List.

2. Click the left mouse button once, and the Status Symbol Menu will be displayed with the options Not Started, Started, Finished, or OBE.

3. While holding the mouse button down, move the cursor over the appropriate status option and release the mouse.

When changing status using the Status Symbol Menu, the current date will automatically be entered into the applicable date field (Date Started and/or Date Finished).

To change Task Status using the Task Dialog Box:

1. Selecting the desired task and click the Modify button from the ToDo Window Button Bar. The Task Dialog Box for the task will be displayed.

2. Mark the appropriate status option in the Status area of the dialog box, and then click the OK button.

Adding Private Tasks

Private tasks exist only in your ToDo List and are not included in your organization's KWS process model. Only the user who creates a Private task can access it.

To add a private task from the ToDo Window:

1. Click the Insert button. A Task Dialog Box will appear.

2. Enter the information for the task into the Task Dialog Box.
3. Click OK. The new task will be displayed in your ToDo List with a P in the Symbol Column to the left of the task.

**Adding Public Tasks From the ToDo Window**

Public tasks are those tasks that are part of the organization's KWS process model. Any task that is inserted via a Task, Task Manager or Graphical Task Manager Window is automatically a public task. A task inserted from within the ToDo Window is public only if it is inserted as a child of a public task. Otherwise, it is a private task.

**To add a public task from the ToDo Window:**

1. Select the public task under which you want to insert children and double-click the mouse button. A Task Window will be displayed with its associated button bar.

2. Click the Insert button. A Task Dialog Box will be displayed.

3. Enter the information for the task into the Task Dialog Box.

4. Click OK.

**Deleting Tasks From the ToDo Window**

Deleting a task from your ToDo Window also deletes it from the KWS database. You may delete a task only if you have been given Delete permission for the task by the task owner.

**To delete a task from the ToDo Window:**

1. Select the desired task and click the Delete button. The Delete? Dialog Box will be displayed.

2. Click Yes to delete the task, or click No to cancel.

Remember that deleting a task deletes all its children, attachments, steps, and Do Its. Use this command with caution.

**OPTIONS FOR VIEWING THE TODO LIST**

<table>
<thead>
<tr>
<th>ToDo</th>
<th>ToDo: Completed Items</th>
<th>ToDo: Ongoing Items</th>
<th>ToDo Calendar</th>
<th>ToDo Graph</th>
<th>ToDo Browser</th>
</tr>
</thead>
</table>

Several options are available for viewing your ToDo List in KWS. These options are accessed from the ToDo Menu in the KWS Menu Bar. The options are: ToDo, ToDo: Completed Items, ToDo: Ongoing Items, ToDo Calendar, ToDo Graph, and ToDo Browser. The contents of the ToDo List depend on which option you have chosen. Each option is described further in the following sections.
ToDo

The **ToDo** option displays all tasks assigned to you that have not been marked *Finished* or *OBE* (Figure 2-2). Tasks that have been marked *Finished* or *OBE* with a due date later than the current date will also be displayed on the ToDo List until the due date is later than the current date.

![Figure 2-2: ToDo Window](image)

### ToDo: Completed Items

The **ToDo: Completed Items** option displays an archived list of all tasks assigned to you that have been marked *Finished* or *OBE* (Figure 2-3). Tasks with a due date later than the current date will not be displayed on the ToDo: Completed Items List until the current date is later than the due date.

![Figure 2-3: ToDo Completed Items Window](image)

### ToDo: Ongoing Items

The **ToDo: Ongoing Items** option displays all tasks assigned to you that have not been assigned a *Date Due* value (Figure 2-4).
It is recommended that you assign a Date Due value to every task. The Ongoing Task option was originally provided in KWS to enable users to quickly access repetitive tasks that are difficult to assign a specific due date. A better method for defining these tasks is now available. See Chapter 6, The Task Palette, for more detail on this method.

**ToDo Calendar**

The ToDo Calendar option unites an interactive Calendar with a ToDo Window and an Appointment Window (Figure 2-5). The Calendar displays the months across the top section of the window. The ToDo Window is below the Calendar on the left side, and the Appointment Window is below the Calendar on the right side.

![Figure 2-5: ToDo Calendar Window](image)

*Opening the ToDo Calendar Window*

**To open the ToDo Calendar Window:**

1. Select the **ToDo** Menu in the KWS Menu Bar.
2. Click on the **ToDo Calendar** option.

The ToDo Calendar Window typically is displayed in the KWS workspace when a user first logs in.
- Resizing the ToDo List and Appointment List Windows

The ToDo Window can be expanded to cover the Appointment Window, or the Appointment Window can be expanded to cover the ToDo Window. This capability gives you a large window in which to view the information. Either of these expanded windows can be contracted to display both windows again.

To expand the ToDo or Appointment Window:

Double-click on the Title Bar of the window to be expanded. The expanded window will cover the other window.

To contract an expanded ToDo or Appointment Window:

Double-click on the Title Bar of the expanded window. Both windows will be displayed at their original size.

- The Calendar

When the ToDo Calendar Window initially opens, the Calendar displays the months starting with the current month on the left side with the current date selected. You can scroll through the months displayed in the Calendar by using the scroll bar located immediately below the Calendar.

The Calendar interacts directly with the ToDo List and Appointment List. The tasks displayed in the ToDo List or appointments in the Appointment List are determined by the date(s) selected in the Calendar. Dates marked in red indicate that a task is due or an appointment is scheduled for that date.

- Selecting Items in the Calendar

You can select any day, week, or month from the Calendar to view your ToDo List items for the selected period.

To select a specific day in the Calendar:

1. Move the cursor over the date to be selected. A red box will surround the date.

2. Click the mouse button. A black box will surround the selected date.

To select an entire month in the calendar:

1. Move the cursor over the title of the month to be selected. A red box will surround the dates for the month.

2. Click the mouse button. A black box will surround the selected month.
To select an entire week in the calendar:

1. Move the cursor over any date in the week to be selected. A red box will surround the dates for the selected week.

2. Press the [Shift] key while clicking the mouse button. A black box will surround the selected week.

**ToDo List**

The ToDo window displays a ToDo List which contains all the tasks assigned to you that should be started by the selected date and have not been marked Finished or OBE. KWS calculates that a task should be started by the selected date when the **Date Due** value for that task minus the **Duration** equals that selected date. Tasks that have been marked Finished or OBE with a due date later than the current date will also be displayed on the ToDo List until the due date is later than the current date.

**The Appointment List**

The Appointment Window enables the user to enter appointments within KWS. The appointments entered for the date(s) currently selected in the Calendar will be displayed in the Appointment List. The following data fields are used by KWS to describe Appointments:

- **Appointment** A textual description of the appointment
- **Date** The date of the appointment entered in DDMMYY format. The default value is the currently selected date in the Calendar.
- **Start Time** The time when the appointment is scheduled to begin entered in the 12-hr-clock format: e.g., 02:15PM.
- **End Time** The time when the appointment is scheduled to end entered in the 12-hr-clock format as above.

**Entering Appointments**

**To enter an appointment:**

1. Activate the Appointment Window by clicking on it anywhere.

2. Press the **Insert** button on the Button Bar. The Appointment Dialog Box will appear (Figure 2-6).

3. Enter the information into each field of the dialog box and click **OK** to save the appointment. Note that the date and time fields can be entered by clicking the arrows next to the data fields.
Modifying Appointments

To modify an appointment:

1. Activate the Appointment Window by clicking on it anywhere.

2. Select the appointment to be modified from the Appointment List and press the Modify button on the Button Bar. The Appointment Dialog Box will appear.

3. Enter the desired changes to each field in the dialog box and click OK.

Deleting Appointments

To delete an appointment:

1. Activate the Appointment Window by clicking on it anywhere.

2. Select the appointment to be deleted from the Appointment List and press the Delete button. The Delete? Dialog Box will be displayed (Figure 2-7).

3. Click Yes to delete the appointment, or click No to cancel.

Linking Attachments to Appointments

To link an attachment to an appointment:

1. Activate the Appointment Window by clicking on it anywhere.
2. Select the appointment to be linked to an attachment from the Appointment List and press the **Attach** button in the Button Bar. An Attachment Window will appear.

3. Link the attachment in the usual manner. See Chapter 4, Attachments, for detail on linking Attachments.

**Linking Do Its to Appointments**

1. Activate the Appointment List Window by clicking on it anywhere.

2. Select the appointment to be linked to a Do It from the Appointment List and press the **Do It** button. A Do Its Window will appear.

3. Link the Do It in the usual manner. See Chapter 5, Do Its, for more detail on linking Do Its.

**ToDo Graph**

The **ToDo Graph** option displays the complete process hierarchy to which the ToDo item belongs in a Graphical Task Manager Window. Your ToDo items are indicated in bold type. Tasks that have been marked **Finished** or **OBE** and Ongoing Tasks are not displayed. See The Graphical Task Manager in Chapter 3, Tasks and Steps, for more details on using the Graphical Task Manager Window.

**ToDo Browser**

The **ToDo Browser** option displays all the tasks assigned to you within a split-screen window (Figure 2-8). This allows you to view two levels of the task hierarchy simultaneously. Using this option, you can access all the levels of the ToDo List without opening multiple task windows.

![ToDo Browser Window](image)

**Figure 2-8: ToDo Browser Window**
Chapter 3 TASKS AND STEPS

Overview 3-2
Task Definition 3-2
The Task Window 3-18
The Task Manager 3-19
Cyclic Tasks 3-24
Predecessor and Successor Relationships 3-29
Milestones 3-32
The Graphical Task Manager 3-33
Steps 3-43
OVERVIEW

Tasks are the basic building blocks of a KWS process model. KWS provides the ability to build process models via the Task Manager and Graphical Task Manager. In addition, users may add to the KWS process model by inserting tasks within Task Windows accessed from their ToDo Lists.

This chapter describes how to define tasks within KWS, manipulate tasks for building process models, define cyclic tasks, create predecessor and successor relationships between tasks, use the Graphical Task Manager, and define steps.

TASK DEFINITION

Each task has a specific set of information or data fields associated with it. To build a KWS process model, it is necessary to enter the information that defines each task into KWS. The following sections describe the information required for defining tasks within the KWS database.

The Task Dialog Box

Tasks are entered into the KWS database through the Task Dialog Box (Figure 3-1). The Task Dialog Box contains a set of data fields that capture user-specified values for defining tasks within KWS. In addition, the Task Dialog Box contains buttons used to access dialog boxes for capturing or

![Task Dialog Box]

Figure 3-1: The Task Dialog Box
viewing additional task information. The following sections describe the
data fields contained within the Task Dialog Box as well as the data fields
accessed from the Task Dialog Box.

Task Dialog Box Data Fields

The following data fields in the Task Dialog Box are entered by the user
when defining tasks within KWS.

**ToDo**

*Designating a Task as a ToDo Item*

**To designate a task as a ToDo item:** Check the **ToDo** box by clicking on
it. If the box is already checked, clicking on it will uncheck it and vice
versa.

**Description:** Indicates whether a task should be displayed in the ToDo List.

**Type:** An option-box field that indicates a task should appear in the ToDo
List when the box is checked and should not appear in the ToDo List when
the box is not checked.

**Default Value:** Checked

**Usage:** When building KWS process models, some higher-level tasks are
defined to provide organizational structure to the task hierarchy. It may not
be appropriate for these tasks to appear as ToDo items. Typically, ToDo
items are the lower-level tasks that are actually performed by a knowledge
worker.

**Title**

*Entering Task Title*

**To enter Task Title:** Type the desired value into the **Title** field.

**Description:** The name of the task.

**Type:** A 240-character text field that can include any combination of
alphanumeric characters, punctuation marks, and standard ASCII symbols.
It is a required field.

**Default Value:** Blank

**Usage:** The **Title** value should contain an abbreviated description of the
central activity that defines the task. It is recommended that a task be named
with an active verb phrase (Verb + Noun Phrase). For example: Conduct
Meeting. The KWS convention is to capitalize each key word in the task
name, just as you would the title of a book.
ID

Entering the Task ID

To enter the task ID: Type the value into the ID field.

Description: An identifier used to classify tasks.

Type: A 20-character text field that can include any combination of alphanumeric characters, punctuation marks, and standard ASCII symbols. It is a required field.

Default Value: The ID value of the parent task.

Usage: The ID value should contain information that enables you to quickly associate the task with a specific project or assignment. For example, an ID field containing the project number 001CS4 for the task Conduct Status Review Meeting reminds the user which project the task pertains to without the user having to include the project name in the Title field. Also, marking tasks with ID values ensures they will be found when a user makes a database query to retrieve all the tasks that contain that specific ID value.

Date Due

Entering Date Due

To enter Date Due: Type the value into the Date Due field using the DDMMYY format, or set the value by clicking on the up and down arrows to the right of the field.

Description: The scheduled date of completion for a task.

Type: A date field entered using the format DDMMYY, where DD is the 2-character number for the day of the month, MMM is the first three letters of the name of the month, and YY is the 2-character number for the year. For example, February 3, 1997 is entered as 03FEB97.

Default Value: The Date Due value of the parent task. If the task does not have a parent, the default value is the current date. If the task is being entered as a private task from the ToDo List in the ToDo Calendar Window, the default value is the date selected in the calendar.

Usage: The Date Due value of a task is based on the Date Due values of its children. If a task has children, its Date Due value is set to the Date Due of its earliest child. If a task does not have children, its Date Due value is set by the user. Therefore, you cannot change the Date Due value of a parent task; you can only change the Date Due value of leaf-level tasks. Because a parent task inherits its Date Due value from its children, when you are building a task structure it is often simpler to accept the default value until you reach the leaf level of the hierarchy. At the leaf level, assign Date Due values, and the parent task’s values will be set automatically.
It is recommended that all tasks be assigned a Date Due. If the Date Due field is left blank, the task is designated as an Ongoing Task within KWS. The Ongoing Task option was originally provided in KWS to enable the user to have quick access to tasks of a repetitive nature that are difficult to assign a specific due date. A better method for defining these tasks is now available. See Chapter 6, The Task Palette, for detail on this method.

**Duration**

*Entering Duration*

**To enter Duration:** Type the value into the Duration field, or set the value by clicking on the up and down arrows to the right of the field.

**Description:** An estimate of the number of work days and hours it will take to complete the task.

**Type:** A numeric field that is divided into days and hours.

**Default Value:** 0 days, 0 hours

**Usage:** KWS uses the information stored in the Duration field to compute the Late Start Date for a Task (See Late Start Date, p 3-18). Work days are formulated as 8 hr, and exclude Saturdays and Sundays.

The Duration value of a parent task is equal to the difference between the latest Date Due value and earliest Start Date value of its children. If a task does not have children, its Duration value is set by the user. Therefore, you cannot change the Duration value of a parent task; you can only change the Duration value of leaf-level tasks. Because a parent task inherits a Duration value from its children, when you are building a task structure, it is often simpler to accept the default value until you reach the leaf level of the hierarchy. At the leaf level, assign Duration values and the parent task’s values will be set automatically.

**Date Started**

*Entering Date Started*

**To enter Date Started:** Type the value into the date field using the DDMMYYYY format, or set the value by clicking on the up and down arrows to the right of the field.

**Description:** The date that work on a task is initiated.

**Type:** A date field entered using the format DDMMYYYY, where DD is the 2-character number for the day of the month, MMM is the first three letters of the name of the month, and YY is the 2-character number for the year. For example, February 3, 1997 is entered as 03FEB97.

**Default Value:** Current date
Usage: The Date Started field indicates that a task is in progress. This information is valuable for users who need to know the status of a task. Also, it can be used in conjunction with the Date Finished field value to compute the actual completion time for a task.

Date Started is set to the current date when the user marks a task Started from the Status Symbol Menu. The user may change this value from the Task Dialog Box if, for some reason, the Task Status was not set on the actual start date. If a task is not marked Started before it is marked Finished, the Date Started is set to the current date.

**Date Finished**

*Entering Date Finished*

To enter Date Finished: Type the value into the date field using the DDMMMYY format, or set the value by clicking on the up and down arrows to the right of the field.

Description: The date that work on a task is completed.

Type: A date field entered using the format DDMMMYY, where DD is the 2-character number for the day of the month, MMM is the first three letters of the name of the month, and YY is the 2-character number for the year. For example, February 3, 1997 is entered as 03FEB97.

Default Value: Current date

Usage: The Date Finished field is used to indicate that a task is completed. A completed task will be displayed on your ToDo List (with a check mark next to it) until the Date Due value is less than the current date. This value is also used in conjunction with the Date Started value to compute the actual completion time for a task. Date Finished is set to the current date when the user marks a task Finished from the Status Symbol Menu. You may change this value from the Task Dialog Box if, for some reason, the Task Status was not set on the actual completion date.

**% Effort**

*Entering % Effort*

To enter % Effort: Type the value into the % Effort field or select the value by clicking on the up and down arrows to the right of the field.

Description: An estimate of the percentage of effort a user will spend on completing a task.

Type: Integer with a maximum value of 100.

Default Value: 100

Usage: The % Effort field gives users an estimate of how much of their total effort should be spent on a task.
% Complete

*Entering % Complete*

**To enter % Complete:** Type the value into the % Complete field or select the value by clicking on the up and down arrows to the right of the field.

**Description:** An estimate of what percentage of the task has been completed.

**Type:** Integer with a maximum value of 100.

**Default Value:** 0

**Usage:** The % Complete field provides users with a measure of the progress that has been made on a task.

Assigned To

*Entering Assigned To*

**To enter Assigned To:** Type any valid KWS User ID in the Assigned To field, or click the small arrow located to the right of the field and select the desired value from the list provided. You may also enter the beginning characters of the User ID into the field to quickly locate a value in the list. For example, entering the value “ka” will automatically place you at the first User ID in the list beginning with “ka.”

**Description:** The KWS User ID of the user (or Work Group) responsible for completing the task.

**Type:** A 20-character text field. The value must be a valid KWS User ID or Work Group. It is a required field.

**Default Value:** The KWS User ID of the user entering the task.

**Usage:** All tasks indicated as ToDo items and assigned to your KWS User ID or any Work Groups containing your User ID are displayed in your ToDo List.

Performed By

*Entering Performed By*

**To enter Performed By:** Type any valid KWS User ID in the Performed By field, or click the small arrow located to the right of the field and select the desired value from the list provided. You may also enter the beginning characters of the User ID into the field to quickly locate a value in the list. For example, entering the value “ka” will automatically place you at the first User ID in the list beginning with “ka.”

**Description:** The KWS User ID of the user (or Work Group) who will perform the task.
Type: A 20-character text field. The value must be a valid KWS User ID or Work Group. It is a required field.

Default Value: The KWS User ID of the user entering the task.

Usage: The **Performed By** field enables a user to reassign a task to another user for actual completion, while still maintaining the responsibility for ensuring it is completed. When the **Performed By** value is different than the **Assigned To** value, the task will appear in the ToDo Lists of both User IDs. The task will appear in the ToDo List of the User ID contained in the **Assigned By** field with the transferred symbol next to it.

Whenever the **Assigned To** value is changed, **Performed By** is set to the same value as **Assigned To**. The **Performed By** field can then be set to a value different than the **Assigned To** value.

**Assigned By**

*Entering Assigned By*

To enter **Assigned By**: Type any valid KWS User ID in the **Assigned By** field, or click the small arrow located to the right of the field and select the desired value from the list provided. You may also enter the beginning characters of the User ID into the field to quickly locate a value in the list. For example, entering the value “ka” will automatically place you at the first User ID in the list beginning with “ka.”

Description: The KWS User ID of the user who assigned the task.

Type: A 20-character text field. The value must be a valid KWS User ID (not a Work Group). It is a required field.

Default Value: The KWS User ID of the user entering the task.

Usage: The **Assigned By** value should contain the User ID of the person within the organization responsible for assigning the task. Typically, this person would be the supervisor of the user specified in the **Assigned To** field.

**Task Owner**

*Entering Task Owner*

To enter **Task Owner**: Type any valid KWS User ID in the **Task Owner** field, or click the small arrow located to the right of the field and select the desired value from the list provided. You may also enter the beginning characters of the User ID into the field to quickly locate a value in the list. For example, entering the value “ka” will automatically place you at the first User ID in the list beginning with “ka.”

Description: The KWS User ID of the user who owns the task (i.e., the knowledge worker who has administrative rights for managing the task in KWS).
Type: A 20-character text field. The value must be a valid KWS User ID (not a Work Group). It is a required field.

Default Value: The KWS User ID of the user entering the task.

Usage: The Task Owner is considered to be the owner of the task and has full security rights for the task. Hence, the Task Owner value should be set to the User ID of the knowledge worker who should have ultimate authority on any modifications made to the task’s definition. In many cases, this value is the same as the Assigned By value.

Status Change

Entering Status Change

To enter Status Change: Click the small arrow to the right of the field and select the desired value from the list provided.

Description: The User ID within the Work Group assigned a task that has ultimate responsibility for indicating when a task is finished.

Type: A text field selected from a list containing the values All Members, Any Member, and all User IDs of the members of the Work Group to which the task is assigned.

The Status Change field is only active when the Assigned To value is set to a Work Group.

Default Value: Any Member

Usage: When a task is assigned to a Work Group, the final Task Status value is determined by the completion status of each member of the Work Group. As each member of the Work Group completes a task, they set their individual Task Status value. The final Task Status is set by KWS depending on the value of the Status Change field as follows:

- **All Members**: When all members of the Work Group set their individual Task Status values to Finished, KWS sets the final Task Status to Finished.

- **Any Member**: When any member of the Work Group sets their Task Status value to Finished, KWS sets the final Task Status to Finished.

- **User ID**: When the specified User ID within the Work Group marks their individual Task Status value to Finished, KWS sets the final Task Status to Finished.
**Task Status**

*Entering Task Status*

**To enter Task Status:** Click on the box next to the desired value within the **Task Status** box. If one box is already checked, clicking on another box will uncheck it and set the new value.

**Description:** An indicator of the progress made towards task completion.

**Type:** A text field selected from the values **Not Started**, **Started**, **Finished** or **OBE**.

**Default Value:** Not Started

**Usage:** The **Task Status** value should always reflect the current status of the task. The user should set **Task Status** to one of the following values as the status changes:

- **Not Started** – The task has not been started.
- **Started** – The task has been started.
- **Finished** – The task has been completed.
- **OBE** – The task has been overcome by events.

Setting the **Task Status** to any value other than **Not Started** will automatically cause the current date to be entered into the **Date Started** or **Date Finished** fields as appropriate.

**Cyclic**

*Marking a Task as Cyclic*

**To mark a task cyclic:** Click on the **Cyclic** box to change the value. If the box is already checked, clicking on it will uncheck it and vice versa. If the task has previously been saved with the **Cyclic** box checked, the value cannot be unchecked.

**Description:** Indicates that a task is repeated at regular intervals.

**Type:** An option box field that indicates a task is **Cyclic** when the box is checked and **Not Cyclic** when the box is not checked.

**Default Value:** Unchecked

**Usage:** See Cyclic Tasks, p 3-24, for more detail.
Cycle Type

Entering Cycle Type

To enter Cycle Type: Click on the box next to the desired value within the Cyclic area. If one box is already checked, clicking on another box will uncheck it and set the new value.

Description: An indicator of how often a cyclic task occurs.

Type: A checkbox field selected from the values Weekly, Monthly, Quarterly, and Yearly.

Default Value: Weekly

Usage: The value assigned to this field indicates to KWS how often the task should be repeated in the database. For example, if a cyclic task is assigned a Cycle Type of Weekly, then KWS will create an instance of the task that is due every week. This field is tied directly with the Last Cycle field, which indicates to KWS the last date to create an instance of the task.

This field is active only if the Cyclic option box is checked.

Last Cycle

Entering Last Cycle

To enter Last Cycle: Increment or decrement the value using the arrow box to the right of the Last Cycle field. KWS increments the date based on the due date and the number of days in the selected cycle.

Description: The due date of the last instance of a cyclic task.

Type: A date field of the format DDMMYY, where DD is the 2-character number for the day of the month, MMM is the first three letters of the name of the month and YY is the 2-character number for the year. For example, February 3, 1997 is entered as 03FEB97.

Default Value: None

Usage: Assigning a value to this field indicates to KWS that the task should be repeated in the database until the date specified. For example, if a weekly task with a Date Due value of 07JUN96 is assigned a Last Cycle Date of 21JUN96, three instances of the task would be added to the KWS database with due dates of 07JUN96, 14JUN96, and 21JUN96. You must enter a Last Cycle value or the task will not be projected.

This field is active only if the Cyclic option box is checked.
Priority

Entering Priority

To enter Priority: Click on the box next to the desired value within the Priority area. If one box is already checked, clicking on another box will uncheck it and set the new value.

Description: Indicates the importance of the task.

Type: A text field selected from the values Normal, High, or Critical.

Default Value: Normal

Usage: The color of a task in the ToDo List is determined by the value of the Priority field. Critical tasks are displayed in blue, and high priority and normal tasks are in black. Assigning a value to this field quickly indicates which task(s) to work on first.

Task Dialog Box Security Button

The Security... button on the Task Dialog Box is used to access the dialog box for assigning user access rights for modifying task data field values. Clicking the Security... button displays the Task Security Dialog Box (Figure 3-2).

Figure 3-2: Task Security Dialog Box

The following values may be assigned by Knowledge Worker and Work Group within the Task Security Dialog Box.

KW/Group

Selecting KW/Group

To select the KW/Group: Click on the desired User ID or Work Group in the list provided in the KW/Group box.
Description: The User ID or Work Group being assigned security rights for a task.

Type: A 20-character text field containing a valid KWS User ID or Work Group.

Default Value: PUBLIC

PUBLIC is a KWS generated Work Group that contains all KWS users within your organization.

Usage: Access rights are assigned by selecting from the list of User IDs and Work Groups. The currently assigned rights for the selected user are displayed in the fields to the right of the KW/Group box.

Delete

Assigning Task Delete Permission

To assign task delete permission: Click on the box next to the Delete field. If the box is already checked, clicking on it will uncheck it and vice versa.

Description: Indicates whether a user has permission to delete the task.

Type: An option-box field that indicates a user has delete rights when the box is checked and does not have delete rights when the box is not checked.

Default Value: Checked for the task owner’s User ID and unchecked for all other users.

Usage: Enables a user to delete a task from the KWS database. Only the task owner can assign delete permission on a task. This option safeguards against the erroneous deletion of tasks from the KWS database.

Update

Assigning Task Update Permission

To assign task update permission:

1. Click on the box next to the Update field. If the box is already checked, clicking on it will uncheck it and vice versa.

2. Set the scope of the update permission by clicking on the box next to the specific permissions available in the area below the Update box (Assignment, Due Date/Duration, Status, All Other Attributes).

Description: Indicates whether a user has permission to modify the Task Data field values.
**Type:** An option-box field that indicates a user has update rights when the box is checked and does not have update rights when the box is not checked.

**Default Value:** Update rights for Status field

**Usage:** Users with update permission can be assigned specific permissions for each data field they may update. When the Update checkbox is checked, one or more of the following Update Permissions may be assigned:

- **Assignment**
  The user may change the **Assigned To** and **Performed By** fields of the task.

- **Due Date/Duration**
  The user may modify the **Date Due** and **Duration** of the task.

- **Status**
  The user may modify the **Task Status**.

- **All Other Attributes**
  The user may modify all the other attributes of the task.

---

**Task Dialog Box Status Button**

Use the **Status...** button on the Task Dialog Box to obtain the individual user status of a task assigned to a Work Group. Clicking the **Status...** button displays the Task Group Status Window (Figure 3-3), which displays the individual **Task Status** values for each member of the Work Group.

![Task Group Status Window](image)

**Figure 3-3: Task Group Status Window**

The **Status...** button is only available when the value in the **Assigned To** field is a Work Group.
Task Group Status

**Description:** Provides a list of User IDs within the Work Group and their individual task status values.

**Type:** List of valid Work Group members and associated **Task Status** values.

**Default Value:** None

**Usage:** The **Task Group Status** List enables you to determine the overall status of a task by displaying the status of the individual members of the group.

---

**Task Dialog Box Description Button**

The **Description**... button on the Task Dialog Box is used to access a textual description of a task. Clicking the **Description**... button displays the Task Description Dialog Box (Figure 3-4), which contains the **Task Description** data field.

![Task Description Dialog Box](image)

Figure 3-4: Task Description Dialog Box

---

**Task Description**

*Entering the Task Description*

**To enter a task description:**

1. Click the **Description**... button on the Task Dialog Box. The Task Description dialog box will appear.

2. Enter text into the **Task Description** field.

3. Click **OK**.
**Description:** A textual description of a task.

**Type:** A 32,000-character text field that can include any combination of alphanumerical characters, punctuation marks, and standard ASCII symbols.

**Default Value:** Blank

**Usage:** Enables the task owner to enter or modify a textual description that provides more detail about the task. Users with Update, All Other Attributes permission may also modify the Task Description. Other users may only view the Task Description.

---

**KWS-Generated Data Fields**

When a user defines a task, KWS generates some additional data field values. With the exception of **Org ID**, these values do not appear in the Task Dialog Box but do appear in the task listings within the ToDo, Task, and Task Manager Windows.

---

**Org ID**

**Description:** Indicates the user’s organization.

**Type:** 20-character text field assigned by the KWS administrator.

**Default Value:** The organization of the user inserting the task.

**Usage:** KWS allows more than one organization to share a database. The KWS System Administrator assigns an **Org ID** to every **User ID**. Only those tasks assigned to the user’s **Org ID** will be displayed within the Task Manager.

---

**Task Type**

**Description:** Indicates whether a task is part of the organization’s task hierarchy or is a user’s personal task.

**Type:** A text field containing the value **Private** or **Public**.

**Default Value:** **Public** if the task is inserted in a Task Manager, Graphical Task Manager, or Task Window; **Private** if entered in a ToDo Window.

**Usage:** Public tasks are official activities performed by an organization. Private tasks are activities that are not official and, therefore, not necessary to include in the organization’s process model. Most tasks within KWS should be public.
Level

Description: Indicates the position of a task within the task hierarchy.

Type: Integer

Default Value: Not applicable

Usage: The value in the Level data field provides the user with an indication of where a task occurs in the organization's process model. A top-level task (or process) is assigned Level 1, children of a process are assigned Level 2, and so on.

Attachments

Description: Indicates the number of attachments associated with a task.

Type: Integer

Default Value: None

Usage: This value quickly indicates how many attachments are associated with a task without having to open the Attachment Window. When the value of the Attachments data field is greater than zero, then an attachment icon will appear in the Indicator Column on the right-hand side of the ToDo List, Task, Task Manager, Steps, Attachments, Do Its, Appointment, and Milestone windows.

Do Its

Description: Indicates the number of Do Its associated with a task.

Type: Integer

Default Value: None

Usage: This value quickly indicates how many Do Its are associated with a task without having to open the Do Its Window. When the value of the Do Its data field is greater than zero, then a Do It icon will appear in the Indicator Column on the right-hand side of the ToDo List, Task, Task Manager, Steps, Attachments, Do Its, Appointment, and Milestone Windows.

Task Number

Description: A unique number assigned to each task within the KWS database.

Type: Integer
Default Value: None

Usage: The Task Number is assigned sequentially by KWS when a task is inserted into the database. This value is used primarily by the KWS System Scheduler to differentiate between items that may have the same Title or ID value. Typically, the Task Number has no significance for the user but may be useful for the System Administrator should task record corruption occur within the database.

Late Start Date

Description: The latest date on which a task can be started to complete the task by the scheduled due date.

Type: A date field entered using the format DDMMYY, where DD is the 2-character number for the day of the month, MMM is the first three letters of the name of the month, and YY is the 2-character number for the year. For example, February 3, 1997 is entered as 03FEB97.

Default Value: Not applicable

Usage: The KWS Scheduler computes this date by subtracting the number of days entered in the Duration field from the date listed in the Date Due field. In the calculations, KWS excludes Saturdays and Sundays and rounds any hours up to 1 day. If a task's status is not set to Started by the end of the Late Start Date, then it is considered “In Danger of Becoming Late.”

THE TASK WINDOW

The Task Window (Figure 3-5) displays a list of tasks. The contents of the Task Window depend on the method used to open the window. When you request to view child tasks by double-clicking on a task in your ToDo List or another Task Window (or by clicking on the task icon in the Indicator Column), the Task Window contains a list of the selected task's child tasks. When you execute a task query from the Query, Tasks menu option, the Task Window contains a list of the tasks matching the selected query.

The functionality of the Task Window is exactly the same as the ToDo Window. They differ in that the Task Window contains more than just the tasks assigned to you. See The ToDo List Window, p 2-2, for details on using the Task Window.
THE TASK MANAGER

The Task Manager displays the public tasks defined for an organization within an MDI Window (Figure 3-6). The split-screen MDI Window allows you to view two levels of the task hierarchy simultaneously. Using this option, you can access all the levels of the task hierarchy without opening multiple Task Windows. The task information contained in each of the levels within the Task Manager MDI Window is the same as that displayed in the Task Window and the ToDo Window. See The ToDo Window for detail on the task information displayed.
Manipulating Tasks

Tasks can be manipulated within the Task Manager, Graphical Task Manager, ToDo, and Task Windows. Both the Task Manager and Graphical Task Manager are used when building or modifying the organization’s process model. The ToDo Window is used by individual knowledge workers for executing their tasks. Tasks within the ToDo Window may be decomposed through the Task Window. See *Adding Public Tasks From the ToDo List* for more detail.

The following sections describe how to manipulate tasks within the Task Manager. Detail on manipulating tasks within the Graphical Task Manager may be found in the section describing the Graphical Task Manager. Further detail on manipulating tasks within the ToDo Window may be found in Chapter 2, The ToDo List.

- **Opening the Task Manager**

  **To open the Task Manager:**

  1. Click on the **Task** option in the KWS Menu Bar.

  2. Select **Task Manager** from the list of options. The Task Manager Window will be displayed with your organization’s processes in the top level.

- **Viewing the Task Tree in the Task Manager**

  **To view the task tree in the Task Manager:**

  You may view the children of any task in the Task Manager by double-clicking on the task or clicking the task icon in the Indicator Column. The child tasks will be displayed in the lower workspace. You may continue moving down the hierarchy by clicking on a task to display its child tasks. You can move between the different levels of the Task Manager by clicking the browser arrow buttons located on the leftmost edge of the windows. If the browser arrow is gray, then the next level has no items.

- **Accessing Child Tasks, Steps, Attachments, and Do Its**

  **To access child tasks, steps, attachments, and Do Its:**

  Click the left mouse button on the desired resource icon in the Indicator Column of the Task Manager Window.

  or...

  Select the desired task and click the appropriate button from the Task Manager Window Button Bar.

  With either method, the window for the desired resource will be displayed.
Accessing Sibling and Parent Tasks

To access Sibling or Parent tasks:

1. Select the task for which you want to view the sibling or parent task.

2. Click the right mouse button to open the Available Options Menu.

3. Select the desired option, Siblings or Parent, from the menu. A task window will be displayed that contains the related tasks.

Inserting Public Tasks

Public tasks are a part of the organization’s KWS process model. Any task inserted within the Task Manager is a public task.

To add a public task from the Task Manager:

1. Move to the location in the task tree where you want to add the task.

2. Click the Insert button from the Task Window Button Bar to open the Task Dialog Box.

3. Enter the information for the task and click OK.

Modifying Tasks

A user may change task information for the tasks in the Task Manager. However, the information that can be changed depends on the task permissions assigned to the user.

To modify a task from the Task Manager:

1. Select the desired task and click the Modify button from the Task Manager Window Button Bar. The Task Dialog Box for the task will appear.

2. Make the desired changes in the Task Dialog Box and click the OK button.

Deleting Tasks

You may delete a task in the Task Manager only if you have been given delete permission for the task.

To delete a task from the Task Manager:

1. Select the task to be deleted.

2. Click on the Delete button from the Task Manager Window Button Bar. The Delete? Dialog Box will appear.

3. Click Yes to delete the task or No to cancel.

Remember that deleting a task deletes all its children, attachments, steps, and Do Its. Use this command with caution.
Moving and Copying Tasks

Tasks can be copied or moved to new locations within the task hierarchy. When a task is moved, all its child tasks, attachments, and Do Its are moved along with it. When a task is copied, all its child tasks are copied and links are made between the copied tasks to the original task's attachments and Do Its. It is important to remember that the attachments and Do Its are not copied. They are the same attachments and Do Its as those linked to the original task structure; any changes made to them from either task structure will be reflected in the other.

Tasks can be copied or moved between any of the task windows: Task, Task Manager, and ToDo. To copy tasks, it is necessary to open two Task Manager Windows.

To copy or move a task:

1. In the Task Manager Window, go to the location in the task hierarchy to which you want to move or copy the task.

2. Open a second Task Manager Window and select the task to be copied or moved.

3. Hold down the left mouse button and drag the selected task to the desired location in the other Task Manager.

4. Release the mouse button. The Confirm Move or Copy Dialog Box will appear.

5. Select Move or Copy as desired.

Converting a Private Task to a Public Task

Private tasks can be made a part of your organization’s public task hierarchy by copying the task from your ToDo List to the desired location in the Task Manager. However, the location you select in the task hierarchy cannot be at the process level. It must be at Level 2 or greater.

To convert a private task to a public task:

1. In the Task Manager Window, go to the location in the task hierarchy where you want to include the private task.

2. In your ToDo List, select the private task that you want to convert to a public task.

3. Hold down the left mouse button and drag the selected task to the desired location in the Task Manager Window.

4. Release the mouse button. The Confirm Move or Copy Dialog Box will appear.

5. Select Move.
**Changing Task Status**

Two methods change Task Status from the Task Manager Window. The quickest method uses the Status Symbol Menu. The other uses the Task Dialog Box.

**Task Status** should normally be updated within the ToDo List as the task is being executed. It should only be changed within the Task Manager as required for database maintenance.

To change Task Status using the Status Symbol Menu:

1. Select the desired task and place the cursor over the Status Symbol Column on the left side of the Task Manager.

2. Click the left mouse button once, and the Status Symbol Menu will be displayed with the options Not Started, Started, Finished, or OBE.

3. While holding the mouse button down, move the cursor over the appropriate status option and release the mouse.

To change Task Status using the Task Dialog Box:

1. Select the desired task and click the **Modify** button from the Task Manager Window Button Bar. The Task Dialog Box for the task will be displayed.

2. Mark the appropriate status option in the **Status** area of the dialog box, and then click the **OK** button.

**Assigning Task Permissions**

If you are the task owner, you can assign permissions to other users to allow them to perform actions on tasks you have inserted into the KWS database.

To assign Task Security:

1. If the Task Dialog Box is not already open, select the task for which you want to assign permissions.

2. Click the **Security** button on the Task Dialog Box. The Task Security Window will open.

3. Select the User ID or Work Group for which you want to assign permissions.

4. Select the desired permissions by clicking the appropriate checkbox.

5. For each additional user for whom you want to assign permissions, repeat steps 3 and 4.

6. Click **OK** to save.
CYCLIC TASKS

Tasks that need to be performed at regular intervals are referred to as "cyclic" tasks in KWS. Cyclic tasks occur at regular cycles throughout a specified time period. For example, the task Conduct Weekly Project Meeting occurs every week until the project is complete. Instead of inserting the same task multiple times, KWS allows you to designate a task as Cyclic; multiple instances of the task will then be created automatically. All children, steps, attachments, and Do Its associated with a cyclic task are also associated with each occurrence of that task.

Template

A Task Template is generated when a cyclic task is created. This Template is used by KWS to create instances of the task. The Template appears in the Task Manager as TEMPLATE: <Task Name>. It appears in the Graphical Task Manager as a task with a lighter bar color than other tasks. In both cases, the user can set options to display or not display Templates in the window. See Font and Data Display Preferences for more details on this option.

If a cyclic task is defined with an empty value in the Last Cycle field, only the Template is created. This allows you to define the task structure, including child tasks, attachments, Do Its, and steps before creating any of the cycles. When the task structure is complete, the instances of the cyclic task are created by entering a Last Cycle value for the Template.

Cycle Types

KWS allows users to define cyclic tasks that occur Weekly, Monthly, Quarterly, and Yearly.

Weekly

Instances of weekly tasks are assigned Date Due values that occur on the same day of the week as the Date Due value specified in the Template. For example, instances of a weekly task with Date Due of (Wednesday) 01JUL96 will occur on Wednesdays.

Monthly

Monthly tasks are assigned Date Due values that occur on the same date of the month as the Date Due value specified in the Template. For example, instances of a monthly task with Date Due of 30Jan96 will occur on the 30th of each month. If the month does not have a day with the date, as is the case with February, then KWS assigns the latest available date in the month, e.g., February 28th.

Quarterly

Quarterly tasks occur every 3 months. They are assigned Date Due values that occur on the same date of the third month as the Date Due value specified in the Template. For example,
instances of a quarterly task with **Date Due** of 30JAN96 will occur on the 30th of every third month, e.g. 30APR96. If the month does not have a day with the date, then the latest available date in the month is assigned.

**Yearly**

Yearly tasks occur once every year. They are assigned **Date Due** values that occur on the same date of the year as the **Date Due** value specified in the Template. For example, instances of a yearly task with a **Date Due** of 30JAN96 will occur on January 30th, e.g., 30JAN97. If the month does not have a day with the date, then the last available date in the month is used.

---

**Manipulating Cyclic Tasks**

**Inserting Cyclic Tasks**

The number of instances of a cyclic task created depends on the **Date Due**, **Cycle Type**, and **Last Cycle Date** values specified in the Task Dialog Box. The **Date Due** indicates the date that the first occurrence of the task is due and is used to determine the **Date Due** for all subsequent instances of the task. The **Cycle Length** indicates how often the task will occur: **Weekly**, **Monthly**, **Quarterly**, or **Yearly**. The **Last Cycle Date** indicates the date the last occurrence of the task is due. For instance, if you define a task as **Cyclic**, **Weekly** with a **Date Due** value of 02FEB96 and a **Last Cycle** date value of 23FEB96, four occurrences of the task will be created. The first occurrence will have a **Date Due** value of 02FEB96 and the last occurrence will have a **Date Due** value of 23FEB96.

Cyclic tasks may be inserted from the same locations as any other KWS task.

**To insert a cyclic task:**

1. Open a Task Dialog Box by clicking the **Insert** button.

2. In the **Date Due** field, enter the due date of the first occurrence of the cyclic task.

3. Click the **Cyclic** box. A check will appear in the box, and the Cyclic Options fields will become available.

4. Select the desired **Cycle Type**: **Weekly**, **Monthly**, **Quarterly**, or **Yearly**.

5. In the **Last Cycle** field, enter the date of the last occurrence of the cyclic task.

6. Enter all other Task data field values as appropriate, then click **OK**.
Modifying Cyclic Tasks

Both the Template and individual instances of cyclic tasks can be modified. Changes made to the Template will affect all unfinished instances of the cyclic task. Changes made to an individual instance will only affect that instance. Possible modifications to cyclic tasks include extending the Last Cycle Date, terminating unfinished instances, and changing the Cycle Type. In addition, modifications to the task structure can be made by adding or subtracting child tasks, attachments, Do Its, and steps.

Cyclic tasks cannot be changed to noncyclic.

To extend a cyclic task:

1. Select the Template for the cyclic task to be extended.

2. Open the Task Dialog Box by clicking the Modify button in the Task Button Bar options.

3. In the Last Cycle field, enter the new date of the last occurrence of the cyclic task.

4. Click OK.

To terminate unfinished instances of a cyclic task:

1. Select the Template for the cyclic task to be terminated.

2. Open the Task Dialog Box by clicking the Modify button in the Task Button Bar options.

3. In the Last Cycle field, enter the date of the last finished instance of the cyclic task.

4. Click OK.

5. A message will be displayed asking if you are sure you want to delete all of the tasks that are due after the date entered. Click Yes.

To modify an individual instance of a cyclic task:

1. Locate the individual instance of the cyclic task to be modified.

2. Modify the task structure as desired. All changes will be reflected only in the individual instance.
To modify the task structure for all unfinished instances of a cyclic task:

1. Locate the Template for the cyclic task to be modified.
2. Delete unfinished instances of the task.
3. Modify the task structure as desired.
4. Extend the cyclic task to the desired date.

To change the Cycle Type of a cyclic task:

1. Select the Template for the cyclic task to be changed.
2. Open the Task Dialog Box by clicking the Modify button in the Task Button Bar options.
3. Change the Cycle Type to the desired value.
4. Click OK.

If you change the Cycle Type of a cyclic task, the change will only affect future projections of the cyclic task. Existing instances of the cycle will remain unchanged. To remove unfinished instances of the previous cycle type, follow the procedure for terminating unfinished instances and then extend the cyclic task to create instances with the new Cycle Type.

 Deleting Cyclic Tasks

When deleting cyclic tasks, the Delete Cyclic Task? Dialog Box is displayed with the following options:

Delete All Cycles

Deletes all instances (finished and unfinished) of a cyclic task. The Template is not deleted.

Delete Just This Cycle

Deletes only the selected instance of a cyclic task whether finished or unfinished.

Delete Unfinished Cycles

Deletes all unfinished instances of a cyclic task.

Delete This Cycle and Later Cycles

Deletes the selected instance of a cyclic task and all later instances.

To delete all instances of a cyclic task:

1. Select the Template for the cyclic task to be deleted or any instance of the cyclic task.
2. Click the Delete button in the Task Button Bar options.
3. The Delete? Dialog Box will be displayed. Click Yes.

4. The Delete Cyclic Task? Window will then appear. From the options available, select Delete All Cycles.

5. Click OK.

**To delete one instance of a cyclic task:**

1. Select the instance of the cyclic task to be deleted.

2. Click the Delete button in the Task Button Bar options. The Delete? Dialog Box will be displayed.

3. Click Yes.

4. The Delete Cyclic Task? Window will then be displayed. From the options available, select Delete Just This Cycle.

5. Click OK.

**To delete all unfinished instances of a cyclic task:**

1. Select the Template for the cyclic task to be deleted or any instance of the cyclic task.

2. Click the Delete button in the Task Button Bar options.

3. The Delete? Dialog Box will be displayed. Click Yes.

4. The Delete Cyclic Task? Window will then be displayed. From the options available, select Delete Unfinished Cycles.

5. Click OK.

**To delete all instances of a cyclic task due after a specific date:**

1. Select the earliest instance of the cyclic task to be deleted.

2. Click the Delete button in the Task Button Bar options.

3. The Delete? Dialog Box will be displayed. Click Yes.

4. The Delete Cyclic Task? Window will then be displayed. From the options available, select Delete This Cycle and Later Cycles.

5. Click OK.
To delete all instances and the Template of a cyclic task:

1. Select the Template for the cyclic task to be deleted or any instance of the cyclic task.

2. Click the Delete button in the Task Button Bar options.

3. The Delete? Dialog Box will be displayed. Click Yes.

4. The Delete Cyclic Task? Window will then be displayed. From the options available, select Delete All Cycles.

5. Click OK. All instances of the cyclic task will be deleted, but the Template will remain.

6. Select the Template for the cyclic task to be deleted.

7. Click the Delete button in the Task Button Bar options.

8. The Delete? Dialog Box will be displayed. Click Yes.

9. The Delete Cyclic Task? Window will then be displayed. From the options available, select Delete Just This Cycle.

10. Click OK.

**PREDECESSOR AND SUCCESSOR RELATIONSHIPS**

A task that must be completed before starting another is called a predecessor. Conversely, a task that must be performed after another task is called a successor.

Certain rules are enforced whenever a task is designated as a predecessor or successor. These rules are:

- The status of a successor task cannot be set to Started or Finished until the predecessor task has been marked Finished or OBE. If you violate this rule, KWS displays a message stating that the task cannot be started until the predecessor has been completed.

- The Start Date of a successor task must be greater than or equal to the Date Due of the predecessor task. If you violate this rule, KWS reschedules the Start Date of the successor to equal the Date Due of the predecessor. If a task is a predecessor of a milestone, KWS reschedules the Date Due of the predecessor to equal the Start Date of the milestone.

Predecessor and successor links should typically be made between sibling tasks. If you need to do otherwise, you should probably rethink the way you
have decomposed your tasks. The step-by-step nature of predecessor and successor links usually infers the sibling relationship. For example, the Acquire Funds task (see Figure 3-7) has five child tasks - Write Proposal, Write Proposal Cover Letter, Review Proposal Package, Acquire Sponsor's Signature on Draft Proposal, and Submit Proposal Package for Approvals. The tasks Write Proposal and Write Proposal Cover Letter must be completed before Review Proposal Package, so they have been designated as predecessors of Review Proposal Package. Review Proposal Package must be completed before Acquire Sponsor's Signature on Draft Proposal and Submit Proposal Package for Approvals and has been designated as a predecessor of the two tasks. Upon completion of the final two sibling tasks, the parent task will also be completed. This example illustrates how a good task decomposition has related child tasks whose completion will result in the completion of the parent task.

![Graphical Task Manager](image)

Figure 3-7: Task Structure With Predecessor/Successor Relationships

Predecessors and successors are used in defining workflow. See Workflow in Chapter 4, Attachments for more detail on workflow.

- Creating Predecessor and Successor Relationships

The following method describes how to designate predecessor and successor relationships within task windows. Predecessor and successor relationships can be created by designating one task a successor of another or by designating one task a predecessor of another. Which method used is a matter of personal preference. Once a task is designated as a predecessor (or successor) of a second task, the second task automatically becomes the successor (or predecessor) of the first task.

**To designate a predecessor task:**

1. Select the task with which you want to create a predecessor relationship.

2. Click the **Pred** button. A Predecessor Window will be displayed. If no predecessors of the selected task currently exist, this window will be empty.
3. Locate and select the task you would like to designate as the predecessor. Drag the selected task to the Predecessor Window by holding down the left mouse button and releasing it within the Predecessor Window. A message window will ask whether you want to Move or Copy the task.

4. Select Copy. The task should now be displayed in the Predecessor Window.

To designate a successor task:

1. Select the task with which you want to create a successor relationship.

2. Click the Succ button. A Successor Window will be displayed. If no Successors of the selected task currently exist, this window will be empty.

3. Locate and select the task you would like to designate as the successor. Drag the selected task to the Successor Window by holding the right mouse button down and releasing it within the Successor Window. A message window will be displayed asking whether you want to Move or Copy the task.

4. Select Copy. The task should now be displayed in the Successor Window.

Defining predecessor/successor relationships within Task Windows can be confusing because multiple windows must be opened. We recommend you define predecessor/successor relationships in the Graphical Task Manager. See p 3-40, Creating Predecessor and Successor Links in the GTM, for more detail on this option.

- Viewing Predecessor and Successor Relationships

In the Task Manager, there is no way to immediately determine from the task list if a task has a predecessor or successor. Therefore, it is necessary to open the task's Predecessor and Successor Windows to determine if it contains any such tasks.

To view a predecessor or successor task:

1. Select the task for which you want to view the predecessor or successor.

2. Click the Pred or Succ button in the Task Button Bar options.

3. A Predecessor or Successor Window will appear. If no predecessors or successors of the selected task currently exist, this window will be empty.

- Deleting a Predecessor or Successor Relationship

When you delete a task from the predecessor or successor list, it is not deleted from the task hierarchy; only the predecessor or successor relationship is deleted.
To delete a predecessor (or successor) task:

1. Select the task whose predecessor (or successor) you wish to delete.

2. Click the Pred (or Succ) button in the Task Button Bar options. A Predecessor (or Successor) Window will be displayed.

3. Select the item from the predecessor (or successor) list to be deleted and click the Delete button in the Task Button Bar options. A dialog box will ask you to confirm the deletion.

4. Click Yes.

MILESTONES

A milestone is a zero duration task with a set due date. Whereas a task represents an activity that starts, finishes, and consumes resources, a milestone represents completion of a task or a set of tasks. The task Complete Budget Report is an example of a milestone. This task has a set due date and on its own has no duration. Instead, another task would be defined to accomplish this milestone such as Generate Budget Report (Figure 3-8). The use of milestones within KWS is optional. They are useful when you want to assign a task without having to specify a start date and duration. The user assigned the milestone would then be responsible for defining the task structure required to complete the milestone by the set date.

![Graphical Task Manager](image)

Figure 3-8: Defining a Milestone

Milestones are displayed in both the Task Manager and Graphical Task Manager Windows. The same actions that you can perform on tasks such as copying, deleting, and creating predecessor and successor relationships can be performed on milestones.

- Viewing Milestones

To view milestones:

1. Select Task from the KWS Menu Bar.

2. Select Milestones from the Task Menu. The Milestones Window showing the milestones defined for your organization will be displayed (Figure 3-9).
Figure 3-9: Milestones Window

Inserting a Milestone

To insert a milestone:

1. Select Task from the KWS Menu Bar.

2. Select Milestones from the Task Menu. The Milestones Window for your organization will be displayed.

3. Click Insert. The Milestone Dialog Box will be displayed (Figure 3-10).

Figure 3-10: Milestone Dialog Box

4. Enter the information required to define the milestone.

5. Click OK.

THE GRAPHICAL TASK MANAGER

The Graphical Task Manager (GTM) enables the user to view tasks in a graphical format. The graphical view is presented in a combined hierarchical tree and Gantt chart format (Figure 3-11). Depending on your personal preference, the graphical display may make it easier to understand the “nesting” of tasks and their relationships to each other. It is also easier to perform some task manipulations in the graphical view, e.g., assigning predecessor and successor relationships. The Task Manager presents the same information in text form.
Figure 3-11: Graphical Task Manager

- **Viewing all Public Tasks in the GTM**
  In the GTM, you may view all your organization’s public tasks, via the Graphic Task Manager option in the Task Menu.

  **To view all public tasks in the Graphical Task Manager:**

  1. Select the **Task** Menu from the KWS Menu Bar.
  2. Select the **Graphical Task Manager** option from the **Task** Menu.

- **Viewing a Specific Task in the GTM**
  A specific task listed within the Task Manager, a Task Window or the ToDo List can be viewed graphically via the Graph option in the Available Options Menu.

  **To view a specific task in the Graphical Task Manager:**

  1. Select the desired task from your task list.
  2. Open the Available Options Menu by clicking the right mouse button.
  3. Select the **Graph** option from the Available Options Menu.

- **Viewing a ToDo List in the GTM**
  You may view the items in your ToDo List graphically via the ToDo Graph (TDG) option. This option opens the TDG with all of the processes that include your ToDo items in an expanded view. The items in your ToDo List are displayed in bold typeface.

  **To open the TDG:**

  1. Select the **ToDo** Menu from the KWS Menu Bar.
  2. Select the **ToDo Graph** option from the **ToDo** Menu.
The purpose of the TDG is to enable you to see how your ToDo items fit within your organization. If your organization’s process hierarchy contains many tasks and your ToDo items span several processes, the TDG will be difficult to interpret. In this case, the method described above for viewing a specific task in the GTM is recommended.

Using the Graphical Task Manager

The GTM Window (Figure 3-11) is split into two parts by a separator bar: The task tree on the left and a Gantt chart on the right. The task tree provides a view of the task hierarchy. The Gantt chart provides a view of the tasks organized by date. A linear timeline at the top of the Gantt chart denotes months and years.

The Task Tree: In the task tree, each task is connected to its children and parents by a line. The task tree view may be expanded and compressed to display all of the tasks in the hierarchy or to display only a portion of the tasks. A plus (+) sign is displayed to the left of a task when the task has children and has not been fully expanded. A minus (−) sign is displayed to the left of a task when the task has been fully expanded.

The Gantt Chart: Each task in the Gantt chart is displayed as a rectangular bar, called the task bar, with attendant data in and around it. The attendant data includes the task Title, Status Symbols, and Indicator Icons. Depending on user-assigned preferences, the Date Due, Start Date, Duration, Percent Complete and predecessor/successor links may also be displayed with the task. The tasks are organized horizontally by date (Start Date and Date Due), with later dates to the right. The tasks are organized vertically by Start Date, with earlier tasks at the top. The size of each task is determined by the task’s duration. The result of this organization is that the tasks layer from left to right across the workspace in the order in which they should be performed.

Relationship Between the Task Tree and Gantt Chart: The two sides of the GTM Window are synchronized. When you select a task in the task tree, the same task is selected in the Gantt chart. Similarly, if you expand or compress a task on either side, the task is expanded or compressed on the other.

Adjusting the Separator Bar

The bar separating the two parts of the graphical view is called the Separator Bar. This bar can be moved to change the size of the task tree and Gantt chart views by dragging it one way or the other.

To adjust the Separator Bar:

1. Place the cursor over the bar. When the bar is selected, the cursor will change into a bar with arrows.
2. Click the left mouse button, and drag the bar to move it.

If you slide the bar to the leftmost side of the window, the task tree disappears and the separator bar is represented by a small bar, which appears to the left of the left scroll arrow at the bottom of the window. To move the bar back to the right, select the small bar and drag it.

● Viewing and Hiding Child Tasks

When you open the GTM, the task tree and Gantt chart are compressed and display only the top-level tasks. To view the children of a particular task, you must expand the task. After a task is expanded, the user must compress the task to hide the children of the task.

To expand a task:

In the task tree, double-click on the task title or click the plus sign to the left of the task.

or...

In the Gantt chart, double-click on the task bar.

To compress a task:

In the task tree, double-click on the task title or click the minus sign to the left of the task.

or...

In the Gantt chart, double-click on the task bar.

● Moving through the Task Tree and Gantt Chart

You can move horizontally in each window using the scroll bars at the bottom of the task tree and Gantt chart. The two windows are synchronized, so you can move vertically through both windows using the scroll bar at the right of the Gantt chart.

If you need to scroll a long distance through the Gantt chart, compressing the timeline can shorten the scroll time. Also, if you click the mouse anywhere in the Gantt chart outside of a task, the workspace will scroll horizontally to the task located on that line.

● Expanding and Compressing the Timeline

The timeline at the top of the Gantt chart can be expanded or compressed to control the length of the time period displayed. You can expand the timeline to shorten the timeframe or compress it to lengthen the timeframe.

To expand the timeline:

1. Move your mouse over the timeline.
2. Click either mouse button and drag it to the right until the desired time period is displayed.

**To compress the time line:**

1. Move your mouse over the timeline.

2. Click either mouse button and drag it to the left until the desired time period is displayed.

*Selecting a Task*

When a task is selected, the task bar is highlighted by a bold border and is outlined with a rectangular box. Within the outline, the **Late Start Date** is displayed on the left, the **Date Due** is displayed on the right, and the **Duration** is displayed in the middle. Other information may also be displayed depending on the GTM Window preferences specified (see **Setting Preferences in the GTM** in this section for more detail).

**To select a task:**

Click on the title of the task in the task tree.

or

Click on the task bar in the Gantt chart.

If you are selecting a task in order to edit it, you must select it from the Gantt chart, because tasks cannot be edited from the task tree.

*Changing Percent Complete in the GTM*

In the GTM, you can change the **Percent Complete** value by selecting the task and clicking the **Modify** button to open the Task Dialog Box. In the Task Dialog Box, enter the new value for **Percent Complete**. The GTM provides a simpler method that does not require opening the Task Dialog Box.

**To change Percent Complete in the GTM:**

1. Move the cursor between the two date fields in the Task Outline box. The cursor will change to a percent sign (%).

2. Click the left mouse button. The **Percent Complete** value will be displayed above the cursor.

3. While holding the left mouse button down, drag the percent cursor. When your desired **Percent Complete** value is displayed, release the mouse button.
If, in the GTM Window preferences, you specified that you wanted Percentage Complete to be displayed, then a red line representing the Percent Complete will be displayed over the task bar and will change in size as you drag the % cursor.

**Changing Task Status in the GTM**

Task Status is changed in the GTM in the same manner as in the Task Manager, i.e., via the Task Dialog Box or the Status Symbol Menu.

**To change task status from the Status Symbol Menu:**

1. Click the right mouse button in the space between the task bar and the outline (to the left of the task bar). The Status Symbol Menu will appear.

2. Select the desired status value from the Status Symbol Menu and release the mouse button.

**To change task status from the Task Dialog Box:**

1. Select the task and click the Modify button. The Task Dialog Box will open.

2. In the Task Dialog Box, change the status by clicking the box next to the desired value.

3. Click OK to save.

Remember that only the status of a leaf-level task can be changed.

**Changing Task Dates in the GTM**

Changes to task dates may be made by either moving the entire task or changing the individual Start Date and Date Due values.

**To change task dates by moving the task:**

1. Select the task to be moved by clicking on its task bar with the left mouse button.

2. While holding the left mouse button down, drag the task to the desired location. Note that the Start Date and Date Due change as you move the task.

**To change individual task dates:**

1. Select the date to be changed, either the Start Date or Date Due, by clicking on it with the left mouse button. The selected date will be surrounded by a red box.
2. While holding the left mouse button down, drag the date until the desired value is displayed, then release the mouse.

| You cannot change the **Start Date** and **Date Due** of a parent task directly. Instead, you must change the dates of the children, which will cause the dates to change in the parent. However, you can change both the **Start Date** and **Date Due** of a parent task by moving the task; the dates of the task's children will be changed accordingly. |

**Inserting a Task in the GTM**

A task may be inserted in the GTM as a sibling or child of another task. However, once a task already has a child, additional children are inserted by adding siblings to its child. Tasks are inserted into the GTM via the Task Dialog Box. See Task Definition, p 3-2, for detail on using the Task Dialog Box.

**To insert a sibling task:**

1. Select the task for which you want to insert a sibling.
2. Click the **Insert** button. The Task Dialog Box will appear.
3. Enter the task information.
4. Click **OK** to save.

**To insert a child task:**

1. Select the task for which you want to insert a child.
2. Double-click the left mouse button. The Task Dialog Box will appear.
3. Enter the task information.
4. Click **OK** to save.

**Modifying a Task in the GTM**

You may change all task data values within the GTM via the Task Dialog Box. See Task Definition, p 3-2, for detail on using the Task Dialog Box. However, the information that can be changed depends on the task permissions assigned to the user. See Task Security, p 3-12, for more detail.

**To modify a task in the GTM:**

1. Select the task to be modified by clicking the left mouse button on its task bar.
2. Click the **Modify** button from the Task Button Bar. The Task Dialog Box will open.
3. Enter your desired modifications into the Task Dialog Box.
4. Click **OK** to save your changes.

**Deleting Tasks in the GTM**

You may delete a task in the GTM only if you have been given delete permission for the task. See Task Security, p 3-12, for more detail.

**To delete a task from the GTM:**

1. Select the task to be deleted.

2. Click the **Delete** button from the Task Manager Window Button Bar. The Delete? Dialog Box will be displayed.

3. Click **Yes** to delete the appointment or **No** to cancel.

> Remember that deleting a task deletes all its children, attachments, steps, and Do Its. Use this command with caution.

**Saving Changes in the GTM**

If you have modified a task in the GTM, a red **M** symbol will appear in the left end of the task bar. If you have inserted a task in the GTM, a red **I** symbol will appear in the left end of the task bar. These symbols will remain until the changes are saved to the database.

You may choose to have your changes saved automatically whenever you make them by setting the **Save After Each Change** to Graph option. See Setting GTM Display Preferences on p 3-41 for more detail. The option to not have changes saved automatically is provided to assist in “what if” analysis of your model.

**To save changes in the GTM:**

1. If the GTM is not already the active window, make it active by clicking anywhere on it.

2. Open the **Window** Menu from the KWS Menu Bar and select **Save Changes**.

> If the GTM is not the active window, the **Save Changes** option will not be available.

**Creating Predecessor and Successor Links in the GTM**

**To create a predecessor (or successor) link:**

1. Select the predecessor task.

2. While holding down the mouse button, press the [Shift] key and drag the cursor to the desired successor task.

3. Release the [Shift] key and mouse button. A red arrow will be displayed to represent the link between the two tasks.
To delete a predecessor (or successor) link:

1. Select the predecessor task of the link to be deleted.

2. While holding down the mouse button, press the [Shift] key and drag the cursor to the successor task.

3. Release the [Shift] key and mouse button. The red arrow that indicated the predecessor/successor link will disappear.

You can customize the appearance of the GTM Window by specifying bar colors, which task data fields are displayed around the task bar, graph style, and whether KWS will save changes to a task as soon as you modify it.

To set GTM display preferences:

1. With a GTM Window active, open the Window Menu from the KWS Menu Bar and select Options. The Graph Preferences Window will be displayed (Figure 3-12).

![Graph Preferences Window](image)

Figure 3-12: Graph Preferences Window

2. Set display options by clicking on the box next to the option in the Display area. If an option is checked, then it will be displayed for all tasks. The option definitions are:

<table>
<thead>
<tr>
<th>Option</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Due Date</td>
<td>The task’s Due Date value will be displayed with the task bar.</td>
</tr>
<tr>
<td>Late Start Date</td>
<td>The task’s Late Start Date will be displayed with the task bar.</td>
</tr>
<tr>
<td>Duration</td>
<td>The task’s Duration value will be displayed with the task bar.</td>
</tr>
<tr>
<td>Percent Complete</td>
<td>A colored bar will be displayed over the task bar that represents the task’s Percent Complete value.</td>
</tr>
<tr>
<td>------------------</td>
<td>--------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Predecessor Links</td>
<td>The predecessor and successor links will be displayed by a red arrow between tasks.</td>
</tr>
<tr>
<td>Milestones</td>
<td>Milestones will be displayed in the GTM.</td>
</tr>
</tbody>
</table>

3. Color options may be set for:

<table>
<thead>
<tr>
<th>Task Bar For Level</th>
<th>Allows you to customize the color of the first six task levels.</th>
</tr>
</thead>
<tbody>
<tr>
<td>% Complete Bar</td>
<td>Allows you to customize the color of the Percent Complete bar.</td>
</tr>
</tbody>
</table>

Set Color options by clicking the button for the item for which you want to set the color. The Select Color Window will be displayed (Figure 3-13). Set the color by sliding the Red, Green, and Blue bar until the desired color is displayed in the box to the right.

![Select Color Window](image)

Figure 3-13: Select Color Window

4. Set Graph Style options by clicking on the box next to the option in the Graph Style area. If an option is checked, then the graph will be displayed using that style option. The option definitions are:

<table>
<thead>
<tr>
<th>Block</th>
<th>Parent tasks are displayed as blocks that surround child tasks.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bar</td>
<td>All tasks are represented as bars. A selected task will have a block that surrounds its child tasks.</td>
</tr>
</tbody>
</table>

5. Set the **Save After Each Change to Graph** option. If the Save After Each Change to Graph box is checked, KWS will save changes to a task as soon as it is modified in the GTM. If the box is not checked, then you must explicitly save any changes you make to a task in the GTM.
6. Set the **Save as Default** option. If the **Save as Default** box is checked, the preferences you specify will be saved as your default settings for future use in KWS. If the **Save as Default** box is not checked, changes made in the Graph Preferences Window will be active for the current KWS session only.

## STEPS

Steps provide an outline of the procedures users must follow in order to complete a task. They are the lowest level of detail used to define a task. Unlike tasks, steps have few data fields associated with them. Step data fields are entered through the Step Dialog Box (Figure 3-14).

![Figure 3-14: Step Window](image)

The four data fields associated with a step are:

- **Step Title**
  - A textual description describing the action to be performed.

- **Step Number**
  - The number indicating the order in which the step should be performed.

- **Completed**
  - An indicator of whether the step has been completed.

- **Date Completed**
  - The date the step was completed.

Steps are displayed within the Steps Window (Figure 3-15). They are organized by **Step Number**, which reflects the order in which the steps should be performed. Information about each step's status is displayed in the leftmost column with a check mark displayed if the step is completed. Similar to tasks, icons representing attachments and Do Its are displayed in the rightmost columns when these items exist.
Figure 3-15: Steps Window

❖ Viewing Steps

Steps associated with a task may be viewed by opening the Steps Window.

To view steps:

1. Select the task for which you want to view steps.
2. Click the Step button in the Task Button Bar
   or...

   Click the Step icon in the Indicator Column. In either case, the Steps Window will be displayed.

❖ Inserting Steps

To insert a step:

1. Select the task for which you want to insert the step.
2. Click the Steps button from the Button Bar or the Steps icon in the task’s indicator column (if one exists). The Steps window for the selected task will open.
3. To add a step in a specific location in the steps list, select the step that will precede the new step.
4. Click the Insert button. The Step Dialog Box will open.
5. Enter the Step Title in the Step Dialog Box.
6. Click OK to save.
Modifying Steps

To modify a step:

1. Select the step to be modified.
2. Click the Modify button.
3. Change the step information as desired and click OK to save.

Reordering Steps

The order in which steps are listed in the Steps Window can be changed by modifying the Step Number value.

To reorder a step:

1. Select the step to be reordered.
2. Click the Modify button. The Step Dialog Box will appear.
3. Change the value of the Step Number to the new value.
4. Click OK to save.

Deleting Steps

To delete a step:

1. Select the step to be deleted.
2. Click the Delete button. The Delete? Window will appear.
3. Click Yes to confirm your deletion, or Click No to cancel.

Be careful when deleting steps. Because there is no security at the step level, anyone can delete a step. Deleting a step also deletes all links to any Do Its and attachments associated with the step.

Changing Step Status

Steps can be assigned status values of Complete or Not Complete. Similar to tasks, the status of a step can be set through the Step Dialog Box or the Status Symbol Menu.

To change step status via the Step Dialog Box:

1. Select the desired task.
2. Click the Steps button. The Steps Window will appear.
3. Click the Modify button. The Step Dialog Box will appear.
4. In the Step Dialog Box, a step is complete when the box to the left of the Complete field is checked and not complete when it is not checked. Click on the checked box to make the check disappear and vice versa.
5. Click **OK** to save. A check mark will appear in the symbol field next to a completed step.

**To mark a step complete via the Status Symbol Menu:**

1. Click your left mouse button in the leftmost column of the Step Window next to the desired step. The Status Symbol Menu will appear.

2. While holding the mouse button down, select the desired Status value and release the mouse button.

---

**Moving and Copying Steps**

Steps can be copied or moved to new locations within the task hierarchy. When a step is moved, all of its attachments and Do Its links are moved along with it. When a step is copied, new links are created between the new steps and the attachments and Do Its. It is important to remember that the attachments and Do Its are not copied. The attachments and Do Its are the same ones linked to the original step, so any changes made to them from the new step will be reflected in the old step.

**To copy or move a step:**

1. Open the destination Step Window by selecting the task that the step will be associated with and clicking the **Steps** button or icon.

2. Open the Step Window containing the step(s) to be moved by selecting the associated task and clicking the **Steps** button or icon.

3. Select the step to be moved or copied. Hold down the left mouse button and drag the selected step to the destination window.
Chapter 4 ATTACHMENTS

Overview 4-2
Defining Attachments 4-2
The Attachments Window 4-8
Moving, Copying, and Linking Attachments 4-14
Creating Sensitive Attachments 4-17
Attachment File Storage 4-18
Searching Attachments 4-21
Attachment Access Rights 4-23
Workflow 4-24
OVERVIEW

Attachments are information resources used during the execution of an activity. Attachments can be associated with any of the following items: tasks, steps, appointments, and milestones. An association between any of these items and an attachment is referred to as an attachment “link.” Attachments may be defined during the initial development of a KWS process model or on an ad hoc basis as required by the user.

This chapter describes how to create an attachment, manipulate attachments to support task execution, define attachment access rights, and define attachment workflows.

DEFINING ATTACHMENTS

Each attachment has a specific set of information or data fields associated with it. This information is referred to as the Attachment Profile. When an attachment is created within KWS, the Attachment Profile information is stored in the KWS database and is used to search for and retrieve the file.

The Attachment Profile Dialog Box

Attachments are entered into the KWS database through the Attachment Profile Dialog Box (Figure 4-1). The Attachment Profile Dialog Box contains a set of data fields and captures user-specified values that define attachments within KWS. In addition, the Attachment Profile Dialog Box

![Attachment Profile Dialog Box]

Figure 4-1: The Attachment Profile Dialog Box
contains buttons used to access dialog boxes for capturing and viewing additional attachment information. The following sections describe the user-specified and KWS-generated data fields contained in the Attachment Profile Dialog Box.

User-Specified Data Fields

The following sections describe the Attachment Profile data fields entered by the user when defining attachments within KWS.

Title

To enter an attachment Title: Type the desired value into the Title field.

Description: A descriptive name given to the attachment.

Type: A text field that can include any combination of alphanumeric characters, punctuation marks, and standard ASCII symbols.

Default Value: Blank

Usage: The Title value should contain a textual description that enables you to easily recognize what is contained in the attachment file, not the actual DOS file name. For example, use a descriptive title that will remind you of the nature of the attachment such as FY97 Budget Report. For an individual item, the Title value should be unique so that you can differentiate it from others. The Title values for versioned attachments are the same and cannot be changed.

Description

To enter an attachment Description: Type the desired value into the Description field.

Description: Text describing the nature of the document.

Type: A text field that can include any combination of alphanumeric characters, punctuation marks, and standard ASCII symbols.

Default Value: Blank

Usage: The Description value contains text that enables you to easily identify the purpose of the document and differentiate between attachment versions. For example, use a description that will remind you of the differences between versions such as 1st Quarter Revision and 2nd Quarter Revision.
**Application**

- **Entering the Application Used To Create an Attachment**

**To enter the Application Name:** Click the small arrow to the right of the field and select the desired value from the list provided.

**Description:** The name of the application software or computer program used to create and launch the attachment file.

**Type:** A text field selected from your Application List.

**Default Value:** Blank

**Usage:** The Application Name is used by KWS to locate and launch the software required when editing the attachment file. If the Application Name is left blank, you will not be able to edit the attachment. The Application Name is selected from a list you generate in the KWS File Menu, Preferences, Applications option. See Customizing KWS, Application List Setup, p 7-12, for more detail. When you import an attachment file for which you have a predefined association for the extension of the file name, KWS will use the filename extension to automatically set the Application Name. This value can be changed if required. See Customizing KWS, p 7-10, Setting File Associations for more detail.

---

**Storage Type**

- **Entering the Attachment Storage Type**

**To enter the attachment Storage Type:** Click the small arrow located to the right of the field and select the desired value from the list provided.

**Description:** An indicator used by KWS to determine the physical location for storing the attachment file.

**Type:** A text field selected from a list containing the values Public, Private, or Removable.

**Default Value:** Public

**Usage:** Storage Type indicates the physical location for storing the attachment file. There are three possible values: Public, Private, or Removable. Public files are stored on the KWS shared file server and can be accessed by all KWS users. Private files are stored on the KWS workstation of the individual creating the attachment and can only be accessed by the attachment creator. Removable files are stored on a removable media of your choice such as a floppy or Bernoulli disk. The directories for Public and Private attachments are defined by KWS during the KWS installation process (See Database and File Storage Setup, p 7-23). There is no required directory structure for removable media, but it is recommended that the media be dedicated for KWS use only.
Attachment Type

To enter the Attachment Type: Click the small arrow to the right of the field and select the desired value from the list provided.

Description: Indicates the category of a document.

Type: A text field selected from a list containing a blank value and Referential.

Default Value: Blank

Usage: The Attachment Type value is used by KWS to determine storage and archival routines for attachments. A blank Attachment Type value is used for most attachments to indicate a general category. This general category includes attachments that are a product generated by a task. An Attachment Type value of Referential is used to indicate that an attachment contains information that may be useful in completing the task but will not be modified during the execution of the task. Examples include online Standing Operating Procedures and Department of the Army Regulation documents. When an attachment is specified as Referential, it will be stored in the referential attachment directory specified during KWS setup. See Customizing KWS, p 7-23, for detail on KWS Database and File Storage Setup.

The Attachment Type field is a new feature in KWS Version 2.5 and is not fully functional. Currently only two values are available: Blank and Referential. Future versions will allow for additional values. Its primary purpose in Version 2.5 is to separate Referential attachments from other attachments so that routines may be developed to improve access, sharing, and administration of referential documents.

Context

To enter the Context: Type the desired value into the Context field or click the small arrow to the right of the field and select the desired value from the list provided.

Description: A value used for organizing and searching attachments.

Type: A text field selected from a list or entered by the user that can include any combination of alphanumeric characters, punctuation marks, and standard ASCII symbols.

Default Value: Blank

Usage: The Context field is for organizing and searching for attachments based on its subject matter. It is an optional field but is useful for grouping related attachments. For example, if you want to relate all your attachments
for a specific subject such as "Personnel," you could enter the value Personnel into the **Context** field. You could then do an attachment search to list all attachments with the **Context** field value of Personnel.

### Access Rights

The **Access Rights** button on the Attachment Profile Dialog Box is used to define user access rights for attachments. Clicking the **Access Rights** button displays the Attachment Access Rights Dialog Box (Figure 4-2) where the following values may be assigned by Knowledge Worker and Work Group. See Attachment Access Rights, p 4-23, for more detail.

![Attachment Access Rights Dialog Box](image.png)

**Figure 4-2: Attachment Access Rights Dialog Box**

#### Access Rights

**View Profile**

Allows the user or work group to view only the attachment's profile and not the attachment file.

**Read/Copy**

Allows the user or work group to view the attachment’s profile and to view or copy the attachment file, but not to edit the document.

**Read/Copy/Edit**

Allows the user or work group to view the attachment’s profile and to view, copy, and edit the attachment file.

#### Security Restrictions

**Sensitive**

Allows only the attachment creator to view the attachment profile and access the attachment file. If **Sensitive** is checked, the attachment title is displayed in the attachments window only when the attachment creator is logged in.
KWS-Generated Data Fields

The following data fields are generated by KWS when a user defines an attachment within KWS.

**Version**

Contains the version number of the attachment file.

**Attached By**

The KWS User ID of the user who created the link to the attachment file. This value is used by KWS to determine who has subsequent modify rights to the attachment's profile.

**Date Attached**

The date the attachment link was created.

**Last Edit By**

Contains the KWS User ID of the user who last edited the attachment file. This value is set whenever a user opens the attachment via the Edit button in the Attachment Window Button Bar.

**Last Edit Date**

Contains the date the attachment file was last edited. This value is set whenever a user opens the attachment via the Edit button in the Attachment Window Button Bar.

**Links**

Indicates the number of links to items associated with an attachment file. This value can be obtained by clicking on the Links... button in the Attachment Profile Dialog Box. Clicking the Links... button will display the Attachment Links Window (Figure 4-3) that displays the number of links and lists the titles of all items attached to the attachment file.
THE ATTACHMENTS WINDOW

The Attachments Window (Figure 4-4) lists the attachment associated with a selected item alphabetically by Title. The information displayed in the window is determined by your display field setup. For instance, you may change the order of the fields displayed or remove a field from display. See Customizing KWS, Display Field Setup, p 7-4, for detail.

The first column to the left of the Attachments Window contains a symbol that indicates the type of each attachment. There are currently only three types of attachments: Normal, Referential, and Workflow. No symbol appears if the attachment is type Normal. The following symbols appear for Referential and Workflow attachments:

- **R** Referential
- **W** Workflow
Accessing Attachments Window Options

Options for manipulating attachments within the Attachments Window are accessed in the Attachments Window Button Bar and the Available Options Menu. These options are available whenever the Attachments Window is active.

To access Attachments Button Bar options:

1. Select the item associated with the attachment.

2. Click the Attach button in the button bar or the attachment icon in the indicator column to the right of the item. An Attachments Window will open and the Attachments Button Bar (Figure 4-5) will be displayed with the Insert, Delete, Profile, View, Edit, Export, Copy, and Version options available for attachment manipulation.

![Button Bar with options]

Figure 4-5: The Attachments Button Bar

To access the Attachment Window Available Options Menu:

1. Within the Attachment Window, select the desired attachment.

2. Click the left mouse button. The Available Options Menu will be displayed with the View, Edit, Export, Copy, Version, Profile, Delete, and Define Workflow options available for attachment manipulation.

The Available Options Menu provides the same options available from the Attachment Window’s Button Bar, except Insert. In addition, the Available Options menu provides the option Define Workflow. Currently, this is the only way to access the workflow features within KWS. For more detail, see Workflow, p 4-25.

Inserting an Attachment

When a user inserts a new attachment, a link is made from the attachment to the selected item. Attachment links may be made to existing files or to new files you create during the linking process.

To insert an attachment link to an existing file:

1. Select the item to which the file will be linked.

2. Click the Insert button. The Attachment Insert Dialog Box will appear (Figure 4-6).

3. From the Attachment Insert Dialog Box, select Import. A file browsing window will be displayed.
Figure 4-6: Attachment Insert Dialog Box

4. In the file browsing window, locate and select the file you want to attach and click OK. The Attachment Profile Dialog Box will be displayed.

5. Enter the information describing the attachment in the Attachment Profile Dialog Box.

6. Click OK. The new attachment will appear in the Attachment Window.

To insert an attachment link to a new file:

1. Select the item to which the file will be linked.

2. Click the Insert button. The Attachment Insert Dialog Box will be displayed.

3. From the Attachment Insert Dialog Box, select Create. The Attachment Profile window will be displayed.

4. Enter the information describing the attachment in the Attachment Profile Dialog Box.

5. Click OK. The application software entered in the Application Name field of the Attachment Profile will be launched with the new file.

6. Follow normal procedures for editing and saving the document with the launched application. (DO NOT CHANGE THE NAME OF THE FILE—KWS only recognizes the link to the filename it generated.) After you exit the application, the new attachment will be displayed in the Attachment Window.

 Deleting an Attachment

When deleting an attachment, only the link to the attachment file is deleted and not the file itself. If the last link to an attachment is deleted, the attachment file will be deleted. However, the user is given the opportunity to store the file outside the KWS environment if desired.

To delete an attachment:

1. Select the attachment to be deleted.
2. Click the **Delete** button. The Delete? Dialog Box will be displayed (Figure 4-7).

![Delete? Dialog Box]

Figure 4-7: The Delete? Dialog Box for Attachments

3. Click **Yes** to confirm the deletion, **No** to cancel.

4. If you deleted the last link to the attachment, the Attachment Delete Dialog Box will be displayed (Figure 4-8).

5. If you want to save a copy of the attachment file, click **Yes**. Otherwise, click **No**. [If you clicked **Yes**, a file browser window will be displayed where you can designate the name and location of the saved file.]

Only the user who created the attachment link (or System Administrator) is able to delete it.

![Attachment Delete Dialog Box]

Figure 4-8: Attachment Delete Dialog Box

- **Viewing and Modifying an Attachment Profile**

Most of the attachment information defined within the Attachment Profile can be viewed in the Attachment Window display fields. However, to modify or view all of the information it is necessary to open the Attachment Profile.
To view or modify Attachment Profile information:

1. Select the attachment for which you want to view or modify the Attachment Profile.

2. Click the **Profile** button. The Attachment Profile Window will be displayed.

3. To modify the Attachment Profile, enter the new values in the appropriate data fields and click **OK** to save. To view only and exit without making changes, click **Cancel**.

Only the user who created the original attachment link (or System Administrator) is able to modify the Attachment Profile information. The User ID of the attachment link creator is contained in the **Created By** data field for the attachment.

---

**Viewing an Attachment File**

KWS attachment files may be viewed without loading the application used to create it. For instance, a file created in WordPerfect can be viewed on the computer screen without requiring a copy of WordPerfect. You must specify a file viewer for use with KWS to have the capability to view attachments. If you do not specify a file viewer, the **View** option will not be available. See Customizing KWS, p 7-11, for more detail on setting up a file viewer.

**To view an attachment file:**

1. Select the attachment for which you want to view the file contents.

2. Click the **View** button from the Attachment Window Button Bar options. Your file viewer software package will be launched with the attachment displayed.

3. Follow normal procedures for viewing the document within the file viewer application. When finished, exit the application to return to KWS.

If you do not have a file viewer software package or your file viewer does not support the attachment file's format, you will have to launch the application used to create the file in order to view it. You can do this by clicking the **Edit** option instead of the **View** option available from the Attachments Window Button Bar. However, if you do not have Edit access rights, you will not be able to open the file using this method.

---

**Modifying an Attachment File**

KWS attachment files may be modified with the application used to create it. You must have a copy of the attachment’s associated application, and the application must be defined in your Application List in order to edit it. See Customizing KWS, p 7-12, for more detail on defining your application list. In addition, you must be the attachment’s creator or have Edit access rights.
To modify an attachment file:

1. Select the attachment to be modified.

2. Click the **Edit** button. KWS will launch the associated application with the selected attachment file.

3. Follow normal procedures for editing and saving the document with the launched application. **(DO NOT CHANGE THE NAME OF THE FILE)—** KWS only recognizes the link to the filename it generated.

**Exporting an Attachment File**

At times it may be necessary to copy an attachment file and save it to a location external to the KWS environment. For example, you may need to give a copy of an attachment file to someone who is not a KWS user or who is at a remote location. Within KWS, this capability is referred to as "exporting."

To export a copy of an attachment file:

1. Select the attachment for which you want to export a copy.

2. Click the **Export** button from the Attachment Window Button Bar options. A file browser window will be displayed.

3. In the file browser window, specify a name and location for the exported attachment and click **OK**.

It is important to remember that exporting an attachment file removes the *copy* of the attachment from the KWS environment. The original attachment file remains within KWS.

**Making Multiple Copies of an Attachment to the Same Item**

You can make multiple copies of an attachment file to the *same* item through the **Copy** option in the Attachment Window Button Bar.

To make multiple copies of an attachment to the same item:

1. Select the attachment that you want to copy.

2. Click the **Copy** button.

3. If the attachment has multiple links, the Copy Links? Dialog Box will be displayed (Figure 4-9). If you want the new copy to have the same links as the original click **Yes**. Otherwise, click **No**.
Creating Versions of an Attachment File

Versions of attachment files can be made to save variations of a single document as separate files. This capability can be used to track revisions of a document.

To create a new version of an attachment file:

1. Select the attachment for which you want to make a version.

2. Click the Version button. KWS will make a new version by making a copy of the selected attachment, incrementing the highest version number of the selected attachment by 1, and assigning the result to the version number of the copy. The new version will have the same title as the original attachment and cannot be changed.

3. (Optional) Enter text in the Description field of the new version that indicates the purpose of the version. This may be done by modifying the Attachment Profile.

When you make a version of an attachment, you will become the owner of the new version. This will be reflected in the Attached By field value in the Attachment Profile. All other profile information remains the same.

MOVING, COPYING, AND LINKING ATTACHMENTS

When you move, copy, or link existing attachments within KWS, it is important to understand the relationships that may exist between items and attachments. When an attachment is inserted, its initial link to an item is created (Figure 4-10(a)). Once created, the attachment may be linked to additional items (Figure 4-10(b)), the attachment may be copied and the copy linked to another item (Figure 4-10(c)), and the link may be moved from one item to another (Figure 4-10(d)).
<table>
<thead>
<tr>
<th>Task 1</th>
<th>![Attachment 1]</th>
<th>(a) Original attachment linked to a single task.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Task 2</td>
<td>![Attachment 1]</td>
<td>(b) An attachment linked to multiple tasks.</td>
</tr>
<tr>
<td>Task 3</td>
<td>![Attachment 1]</td>
<td></td>
</tr>
<tr>
<td>Task 1</td>
<td>![Attachment 1]</td>
<td>(c) Copy of an attachment linked to separate tasks.</td>
</tr>
<tr>
<td>Task 2</td>
<td>![Attachment 1]</td>
<td></td>
</tr>
<tr>
<td>Task 1</td>
<td>![Attachment 1]</td>
<td>(d) Attachment link moved from one task to another.</td>
</tr>
</tbody>
</table>

Figure 4-10: Attachment Link Relationships

Moving an attachment creates a link with a new item and deletes the link from the item from which it was moved.

To move an attachment link to another item:

1. Select the item associated with the attachment that you want to move and open its Attachment Window by clicking the Attach button.

2. Select the destination item (the one to which you want to move the attachment) and open its Attachment Window by clicking the Attach button.

You should now have two Attachment Windows open—one for the originating item and one for the destination item.

3. Select the attachment that you want to move, hold down the left mouse button, drag the attachment to the destination item’s Attachment Window, and release the mouse button. The Modify Attachment Links Dialog Box (Figure 4-11) will be displayed.

4. Select Move.
Figure 4-11: Modify Attachment Links Dialog Box

- **Copying an Attachment to Another Item**
  Copying an attachment to another item creates a new copy of the attachment file and creates a link with the new item.

  **To copy an attachment to another item:**

  1. Select the item associated with the attachment that you want to copy to another item. Open its Attachment Window by clicking the Attach button.

  2. Select the destination item (the one to which you want to move the attachment) and open its Attachment Window by clicking the Attach button.

  You should now have two Attachment Windows open—one for the originating item and one for the destination item.

  3. Select the attachment that you want to move, hold down the left mouse button, drag the attachment to the destination item Attachment Window, and release the mouse button. The Modify Attachment Links Dialog Box will be displayed.

  4. Select **Copy**.

  5. If the attachment has multiple links, the Copy Links? Dialog Box will be displayed (Figure 4-9). If you want the new copy to have the same links as the original click **Yes**. Otherwise, click **No**.

- **Linking an Attachment to Another Item**
  Linking an attachment to another item creates a new link from the attachment file to the new item. This feature provides the capability to link an attachment to multiple items.
To link an attachment to another item:

1. Select the item associated with the attachment that you want to link to another item. Open its Attachment Window by clicking on the Attach button.

2. Select the destination item (the one to which you want to link the attachment) and open its Attachment Window by clicking on the Attach button.

You should now have two Attachment Windows open—one for the originating item and one for the destination item.

3. Select the attachment that you want to link, hold down the left mouse button, drag the attachment to the destination item Attachment Window, and release the mouse button. The Modify Attachment Links Dialog Box will be displayed.

4. Select **Link**.

**CREATING SENSITIVE ATTACHMENTS**

Sensitive attachments are documents that must be kept secure from access by unauthorized personnel. For example, contract documents prior to award of the contract are considered sensitive. This access limitation typically requires that the file be stored on a media that can be removed and locked in a secure area. KWS provides the capability to link sensitive attachments to items, while maintaining the extra security restrictions required via the **Sensitive** option in the Attachment Profile.

Only the attachment creator is granted access rights to a sensitive attachment. In addition, the attachment is not listed in the Attachment Window unless the attachment creator is the user logged in to KWS, which further ensures that no one else is aware of the sensitive attachment's existence.

**Creating a Sensitive Attachment**

**To create a sensitive attachment:**

1. Within the Attachment Profile, click the **Access Rights...** button. The Access Rights Dialog Box will appear.

2. Check the **Sensitive** box located within the Security Restrictions area of the dialog box. The **Assigned Access Rights** options and the **User/Group** List will become grayed out because you may not give other users access rights to a sensitive attachment (Figure 4-12).

3. Click **OK**. You will be returned to the Attachment Profile Dialog Box. Because you designated the attachment as Sensitive, the **Storage Type** value has been set to **Removable**.
4. Enter the information required for specifying the removable media to which you want to save the attachment. See Attachment File Storage, below, for more detail on saving to removable media.

You may store a sensitive attachment with a **Storage Type** value of Public or Private by changing the value in the Attachment Profile. However, since the intent is to store sensitive attachments on a securable media, doing so will jeopardize security.

5. Click **OK**.

**ATTACHMENT FILE STORAGE**

The ability to effectively use and share documents in a workgroup environment such as KWS depends on the user’s ability to access them. KWS manages attachment file storage to ensure you have access to the documents you need. In addition, KWS manages document storage to ensure that users who should not have access to your documents do not.

KWS allows three **Storage Type** values: Public, Private, or Removable. The default **Storage Type** value is Public. Public attachment files are stored on your organization’s shared file server and can be accessed by all KWS users. Private files are stored on the KWS workstation where you create the attachment and can only be accessed by users at that workstation. Removable files are stored on a removable media of your choice such as a floppy or a Bernoulli disk.
KWS assigns default attachment access rights based on the value you assign for **Storage Type**. You can assign specific access rights to users or work groups to further control access to your attachments (see Attachment Access Rights, p 4-23).

When you create an attachment, KWS generates a file name and stores the file in a location reserved specifically for KWS attachments. This location is based on the value you assign to the **Storage Type** value. For **Storage Types** Public and Private, you are only responsible for designating the **Storage Type** value and are not required to determine the actual physical location where the document is to be stored. KWS uses the **Storage Type** value and the information specific to your organization to determine the physical location to store the document (See Database and File Storage Setup, p 7-23). For **Storage Type** Removable, you must specify the physical location for storing the file. KWS then uses the location you specify to store and retrieve the attachment.

**Saving Attachments to Removable Media**

To save an attachment to removable media:

1. Within the Attachment Profile, click the small arrow located to the right of the **Storage Type** field and select **Removable** from the list provided. A Media Info... button will be displayed on the lower right corner of the Attachment Profile Dialog Box (Figure 4-13).

![Figure 4-13: Attachment Profile Dialog Box With Media Info... button](image)

2. Click the Media Info... button. The Save to Removable Media Dialog Box will be displayed (Figure 4-14).

3. Specify the drive by clicking the small arrow located to the right of the **Drive** field and selecting a value from the list provided.

4. Select the directory that contains the file you want to open from the directory list box, or enter the directory name in the **Directory** field.
Figure 4-14: Save to Removable Media Dialog Box

5. Enter text in the **Media Description** field that identifies the storage media. It is recommended that you also label the disk with the same text value so you can easily identify it when you later retrieve the attachment file.

6. Click **OK**. KWS will generate a file name for the attachment and save it to the specified drive and directory.

KWS will use this information when you retrieve an attachment file from removable media. The system will display an Insert Removable Media Dialog Box to request you to insert the media you previously specified (Figure 4-15).

Figure 4-15: Insert Removable Media Dialog Box
SEARCHING ATTACHMENTS

KWS enables you to search for attachments associated with tasks and steps using Query-by-Example (QBE). Essentially, QBE enables you to search attachments by entering data values for fields contained in the attachment’s Profile. KWS uses these values to perform the search and retrieve the attachments that contain them.

Searching for Attachments

To search for an attachment:

1. Select Query from the KWS Menu Bar.

2. Select the Attachment Search option from the Query Menu. The Attachment Search Dialog Box will appear (Figure 4-16).

![Attachment Search Dialog Box](image)

Figure 4-16: Attachment Search Dialog Box

3. (Optional) Enter the Title value for which you want to search. You may also enter a text string value if you want to find attachments containing the string in its title.

4. (Optional) Enter the Storage Type value for which you want to search by clicking the small arrow to the right of the data field and selecting the desired value.

5. (Optional) Enter the Attachment Type value for which you want to search by clicking the small arrow to the right of the data field and selecting the desired value.
6. (Optional) Enter the **Context** value for which you want to search by clicking the small arrow to the right of the data field and selecting the desired value.

7. (Optional) Enter the **Document Text** value for which you want to search. **THIS SEARCH CAN TAKE A LONG TIME, SO USE IT ONLY WHEN NECESSARY.**

8. Select the task from which you want to search by checking the box next to one or more of the following options:

   **Current Task**
   Searches for attachments linked to the selected task. Attachments linked to the Steps associated with the task will also be searched.

   **Ancestors of Current Task**
   Searches for attachments linked to the upper level tasks of the selected task (all parents and their parents). Attachments linked to the Steps associated with the tasks will also be searched.

   **Descendants of Current Task**
   Searches for attachments linked to the lower level tasks of the selected task (all children and their children). Attachments linked to the Steps associated with the tasks will also be searched.

   **All Tasks**
   Searches attachments linked to all tasks and steps.

   Performing the **All Tasks** option may take a while, so use it only when necessary.

9. If you want your search to find only values whose letters match the case you entered in the search criteria, check the box next to the **Match Case** option in the lower righthand corner of the dialog box.

10. Click **OK**. When the search is complete, the Attachment Search Results Window will be displayed (Figure 4-17). This window lists all the attachments found that meet the search criteria. If no matches are found, the window will be empty. The text string entered in the **Title** field will be highlighted in the title of each attachment listed.
ATTACHMENT ACCESS RIGHTS

Each attachment has access rights associated with it that enable you to limit access to your attachments. As the attachment creator, you automatically have full rights to the attachment and are the only one who can modify access rights for other users.

The following access rights values may be assigned:

<table>
<thead>
<tr>
<th>Access Rights</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>View Profile</td>
<td>Allows the user or work group to view only the attachment’s profile and not the attachment file.</td>
</tr>
<tr>
<td>Read/Copy</td>
<td>Allows the user or work group to view the attachment’s profile and to view or copy the attachment file, but not to edit the document.</td>
</tr>
<tr>
<td>Read/Copy/Edit</td>
<td>Allows the user or work group to view the attachment’s profile and to view, copy, and edit the attachment file.</td>
</tr>
</tbody>
</table>

When you insert an attachment, KWS designates you as the Owner of the attachment and assigns default access rights to you and the Work Group PUBLIC. [PUBLIC is a KWS-generated Work Group that contains all KWS users within your organization.] Depending on the Attachment Type value you entered for the attachment—Public, Private, or Removable—KWS assigns the following default access rights:

<table>
<thead>
<tr>
<th>Access Rights</th>
<th>Public</th>
<th>Private</th>
<th>Removable</th>
</tr>
</thead>
<tbody>
<tr>
<td>Owner</td>
<td>View Profile, Read/Copy/Edit</td>
<td>View Profile, Read/Copy/Edit</td>
<td>View Profile, Read/Copy/Edit</td>
</tr>
<tr>
<td>PUBLIC</td>
<td>View Profile, Read/Copy</td>
<td>View Profile</td>
<td>View Profile</td>
</tr>
</tbody>
</table>
Assigning Attachment Access Rights

To assign attachment access rights:

1. Within the Attachment Profile Dialog Box, click the **Access Rights...** button. The Attachment Access Rights Dialog Box will appear (Figure 4-18).

![Attachment Access Rights Dialog Box](image)

**Figure 4-18: Attachment Access Rights Dialog Box**

2. Select the User ID or Work Group ID to which you want to assign access rights by clicking on it in the **User/Group** list.

To give the same access rights to all users, choose the KWS Work Group **PUBLIC**.

3. Within the **Assigned Access Rights** area of the dialog box, click the button next to the desired access rights (**View Profile**, **Read/Copy**, or **Read/Copy/Edit**).

4. Repeat steps 2 and 3 for each User ID or Work Group to which you want to assign access rights.

5. Click **OK**. You will be returned to the Attachment Profile Dialog Box.

6. Click **OK**.

WORKFLOW

Workflow is a capability that allows an organization to manage the route a document takes as it passes from person to person. As each person completes an assigned action on the document, the document is passed to the next person in the workflow. Insurance claim processing is a classic example of a workflow application. A predefined set of actions occur on the insurance claim document from its point of receipt in the claims office to the time it is processed and the final action is taken on the claim.
KWS provides workflow capability by allowing the user to define the path an attachment takes as it progresses through a task hierarchy. This path is referred to as the “workflow path.” As an attachment progresses through a workflow path, successive actions are performed on it until it reaches the last task in the path. The final task’s action on the attachment should result in a completed product.

Definition of a workflow path requires a mechanism for specifying the next task in the sequence. Within KWS, this mechanism is provided through predecessor and successor links (See Predecessor and Successor Relationships, p 3-29). After these relationships are established within a task hierarchy, an attachment can be designated as a workflow attachment and the path it will follow within the predecessor and successor task structure can be defined.

Proper definition of a workflow path requires a thorough understanding of the process and of task decomposition. Also, you must understand what types of task structures are candidates for workflow definition. The following criteria can be used to identify candidates when defining workflow paths.

- Tasks in the task hierarchy must be completed in a step-by-step fashion. In other words, before one task can be started, another one must be completed.

- A specific attachment is required at each step of the task hierarchy and some modification is performed on the attachment at each step. In addition, this attachment is a final product resulting from the completion of the tasks in the hierarchy.

**Defining a Workflow Path**

Before defining a workflow path for an attachment, the predecessor and successor links must be set up for the task hierarchy through which the path will flow. See Predecessor and Successor Relationships, p 3-29, for further detail. Once these links have been established, the workflow path is defined by linking the attachment from predecessor task to successor task until the attachment has been passed through the task hierarchy. At any point in the path, a copy of the attachment may be passed to the parent task or a successor task.

**To define a workflow path for an attachment:**

1. Select the attachment for which you want to define a workflow path.

2. Open the Available Options Menu by clicking the right mouse button.

3. From the Available Options Menu, select **Workflow Definition**. The Workflow Definition Dialog Box will appear (Figure 4-19). This dialog box displays the name of the attachment, the name of the current task to
which the attachment is linked, and the successor tasks of the current task. The parent task of the successor task is included at the top of the list.

Figure 4-19: Workflow Definition Dialog Box

4. Select the task to which you want to link the workflow attachment. Click the Link button. The symbol L will appear to the left of the task. Only one task in the window may have a workflow link.

5. If you want to link copies of the workflow attachment to any of the other tasks listed, select the task and click the Copy button. The symbol C will appear to the left of the task.

6. Click the Continue button. The Workflow Definition Dialog Box will show the successor tasks of the task to which you linked the workflow document. If there are no successors, the successor task list will contain only the title of the Parent task. If only the parent task is listed, you may only send a copy to it because it is not a successor.

7. Repeat Steps 4 and 5 until you have made all the desired workflow links. At any time during workflow definition, you may click the Back button to return to your previous link and make any modifications.

8. To terminate the workflow definition, click the Finish button. You will be returned to the Attachment Window. The workflow attachment will now have a W next to it in the indicator column.
Choosing Between Copying and Linking in Workflow Definition

The following example is provided to illustrate how you choose between copying or linking an attachment within a workflow path. Essentially you should follow the simple rule: If an attachment is going to be modified in some way during execution of the successor task, it should be linked to the task; otherwise, it should be copied. Copies are made to pass the attachment to a new workflow process or to provide information only. The following example is somewhat complex in that two attachments are being flowed through the task hierarchy. However, it illustrates how more than one workflow path can be used to produce the final product.

A graphical depiction of the sample workflow path is given in Figure 4-20. In this process, the task Write Proposal has the attachment “Proposal Document.” The task Write Proposal Cover Letter has the attachment “Proposal Cover Letter.” Both of these attachments must be passed to the task Review Proposal Package. Upon completion of Review Proposal Package, both attachments must be passed to Submit Proposal Package for Approvals and a copy of each passed to Acquire Sponsor’s Signature on Draft Proposal. Upon completion of Submit Proposal Package for Approvals, the attachment will be the final product of the overall task structure so a copy is sent to the parent task, Acquire Funds. The receipt of the signed hard copy of the attachments copied to the task Acquire Sponsor’s Signature on Draft Proposal will result in completion of the task, and the attachment will not be passed to any additional tasks.

Note that when an attachment is copied and not linked to another task in the workflow path, it should no longer be considered part of the workflow. However, the copy could then be used to start a new workflow definition. In this example, the copy passed to the parent task Acquire Funds could then be used in a new workflow within the parent’s sibling task Execute Funded Project.

Figure 4-20: Workflow Process
When defining the workflow paths for these attachments, three successive Workflow Definition Dialog Boxes would be displayed. The following workflow definitions would be designated in the order listed for the attachment “Proposal Document”:

1. **Link** to Review Proposal Package.

2. **Copy** to Acquire Sponsor’s Signature on Draft Proposal and **Link** to Submit Proposal Package for Approvals.

3. **Copy** to Acquire Funds.

The following workflow definitions would be designated in the order listed for the attachment “Proposal Cover Letter”:

1. **Link** to Review Proposal Package.

2. **Copy** to Acquire Sponsor’s Signature on Draft Proposal and **Link** to Submit Proposal Package for Approvals.

3. **Copy** to Acquire Funds.

**Accessing Workflow Attachments**

Workflow attachments are accessed in the same manner as any other attachment. However, workflow attachments have additional access constraints imposed. These constraints are:

- Once the task linked to a workflow attachment has been marked complete, the workflow attachment can no longer be modified from the completed task.

- A workflow attachment cannot be modified from a task until the predecessor task has been marked complete.

**Creating Multiple Copies of a Workflow Attachment**

At times you may want several copies of an attachment to follow the same workflow path. KWS enables this capability without having to define the path for each copy.

**To create multiple copies of a workflow attachment:**

1. Select the workflow attachment for which you want to copy.

2. Click the **Copy** button. The Copy Links? Dialog Box will appear.

3. Click the **Yes** button. The attachment and all its links will be copied.
Chapter 5 DO ITS

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview</td>
<td>5-2</td>
</tr>
<tr>
<td>Do Its</td>
<td>5-2</td>
</tr>
<tr>
<td>Time Agents</td>
<td>5-9</td>
</tr>
<tr>
<td>DoItBase</td>
<td>5-13</td>
</tr>
</tbody>
</table>
OVERVIEW

Do Its are executable programs that can be launched directly from KWS. Like attachments, Do Its can be linked to any of the following items: tasks, steps, appointments, and milestones. In general, Do Its automate repetitive activities performed by knowledge workers. An example of an activity that could be automated by a Do It is generating a weekly report that requires logging into a remote database, downloading data to your workstation, and compiling a report from the data.

Do Its also can be associated with time agents, which are executable programs performed at a specified time. Within KWS, you can define time agents that are associated with a Do It and time agents that run independently of Do Its. When a Do It is associated with a time agent, it is called a Time-Contingent Do It. This capability enables a user to define activities that can be executed automatically, eliminating the need for the user to start the program.

As the number of Do Its within the organization increases, a mechanism will be required for storing and retrieving them to simplify access and support sharing. KWS provides this capability through the DoItBase application. DoItBase is a collection of Do Its that have been archived. You may store your own Do Its in the DoItBase, and you may retrieve other user’s Do Its.

DO ITS

Each Do It has a specific set of information associated with it that KWS uses to execute the Do It. Do It information is captured using the Do It Dialog Box (Figure 5-1).

![Figure 5-1: Do It Dialog Box](image-url)
The Do It Dialog Box contains the following data fields, which capture user-specified values required for executing Do Its within KWS.

**Title**

- **Entering the Do It Title**

  **To enter the Do It title:** Type the desired value into the **Title** field.

  **Description:** A descriptive name given to the Do It.

  **Type:** A text field that can include any combination of alphanumeric characters, punctuation marks, and standard ASCII symbols.

  **Default Value:** Blank

  **Usage:** The **Title** value should contain a textual description that enables you to easily recognize what the Do It does, not the actual DOS filename. For example, use a descriptive title such as Generate Budget Report. For an individual task, step, or appointment, the **Title** values should be unique so that you can differentiate between them in the Do It Window.

**Command**

- **Entering the Do It Command**

  **To enter the Do It command:**

  Type the desired value into the **Command** field

  or...

  Click the file browser button to the right of the **Command** field and select the path and executable file name.

  **Description:** The name of the executable file required to launch the Do It.

  **Type:** Text field containing a valid file and path name.

  **Default Value:** Blank

  **Usage:** Any executable filename may be entered into the **Command** field. This includes program files with .exe extensions, batch files with .bat extensions, and command files with .com extensions. KWS supports both DOS- and Windows-executable files.
Optional Parameters

.jobs Enter Do It Optional Parameters

To enter the Do It optional parameters:

Type the desired value into the Optional Parameters field

or...

If your optional parameter is a file, click the file browser button to the right of the Optional Parameters field to select a filename.

Description: The parameters that your application uses on startup.

Type: Text field.

Default Value: Blank

Usage: These are the same parameters you would type after the application's filename when starting the application from the MS-DOS command prompt or from the Windows File, Run option. For example, to start Microsoft Excel with a specific file open, type the filename in this field. If your Do It does not require parameters, leave this field blank. See the documentation for your Do It for valid parameters.

Working Directory

.jobs Enter the Do It Working Directory

To enter the Do It working directory:

Type the directory path value into the Working Directory field

or...

Click the file browser button to the right of the Working Directory field and select the desired path.

Description: The name of the directory where the program files for the Do It are located.

Type: Text field containing a valid path name.

Default Value: Blank

Usage: The working directory value is optional. If a value is entered, the current directory is changed to this value before the Do It is executed. If the value is left blank, the directory where the program files are located is the working directory.
**Execution Mode**

**To enter the Do It execution mode:** Click on the box next to the desired value within the Execution Mode area. If one box is already checked, clicking on another box will uncheck it and set the new value.

**Description:** The screen interface mode in which you want the Do It displayed.

**Type:** A text field selected from the values **DOS Full Screen, DOS Window, or Windows Program.**

**Default Value:** DOS Full Screen

**Usage:** This option is used to control the screen interface for initially displaying the Do It. The possible values are:

- **DOS Full Screen**
  - Displays the Do It in a full screen DOS shell.

- **DOS Window**
  - Displays the Do It in a window from which the DOS application is executed.

- **Windows Program**
  - Displays the Do It in the Windows environment.

You may use either DOS Full Screen or DOS Window to run DOS applications. However, some DOS applications may not run in DOS Window mode. In this case, you will have to use DOS Full Screen mode. You must use Windows Program mode to run Windows applications.

**Window Size**

**To enter the Do It window size:** Click on the box next to the desired value within the Window Size area. If one box is already checked, clicking on another box will uncheck it and set the new value.

**Description:** The size of the window used for displaying Do Its with a value of **Windows Program** specified for the Execution Mode.

**Type:** A text field selected from the values **Normal, Maximized, or Minimized.**

**Default Value:** Normal

**Usage:** This option is only available if the Execution Mode value has been set to Windows Program. The possible values are:

- **Normal**
  - Displays the Do It in the screen size set by the Do It.
Maximized Displays the Do It in full-size window, which occupies the full screen.

Minimized Displays the Do It as an icon.

You should only use the Minimized value when the Do It does not require user input to execute.

The Do Its Window

The Do Its Window (Figure 5-2) lists the Do Its associated with the selected item alphabetically by Title. The information displayed in the window is determined by your display field setup. For instance, you can change the order of the fields displayed or remove a field from display. See Customizing KWS, Display Field Setup, p 7-4, for detail.

![Do Its: Generate Weekly Budget Report](image)

Figure 5-2: Do Its Window

- **Accessing Do It Window Options**

Options for manipulating Do Its within the Do Its Window are accessed in the Do Its Window Button Bar and the Available Options Menu. These options are available whenever the Do It Window is active.

**To access Do It Button Bar options:**

1. Select the item associated with the Do It.

2. Click the Do It button in the button bar or the Do It icon in the indicator column to the right of the item. A Do Its Window will open and the Do Its Button Bar (Figure 5-3) will be displayed with the Insert, Delete, Modify, and Execute options available for Do It manipulation.
Accessing the Do Its Window Available Options

You can access the Available Options Menu if at least one Do It is listed in the Do It Window.

To access the Do Its Window available options:

1. Within the Do Its Window, select the desired Do It.

   Click the left mouse button. The Available Options Menu will be displayed with the Delete, Modify, and Execute options available for Do It manipulation.

Inserting a Do It

To insert a Do It:

1. Select the item to which the Do It will be linked.

2. Click the Insert button. The Do It Dialog Box will be displayed (Figure 5-1).

3. Enter the information describing the Do It in the Do It Dialog Box.

4. Click OK. The new Do It will appear in the Do It Window.

Deleting a Do It

When deleting a Do It, only the link to the Do It is deleted and not the Do Its program file.

To delete a Do It:

1. Select the Do It you want to delete.

2. Click the Delete button. The Delete? Dialog Box will appear.

3. Click Yes to confirm the deletion, No to cancel.

Modifying a Do It

To modify a Do It:

1. Select the Do It you want to modify.

2. Click the Modify button. The Do It Dialog Box will be displayed.

3. Enter your modifications in the Do It Dialog Box in the appropriate data fields.

4. Click OK.
Executing a Do It

To execute a Do It:

1. Select the Do It you want to execute.
2. Click the **Execute** button. The Do It will be executed.

If the Do It does not execute, you may not have defined it correctly or there may not be enough memory available on your workstation.

Moving and Copying Do Its

You may copy a Do It to multiple items after it has been inserted in a Do Its Window. Also, you may move a Do It link from one item to another.

Moving a Do It creates a link with a new item and deletes the link from the item from which it was moved.

To move a Do It to another item:

1. Select the item associated with the Do It that you want to move and open the Do Its Window by clicking the **Do It** button.
2. Select the destination item (the one to which you want to move the Do It) and open its Do Its Window by clicking the **Do It** button.

You should now have two Do Its Windows open—one for the originating item and one for the destination item.

Select the Do It that you want to move, hold down the left mouse button, drag the Do It to the destination item's Do Its Window, and release the mouse button. The Confirm Move or Copy Dialog Box (Figure 5-4) will be displayed.

![Confirm MOVE or COPY](image)

**Figure 5-4: Confirm Move or Copy Dialog Box**

3. Select **Move**.
Copying a Do It to another item creates a link between the Do It to the new item. The Do It program files are not copied. This feature provides the capability to link a Do It to multiple items.

To copy a Do It to another item:

1. Select the item associated with the Do It that you want to copy and open the Do Its Window by clicking the Do It button.

2. Select the destination item (the one to which you want to copy the Do It) and open its Do Its Window by clicking the Do It button.

You should now have two Do Its Windows open—one for the originating item and one for the destination item.

3. Select the Do It that you want to copy, hold down the left mouse button, drag the Do It to the destination item’s Do Its Window, and release the mouse button. The Confirm Move or Copy Dialog Box will be displayed.

4. Select Copy.

TIME AGENTS

Time agents are useful to support execution of repetitive tasks that occur at regularly scheduled times. For example, suppose you have the ToDo item Generate Weekly Budget Report that consists of three steps: 1. Get budget data, 2. Review budget data, and 3. Print budget report. The first step involves downloading data from a remote computer into the appropriate budget report format. In addition, the first step is performed every Monday morning. If a Time-Contingent Do It is linked to this step, the budget data could be downloaded automatically at a specified time without your input. You could even set the Time-Contingent Do It to execute at a time such that the budget data is waiting for you when you arrive at work on Monday morning. You could then start immediately on the next step of reviewing the data, saving the time you would have spent waiting for the data to download.

Executing Time Agents

Individual time agents are started through the TimeAgent Program. Hence, the TimeAgent Program must be running before you can execute a time agent. If KWS is not running when the TimeAgent Program starts a time agent, you will be prompted for your KWS login information, which is required to obtain access to the KWS database. However, the KWS application will not be started; only its database will be accessed.

To start the TimeAgent Program:

1. Select Tools from the KWS Menu Bar.
2. Select **TimeAgent** from the **Tools** Menu options. The KWS TimeAgent Window will be displayed (Figure 5-5).

![KWS TimeAgent Window]

Figure 5-5: KWS TimeAgent Window

If you want a time agent to execute when you are not at your workstation, you must leave your workstation on with KWS and the TimeAgent Program running. If KWS is closed, the TimeAgent program will also close, and the Time Agent will not execute.

**To close the TimeAgent Program:**

1. Switch to the KWS TimeAgent Window using normal Windows procedures, e.g., [CTRL-tab].

2. Select **File, Close** from the TimeAgent Window Menu Bar or double click on the Control-menu box in the upper left corner of the window.

**Adding a Time Agent**

Time agents are added within the TimeAgent Program. Remember that you may define time agents that are associated with a Do It and time agents that run independently of Do Its. When a Do It is associated with a time agent it is referred to as a Time-Contingent Do It.

**To add a time agent [not associated with a Do It]:**

1. If you have not already done so, start the TimeAgent Program.

2. In the KWS TimeAgent Window, click the **Add** button. The TimeAgent Event Detail Window will appear (Figure 5-6).
The TimeAgent Event Detail Window contains the following data fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Title</strong></td>
<td>A textual description identifying the time agent.</td>
</tr>
<tr>
<td><strong>Command Line</strong></td>
<td>The path and executable file name of the program to be executed.</td>
</tr>
<tr>
<td><strong>Parameters</strong></td>
<td>Any additional parameters required in the Command Line when executing the program.</td>
</tr>
<tr>
<td><strong>Prompt Before Execution</strong></td>
<td>An indicator that specifies whether the user should be prompted before the program is executed.</td>
</tr>
<tr>
<td><strong>Type of Action</strong></td>
<td>Indicates that the time agent executes a program when set to the value <strong>Run Program</strong> or displays a message when set to the value <strong>Display Message</strong>.</td>
</tr>
<tr>
<td><strong>Owner</strong></td>
<td>The KWS user who added the time agent.</td>
</tr>
<tr>
<td><strong>Assign To</strong></td>
<td>The user or work group who can execute the time agent.</td>
</tr>
<tr>
<td><strong>Frequency</strong></td>
<td>How often the time agent should be run. Possible values are: <strong>One Time</strong>, <strong>Yearly</strong>, <strong>Monthly</strong>, <strong>Weekly</strong>, <strong>Daily</strong>, <strong>Every Minute</strong>.</td>
</tr>
</tbody>
</table>
Monthly, Weekly, Week Days (every day Monday through Friday), Daily (every day of the week), and Hourly. [Note that a time agent with a Frequency value of One Time will automatically be deleted after it executes.]

**Time**

The hour and minute that the time agent should execute.

**Week Day**

The day of the week the time agent should execute when Frequency is set to Weekly.

**Day**

The day of the month the time agent should execute when Frequency is set to Monthly.

**Month**

The month of the year the time agent should execute when Frequency is set to Yearly.

**Year**

The year the time agent should execute when Frequency is set to One Time.

**Enable Event**

Activates the time agent. This box must be checked before the time agent will execute.

3. Enter the information describing the time agent into the TimeAgent Event Detail Window.

4. Click OK.

**To add a time agent [associated with a Do It]:**

1. Select the item to which you want to link the Time-Contingent Do It.

2. Click the **Do It** button or icon. The Do Its Window will appear.

3. Click the **Insert** button. The Do It Dialog Box will appear.

4. Enter the information describing the Do It in the Do It Dialog Box. See Do Its, p 5-2, for details on entering data field values.

5. Click the **Time Agent Setup...** button. The TimeAgent Event Detail Window will appear.

6. Enter the data field values to define the time agent. The values for **Title** and **Command Line** are automatically set to the values entered in the Do It Dialog Box and cannot be changed.
7. Click OK. You will return to the Do It Dialog Box. A clock icon will appear to the left of the Do It title to indicate that it is a Time-Contingent Do It.

8. Click OK. The new Time-Contingent Do It will appear in the Do Its Window.

✧ **Modifying a Time Agent**

**To modify a time agent:**

1. Select the time agent to be modified.

2. Click the **Modify** button.

3. Enter the modifications.

4. Click OK.

✧ **Deleting a Time Agent**

**To delete a time agent:**

1. Select the time agent to be deleted.

2. Click the **Delete** button.

✧ **Copying a Time Agent**

**To copy a time agent:**

1. Select the time agent to be copied.

2. Click the **Copy** button. A copy of the time agent will appear with the same title as the original but prefixed by **COPY OF**.

✧ **Refreshing a Time Agent**

**To refresh a time agent:**

1. Select the time agent to be refreshed.

2. Click the **Refresh** button. The time agent information will reflect current values stored in the KWS database.

---

**DOITBASE**

The DoItBase contains a set of archived Do Its that have been saved by you and other users within your organization. You may add Do Its to the DoItBase or you may retrieve Do Its for your own use. Do Its in the DoItBase are stored in zip file format, which is used to compress multiple files into one file. You may then expand this compressed file to return the multiple files into their original format.
Starting the DoItBase

To start the DoItBase application:

1. Select Tools from the KWS Menu Bar.

2. Select DoItBase from the Tools Menu options. The KWS DoItBase Window will open (Figure 5-7).

![KWS DoItBase Window](image)

Figure 5-7: KWS DoItBase Window

Opening a DoItBase Database

To open an existing DoItBase database:

1. Select File from the DoItBase Menu Bar.

2. Select Open DoItBase from the File Menu. The Open DoItBase Dialog Box (Figure 5-8) will be displayed.

![Open DoItBase Dialog Box](image)

Figure 5-8: Open DoItBase Dialog Box
3. Select from the **Defined DoItBases** listed in the Open DoItBase Dialog Box and click **OK**. The KWS DoItBase Window now will contain a list of all of the archived Do Its in the selected database (Figure 5-9).

![KWS DoItBase Window With an Open DoItBase Database](image)

**Figure 5-9: KWS DoItBase Window With an Open DoItBase Database**

- **Adding a New DoItBase Database**

  **To add a new DoItBase database:**

  1. Select **File** from the DoItBase Menu Bar.

  2. Select **New DoItBase** from the **File** Menu. The Add DoItBase Dialog Box (Figure 5-10) will be displayed.

![Add DoItBase Dialog Box](image)

**Figure 5-10: Add DoItBase Dialog Box**

3. Enter a value in the **DoItBase Name** field and click **OK**.
Adding an Archive

To add an archive:

1. Click the **Add** button. The Archive Detail Dialog Box (Figure 5-11) will appear.

![Archive Detail Dialog Box](image)

Figure 5-11: Archive Detail Dialog Box

The Archive Detail Dialog Box contains the following data fields:

- **File Name**: The full path and file name of the zip file containing the Do It.
- **Brief Description**: A short description that identifies the Do It.
- **Full Description**: A long description that provides information about the contents of the zip file, Do It installation instructions, and any other information that might be useful.
- **Required Programs**: A list of commercially available software programs required to execute the Do It (e.g., Microsoft Excel).

2. Enter the information describing your archived Do It.

3. Click **OK**.
When an archive is copied, only the definition of the archive is copied. The actual archive file is not copied. Both definitions will be linked to the same file. If you want to link to a separate archive file, you must copy the archive file and add into the DoItBase a new definition that points to it.

To copy an archive:

1. Select the archive to be copied from your DoItBase list.
2. Click the **Copy** button. The archive definition will be copied and displayed in your DoItBase list prefixed by **COPY OF:**.

To modify an archive:

1. Select the archive to be modified from your DoItBase list.
2. Click the **Modify** button. The Archive Detail Dialog Box will appear.
3. Enter your modifications into the Archive Detail Dialog Box.
4. Click **OK**.

To delete an archive:

1. Select the archive to be deleted from your DoItBase list.
2. Click the **Delete** button. A message box will be displayed to confirm the delete.
3. Click **Yes**.

The DoItBase application contains a zip file viewer that enables you to view the contents of a zip file.

To view an archive:

1. Select the archive to be viewed from your DoItBase list.
2. Click the **View** button. The View Zip File Window will be displayed listing the contents of the zip file (Figure 5-12).
Figure 5-12: View Zip File Window

3. Exit the View Zip File Window by selecting File, Exit from the menu bar or double-clicking on the Control-menu box in the upper left corner of the window.

**Building a DoItBase Automatically**

The DoItBase application will automatically populate a DoItBase from a directory containing zip files.

**To automatically build a DoItBase:**

1. Open an existing or create a new DoItBase.

2. Select File from the DoItBase Menu Bar.

3. Select Properties from the File Menu. The DoItBase Properties Dialog Box will be displayed (Figure 5-13).

4. Enter the name of the directory containing the zip files into the Default Directory field.

5. If you want another user or work group to be able to access your DoItBase, enter the desired User ID in the Assigned To field.

6. Click OK. The zip files will be added to your DoItBase with the brief description value for each set to the name of the file.
Reconciling a DoItBase

The DoItBase application can determine if the zip files entered in the archive definitions still exist and, if not, delete the definition. This process is called reconciling a DoItBase.

To reconcile a DoItBase:

1. Open the DoItBase that you want to reconcile.
2. Select File from the DoItBase Menu Bar.
3. Select Reconcile from the File Menu. You will be prompted to delete any DoItBase archive definitions where the zip file does not exist.

Searching a DoItBase

You may search for text strings contained in the values for the Short Description, Long Description, and Required Programs of an archive.

To search a DoItBase:

1. Select Edit from the DoItBase Menu Bar.
2. Select Find from the Edit Menu. The Find Dialog Box will appear (Figure 5-14).
3. Enter the text field for which you want to search into the Find What field.
4. Select which data fields to search by checking any or all of them.
5. If desired, check Match Case.
6. Click OK. The first definition in your DoItBase Window that contains the text string will be highlighted.
Figure 5-14: Find Dialog Box for Searching a DoItBase
Chapter 6 TASK PALETTE

Overview 6-2
Using the Task Palette 6-2
OVERVIEW

The Task Palette application provides a mechanism for storing tasks that can be added to your KWS model as needed. Typically, tasks that are repetitive and ad hoc in nature are good candidates for the Task Palette. For example, the task of generating a purchase order request is done the same way each time. However, when it is done varies from instance to instance. The Task Palette application enables you to store the task “Generate Purchase Request” so that you can easily access it and add it to KWS whenever you need to perform the task.

Within the Task Palette, you can create multiple “palettes.” Each palette contains a set of related “palette tasks.” For instance, you can define a palette titled Admin that contains tasks for performing various administrative tasks for which you are responsible and another one titled Contracting that contains tasks for performing contracting activities. Any of these palette tasks can be added to your KWS model by opening the palette that contains them and copying them to KWS.

Palette tasks are originally defined within KWS and then copied to a palette. They have the same structure as any KWS task including child tasks, steps, attachments, and Do Its. Once copied to a palette, some of the field values can be modified, but you cannot change the task structure.

USING THE TASK PALETTE

* Starting the Task Palette  

To start the Task Palette application:

1. Select **Tools** from the KWS Menu Bar.

2. Select **Task Palette** from the **Tools** Menu. An empty KWS Palette Window (Figure 6-1) will appear.

![KWS Palette Window](image)

Figure 6-1: KWS Palette Window

* Opening an Existing Task Palette

To open an existing Task Palette:

1. Select **File** from the KWS Palette Menu Bar.
2. Select **Open Palette**... from the **File** Menu. The Open Palette Dialog Box (Figure 6-2) will appear.

![Open Palette Dialog Box](image)

**Figure 6-2: Open Palette Dialog Box**

3. Select the name of the palette to open. The **Palette Name** and **Owner** values of the selected palette will be displayed in their respective data field boxes.

4. Click **OK**. The palette will open and the individual palette tasks will be represented by a title and an icon in the KWS Palette Window (Figure 6-3). Also, the name of the palette will appear in the window's title bar.

![KWS Palette Window With an Open Task Palette](image)

**Figure 6-3: KWS Palette Window With an Open Task Palette**

- **Creating a New Palette**

  To **create a new palette**:

  1. Select **File** from the KWS Palette Menu Bar.

  2. Select **New Palette**... from the **File** Menu. The currently open KWS Palette Window will clear and the message "new palette opened" will be displayed in the window's status bar. Also, the name of the palette will be displayed as "untitled" in the window's title bar. To give it a name, you must save the new palette.
Saving a Task Palette

To save a task palette:

1. Select **File** from the Task Palette Menu Bar.

2. Select **Save As...** from the **File** menu. The Save As Dialog Box will appear (Figure 6-4).

![Save As Dialog Box](image)

Figure 6-4: Task Palette Save As Dialog Box

3. Enter a name for the new Task Palette into the **Palette Name** field box.

4. Click **OK**.

Copying a Task from KWS to a Palette

A task can be copied from any ToDo, Task, or Task Manager Window to a Palette. When you copy the task, all its child tasks, steps, attachments, and Do Its also will be copied.

You cannot drag a task from a Graphical Task Window to a palette.

To copy a task from KWS to a palette:

1. In KWS, select the top level task of the task you want to copy to a palette.

2. Press the [Shift] key and, while holding down the mouse button, drag the task to the KWS Palette Window. A Palette icon will appear with the title equal to the name of the selected task.

Copying a Palette Task to KWS

You can copy a palette task to any ToDo, Task, or Task Manager Window. When you copy the task, all its child tasks, steps, attachments, and Do Its will also be copied. If you copy a task to your ToDo List, it will become a private task and you will not be able to assign any portion of the task structure to another user. If you copy a task to a Task, or Task Manager Window, it will become a public task and a child of the task to which you copied it.
You cannot drag a palette task from a palette to a Graphical Task Window.

To copy a palette task to KWS:

1. Open the palette that contains the palette task you want to copy to KWS.
2. Select the palette task that you want to copy.
3. Press the [Shift] key and, while holding down the mouse button, drag the palette task to the desired location in KWS.

If the palette task requires any variable assignments before it can be copied, you will be prompted for the values (Figure 6-5). If the palette task contains any invalid values, such as an invalid User ID, you will be prompted for a new value.

![Task Attributes Dialog Box](image)

**Figure 6-5: Task Attributes Dialog Box**

**Deleting a Palette**

To delete a palette:

1. Select **File** from the Task Palette Menu Bar.
2. Select **Delete Palette**... from the **File** Menu. The Delete Palette Dialog Box (Figure 6-6) will appear.

![Delete Palette Dialog Box](image)

**Figure 6-6: Delete Palette Dialog Box**
3. Select the Palette to be deleted. The **Palette Name** and **Owner** values of the selected task will be displayed in their respective data field boxes.

4. Click **OK**. A message box will be displayed asking you to confirm the deletion.

5. Click **Yes**.

- **Editing the Name of a Palette Task**

  When a task is copied into a palette, the name of its icon is set equal to the title of the task. However, if you would like another title you can change it.

  **To edit the name of a palette task:**

  1. Click once on the name of the icon to be changed. The title will become highlighted, and a line cursor will appear.

  2. Enter your modifications by adding or deleting text from the label.

- **Deleting a Palette Task**

  **To delete a palette task:**

  1. Select the palette task to be deleted.

  2. Press the [Del] key. A message box will be displayed to confirm the deletion.

  3. Click **Yes**.

- **Setting Palette Permissions**

  You may assign permissions for other users to use and edit your palette. By default, all users can use and edit the task palettes you create.

  **To set palette permissions:**

  1. Select **Settings** from the KWS Palette Menu Bar.

  2. Select **Permissions...** from the **Settings** Menu. The Palette Permissions Dialog Box will be displayed (Figure 6-7).

  3. Click the small down arrow to the right of the field box. A list containing all User IDs and Work Groups in your organization will be displayed.

  4. Select the User ID or Work Group to which you want to assign permissions.

  5. Click **OK**.
Changing Task Palette Settings

A few options are available for customizing your Task Palette environment. These options are available from the Settings Menu in the KWS Palette Menu Bar.

To change Task Palette settings:

1. Select **Settings** from the KWS Palette Menu Bar. The following options will be available:

   - **Always on Top**
     By default, the KWS Palette Window will always be in front of any other windows. This option allows you to change the default so that when you move to another window, the KWS Palette Window will move to the background.

   - **Prompt for Icon Name**
     By default, when you copy a task to a palette, the task icon is given the name of the selected task. This option will cause a prompt to appear whenever you copy a task to a palette asking you to provide a name for the task icon.

   - **Arrange Icons**
     This option will arrange all of the icons in the current palette.

2. Select your desired option.

Viewing or Editing a Task Palette Task

You can view the task structure of a palette task and edit the task field values. You can also enter variable names for task field values so that users will be prompted to enter values when copying a palette task to KWS.
To open a palette task for viewing or editing:

1. Double-click on the task icon. The Task Dialog Box will appear (Figure 6-8).

![Task Dialog Box Diagram]

Figure 6-8: Task Dialog Box

The Task Palette Task Dialog Box contains a subset of the fields found in the KWS Task Dialog Box. The fields with grayed out values cannot be modified. The lower portion of the Task Dialog Box displays the tree structure of the task.

To view the tree structure of a task:

1. Select the task you want to view from the list provided within the Tasks area in the lower left corner of the Task Dialog Box. The attachments, Do Its, and steps linked to the task will be displayed in their respective box. These three lists are for reference only and cannot be changed. Also, the field values for the selected task will be displayed in the upper portion of the Task Dialog Box.

To change a field value:

1. In the Tasks area, select the task that you want to change. The information associated with the selected task will be displayed in the upper portion of the Task Dialog Box.

2. Select the field that you want to change.

3. Enter the new value.

4. Click OK.
To assign a variable value to a field:

You can assign a variable name to a field value or perform simple calculations within a field. A variable name can be any text string that starts with a dollar sign ($). For example, you can enter the variable name $ID in the ID field. Then, whenever you copy the task to KWS you will be prompted to enter a value for the $ID variable. The ID field will then be set to the value specified. Fields can also contain simple mathematical formulas. For example, you can enter the formula $START_DATE + 5 into the Date Due field. Whenever you copy the palette task to KWS you will be prompted to enter a value for the $START_DATE variable. The Date Due field will then be set to the value specified plus five.

When creating a palette task that will be utilized by other users, it is recommended that you enter variable values into the Assigned To, Performed By, and Assigned By fields. For example, suppose all three fields are set to the variable $KWS_USER. Each time the task is copied to KWS, the user copying it will be prompted to enter one value that will be assigned to all three fields. You may also leave these fields blank, and the values will default to the User ID of the user dragging the task to KWS.
Chapter 7 CUSTOMIZING KWS

Overview 7-2
KWS Program Window Configuration 7-2
Font and Data Display Preferences 7-3
Attachment Options 7-10
Knowledge Workers and Work Groups 7-17
KWS Database and File Storage Setup 7-23
Adding Items to the Tools Menu 7-25
OVERVIEW

KWS provides several options for customizing the KWS environment. These options include configuring the KWS Program Window, setting font and display preferences, defining options for handling attachments, entering knowledge worker and work group information, and setting up KWS database connections. The following sections describe these options.

KWS PROGRAM WINDOW CONFIGURATION

- **Saving Your KWS Window Configuration**

  KWS allows you to save your current window configuration with KWS. When you do this, the current size and location of all windows in the KWS workspace will be saved. These windows will then be displayed each time you login to KWS until you save a new configuration.

  **To save your KWS window configuration:**
  
  1. Select **File** from the KWS Menu Bar.
  2. Select **Preferences** from the File Menu.
  3. Select **Save Window Configuration** from the **Preferences** Menu.

  **or...**

  Instead of steps 1 - 3, you may enter [Ctrl + S].

  The contents of a GTM Window, attachment query windows, and Do It search windows are not saved.

- **Displaying the Status Bar**

  You can specify whether the status bar will be displayed in the KWS Program Window.

  1. Select **File** from the KWS Menu Bar.
  2. Select **Preferences** from the **File** Menu.
  3. Select **Show Status Bar** from the **Preferences** Menu.

  **If the Show Status Bar option has a check mark next to it, the Status Bar will be displayed. Otherwise, it will not be displayed.**

- **Displaying the Button Bar**

  You can specify whether the button bar will be displayed in the KWS Program Window.

  1. Select **File** from the KWS Menu Bar.
  2. Select **Preferences** from the **File** Menu.
3. Select **Show Button Bar** from the **Preferences** Menu.

If the **Show Button Bar** option has a check mark next to it, the Button Bar will be displayed. Otherwise, it will not be displayed.

**FONT AND DATA DISPLAY PREFERENCES**

KWS allows you to set preferences for fonts and displaying data fields. Preference options that are not window specific are accessed from the File Menu, Preferences option. Preference options that are window specific are accessed from the Window Menu.

**Display Font Setup**

- **Setting Display Fonts**

  You can specify the font to use to display text within KWS. The font you specify will be used for all text display within KWS, so any window can be active when you select this option.

To set display fonts:

1. Select **Preferences** from the KWS Menu Bar.

2. Select **Display Font...** from the **Preferences** Menu. The Font Window will be displayed (Figure 7-1).

![Figure 7-1: Font Window](image)

3. Select your desired **Font, Font Style**, and **Size** values from the lists provided.

4. Click **OK**.
Display Field Setup

*Specifying Display Fields*

You can specify which data fields will be displayed, the order in which they will be displayed, the width of the data field, and whether text should be wrapped for each window type. These options are window specific, so the fields displayed are different for each window type. **Remember to make the correct window type active before you select this option.**

To access display field options for the active window:

1. Select **Window** from the KWS Menu Bar.

2. Select **Display Field Setup** from the **Window** Menu. The Display Field Setup Window for the active window type will appear (Figure 7-2).

![Figure 7-2: Display Field Setup Window](image)

The Display Field Setup Window contains the following information:

**Fields Displayed**

The data fields that will be displayed in the window.

**Fields Not Displayed**

The data fields that will not be displayed in the window.

**Width**

The display width of the data field.

**Wrap**

Causes the text in the data field to wrap around to the next line within the boundaries of the data field width.

3. Within the Display Field Setup Window, any of the following procedures can be performed. When finished, click **OK** to save your changes.
To specify which data fields to display:

You specify which data fields to display by moving them between the Fields Displayed and the Fields Not Displayed lists.

1. Select the data field in the Fields Displayed list or the Fields Not Displayed list that you want to move.

2. Click the arrow button between the Fields Displayed and Fields Not Displayed lists that points toward the list to which you want to move the data field. The data field will move.

3. For each data field to be moved, repeat steps 1 and 2.

To reorder data fields:

1. Select the data field to be moved by clicking on it in the Fields Displayed list.

2. Move your cursor into the column of horizontal lines to the left of the data field titles. Do not hold down the mouse button. A thick bar will appear in place of the cursor.

3. Move the bar up or down through the column to the desired position.

4. Click the mouse button. The selected data field will be moved to the new position.

5. For each data field to be moved, repeat steps 1 through 4.

To set data field width:

1. Select the data field for which you want to change the display width.

2. Enter the new value in the Width field.

3. For each data field width to be changed, repeat steps 1 and 2.

To set the text wrap option:

1. Select the data field for which you want the text to wrap.

2. Click the Wrap checkbox. A check will appear in the box.

3. For each data field for which the text is to wrap, repeat steps 1 and 2.
Printer Page Setup

- Specifying Page Setup for Printing

You can specify page margins, headers, and footers to be used when printing text from KWS. The values specified will be used for all text prints from KWS, so any window can be active when you select this option.

To specify page setup for printing:

1. Select Preferences from the KWS Menu Bar.

2. Select Printer Page Setup from the Preferences Menu. The Page Setup Window will appear (Figure 7-3).

![Page Setup Window](image)

Figure 7-3: Page Setup Window

3. Enter the desired values for the Page Width, Page Length, Top Margin, Bottom Margin, Left Margin, and Right Margin.

4. Enter any text that you would like to display in the header and footer and enter values for their Left, Center, and Right Margins. You may also specify replaceable parameters in the header and footer to display information such as the current date, database ID, or KWS User ID. To see a complete list of valid replaceable parameters, click the Replaceable IDs... button in the lower left corner of the Page Setup Dialog Box. The Print IDs Window will be displayed with the available IDs listed (Figure 7-4).

5. Click OK.
Printer Font Setup

Setting Printer Fonts

You can specify the font that you want to use to print text from KWS. The font you specify will be used for all text prints from KWS so any window can be active when selecting this option. Note that these options only affect how the data will appear when printing and do not affect how the data appears in the window.

**To set printer fonts:**

1. Select **Preferences** from the KWS Menu Bar.
2. Select **Printer Font...** from the **Preferences** Menu. The Font Window will appear (Figure 7-1).
3. Select your desired **Font**, **Font Style**, and **Size** values from the lists provided.
4. Click **OK**.

Printer Field Setup

Specifying Printer Field Options

You can specify which data fields will be printed, the order in which they will be printed, the width of the data field, and whether text should be wrapped when printing from each window type. These options are window specific, so the fields displayed are different for each window type. **It is**
important to remember that you have made the correct window type active before you select this option. Also note that these options only affect how the data will appear when printing and do not affect how the data appears in the window.

To access print field options for the active window:

1. Select **Window** from the KWS Menu Bar.

2. Select **Printer Field Setup** from the **Window** Menu. The Print Field Setup Window for the active window type will appear (Figure 7-5).

![ToDo Print Field Setup](image)

**Figure 7-5: Print Field Setup Window**

The Print Field Setup Window contains the following information:

**Fields Displayed**
- The data fields that will be printed from the window.

**Fields Not Displayed**
- The data fields that will not be printed from the window.

**Width**
- The print width of the data field.

**Wrap**
- Causes the text in the data field to wrap around to the next line within the boundaries of the data field width.

3. Within the Print Field Setup Window, any of the following procedures can be performed. When finished, click **OK** to save changes.
To specify which data fields to print:

Specify which data fields to print by moving them between the **Fields Displayed** list and the **Fields Not Displayed** list.

1. Select the data field in the **Fields Displayed** list or the **Fields Not Displayed** list that you want to move to the other list.

2. Between the **Fields Displayed** and **Fields Not Displayed** lists, click the arrow button that points toward the list to which you want to move the data field. The data field will be moved.

3. For each data field you want to move, repeat steps 1 and 2.

To reorder data fields:

1. Select the data field to be reordered by clicking on it in the **Fields Displayed** list.

2. Move your cursor into the column of horizontal lines to the left of the data field titles. **Do not hold the mouse button down.** A thick bar will appear in place of the cursor.

3. Move the bar through the column to the desired position.

4. Click the mouse button. The selected data field will be moved to the new position.

5. For each data field that you want to reorder, repeat steps 1 through 4.

To set data field width:

1. Select the data field for which you want to change the print width.

2. Enter the new value in the **Width** field.

3. For each data field width you want to change, repeat steps 1 and 2.

To set the text wrap option:

1. Select the data field for which you want the text to wrap.

2. Click the **Wrap** checkbox. A check will appear in the box.

3. For each data field for which you want the text to wrap, repeat steps 1 and 2.
ATTACHMENT OPTIONS

Customize the KWS environment for handling attachments by setting file associations, specifying a file viewer, and defining your Applications List. These options are described in the following sections.

Setting File Associations

File associations are relationships between files and the applications used to manipulate them. These relationships are based on the one to three character suffix that appears after the period in the filename. For example, a filename of budget.wpd has a file extension of wpd. Most applications append a file extension that is unique to the files created. When a file is associated with an application, you can open the file and start the application at the same time.

In the Windows environment, these associations are managed within the File Manager. When you install Windows, some files are already associated with applications and you may add your own associations. During initial installation, KWS imports the Windows File Manager associations into its own Associations List. You may add to and modify your KWS Associations List. KWS uses this information to determine the Application Name for an attachment when it is imported or to launch an attachment for editing if an Application Name has not been specified.

❖ Setting KWS File Associations

To set KWS file associations:

1. Select File from the KWS Menu Bar.
2. Select Preferences from the File Menu.
3. Select Associations from the Preferences Menu. The File Extension Associations Window will be displayed (Figure 7-6).
4. Enter the extension to be associated with an application in the Extension field.
5. Enter the path and command line for executing the application in the Command field by either typing the value into the field or by clicking the file browser button on the right and selecting the file in the file browser dialog box.
6. Click the Set button.
7. For each file association to be created, repeat steps 4 through 6.
8. When finished, click OK.
Figure 7-6: File Extension Associations

When your KWS Associations List is modified, your Windows Association List is not updated and vice versa. These are two separate lists. KWS simply takes advantage of the contents of the Windows Association List to populate the KWS Associations List when it is initially installed on your workstation.

Specifying a File Viewer

KWS enables you to view an attachment without having to launch the application used to create it. However, a file viewer must be specified before this option is available. A file viewer is a software package that displays the contents of a file as it would be displayed in the application that created it. A variety of commercially available file viewers allow users to view common file formats such as text files, word processing documents, database files, and graphic files.

- **Specifying a File Viewer**

  **To set up a file viewer:**

  1. Select **File** from the KWS Menu Bar.
  2. Select **Preferences** from the **File** Menu.
  3. Select **File Viewer** from the **Preferences** Menu. The Select File Viewer Window will be displayed (Figure 7-7).
  4. Select the path and executable file name for your file viewer software.
  5. Click **OK**.
Application List Setup

Before KWS can launch the application program used to create or edit an attachment file, it must know the application's location and executable command line. For example, if a user wants to edit an attachment file created in WordPerfect, KWS must know the location of the requesting user's executable file for WordPerfect (e.g., c:\wpwin\wpwin.exe). Using this information, KWS can launch the application with the associated attachment file. In KWS, this information is stored in the Application List.

Each KWS user maintains their own personal Application List. When you set up your Application List, you will choose the application names from the Master Application List. The Master Application List is entered by your KWS System Administrator and contains the standard names given to applications within KWS.

The purpose of the Master Application List is to ensure consistency in naming applications throughout KWS. Without this consistency, problems may arise when you try to edit an attachment created by another user who uses a different name for the application. For example, suppose you named your WordPerfect "Wpwin" and another user named theirs "WordPerfect," and each of you created attachments using these values in the Attachment Profile. When either of you tried to edit an attachment created by the other, KWS would not be able to find the application required to launch the file. To solve the problem, each of you would have to add the other user's application to your application list. In a large KWS environment, this fix is both cumbersome and confusing.

To add an application to your Application List:

1. Select File from the KWS Menu Bar.
2. Select **Preferences** from the **File** Menu options.

3. Select **Application List...** from the **Preferences** Menu options. The Application List Dialog Box will appear (Figure 7-8).

4. Select the application name to add to your list by clicking the small right arrow to the right of the **Application Name** field and then clicking on the desired application name from the list provided. The name you select will be entered for the value in the **Application Name** field, and its corresponding executable command will be entered for the value in the **Command Line** field.

5. The value in the **Command Line** field is a default value associated with the Application Name in the Master Application List. If this value is not correct for your individual workstation, change it by entering the correct value. To enter the value, type it into the field or select it by clicking the file browser button to the right of the field.

6. Once you have entered the **Application Name** and **Command Line** values, click the **Set >>>** button on the left of the dialog box to add it to your list.

7. For each application to be added to your list, repeat steps 4 through 6.

8. When finished adding applications, click **OK**.
Modifying the Command Line of an Application in Your Application List

To change the Command Line of an Application:

1. Select File from the KWS Menu Bar.

2. Select Preferences from the File Menu options.

3. Select Application List... from the Preferences Menu options. The Application List Dialog Box will appear.

4. Select the application name to be modified by clicking on its name in your application list. The name selected will be displayed in the Application Name field along with its Command Line.

5. Enter the new value in the Command Line field.

6. Click the Set >>> button on the left side of the Application List Dialog Box. The new Command Line value should appear in the application list.

7. Click OK.

Deleting an Entry in Your Application List

To delete an entry in your Application List:

1. Select File from the KWS Menu Bar.

2. Select Preferences from the File Menu options.

3. Select Application List... from the Preferences Menu options. The Application List Dialog Box will appear.

4. Select the application name to delete by clicking on its name in your application list. The name you select will be displayed in the Application Name field along with its Command Line.

5. Click the Delete button on the left side of the Application List Dialog Box. The application will be removed from the application list.

6. Click OK.

Creating Private Application Templates

When you create new attachments, KWS must be able to find a template file for the application. This template file is a file that is saved in the application's format. The template file is usually an empty file but may contain characters if desired. When you create a new attachment, KWS makes a copy of the template file and gives it a KWS generated filename. If a template file does not exist for a given application, you will not be able to create new attachments using its Application Name. However, you may still edit or view existing attachments with it.
KWS automatically generates a template file for an application selected from the Master Application List. This template file may be used for creating attachments, so it is not necessary to create template files. If you would rather have a personalized template for an application, you may create a private application template. For example, you may always want your Microsoft Word documents to be formatted using a specific style sheet. You may do this by creating a private application template for Microsoft Word that uses the style sheet.

To create a private application template:

1. Select **File** from the KWS Menu Bar.

2. Select **Preferences** from the **File** Menu options.

3. Select **Application List...** from the **Preferences** Menu options. The Application List Dialog Box will appear.

4. Select the application name for which to create a template by clicking on its name in your application list. The name selected will be displayed in the **Application Name** field along with its **Command Line**.

5. Click the **Launch** button on the left of the dialog box. KWS will launch the selected application.

6. Enter any text to be included in the template file and then save it using normal procedures for the application. **[REMEMBER THE NAME AND LOCATION OF THE FILE YOU CREATE—YOU WILL NEED IT LATER.]** Exit the application and you will return to the Application List Dialog Box.

7. Click the **Select Template** button on the left of the dialog box. The Select Template File Dialog Box will appear. Select the name of the file created in the previous step and click **OK**. Two asterisks will be displayed to the right of the Application Name to indicate that you have created a private template file for it.

8. Repeat steps 4 through 7 for each private template you want to create.

9. Click **OK** to save and exit the Application List Dialog Box.

* Editing a Private Application Template

To edit a private application template:

1. Select **File** from the KWS Menu Bar.

2. Select **Preferences** from the **File** Menu options.

3. Select **Application List...** from the **Preferences** Menu options. The Application List Dialog Box will appear.
4. Select the application name for which you want to edit the template by clicking on its name in your application list. The name selected will be displayed in the **Application Name** field along with its **Command Line**.

5. Click the **Edit Template** button on the left of the dialog box. KWS will launch the selected application with the template file.

6. Edit the template file. When you are finished editing, save the file using normal procedures for the application. **[DO NOT CHANGE THE NAME OF THE FILE.]** Exit the application and you will return to the Application List Dialog Box.

7. Click **OK** to save and exit the Application List Dialog Box.

**Adding Private Application Names to Your Application List**

KWS allows you to add applications to your personal Applications List that are not in the Master Application List. This capability is provided so attachments can be created using an application that has not been set up yet on the Master Application List. It is not recommended for regular use unless you do not need to share attachments with other users.

KWS will automatically set the **Storage Type** to **Private** for attachments created using Private Application Names. Hence, only the user creating the attachment will have access to it. As a private attachment, it will also be stored on the workstation where it was created. An attachment’s private **Application Name** may be changed to an **Application Name** on the Master Application List only after the application has been added by your System Administrator.

**To add a private application name to your Application List:**

1. Select **File** from the KWS Menu Bar.

2. Select **Preferences** from the **File** Menu options.

3. Select **Application List...** from the **Preferences** Menu options. The Application List Dialog Box will appear.

4. Enter the name of the application that you want to add to your list by typing it in the **Application Name** field.

5. Enter the executable file name for the application in the **Command Line** field by typing it into the field or by clicking on the file browser button to the right of the field and selecting the file name in the file browser window.

6. Once you have entered the **Application Name** and **Command Line** values, click the **Set >>>** button on the left of the dialog box to add the application to your list.

7. Click **OK**.
KNOWLEDGE WORKERS AND WORK GROUPS

KWS provides the capability to view a list of knowledge workers and work groups in your organization. In addition, you can modify information about a knowledge worker and add, modify, and delete work groups.

You must have KWS System Administrator privileges in order to add and delete KWS User IDs.

The User List

Viewing the KWS User List

The KWS User List contains all User IDs within your organization and the set of information associated with each User ID.

To view the KWS user list:

1. Select Admin from the KWS Menu Bar.

2. Select Knowledge Workers from the Admin Menu. The Knowledge Workers Window (Figure 7-9) will be displayed listing all the User IDs within your organization.

![Knowledge Workers in Organization PLB](image)

Figure 7-9: Knowledge Workers Window

Modifying User Information

Each KWS User ID has information associated with it that describes the knowledge worker to whom it is assigned. This information includes the knowledge worker’s full name, supervisor, phone number, and so on.

To modify user information:

1. Select Admin from the KWS Menu Bar.

2. Select Knowledge Workers from the Admin Menu. The Knowledge Workers Window will appear.

3. Select the User ID for which you want to modify user information.

4. Click the Modify button. The Knowledge Worker Dialog Box (Figure 7-10) will appear.
Figure 7-10: Knowledge Worker Dialog Box

The Knowledge Worker Dialog Box contains the following data fields:

**User ID**
The selected KWS User ID.

**Org**
The name of the organization to which the User ID has been assigned in the KWS database.

**KWS Admin Privilege**
Indicates whether the User ID has been granted KWS administrative rights.

**Name**
The first, middle, and last name of the user.

**Supervisor**
The name of the user’s supervisor.

**Office Symbol**
The user’s office symbol.

**Phone**
The user’s telephone number.

**FAX Phone**
The user’s FAX number.

**Address**
The user’s business mailing address.

5. Change user information by entering the desired value into the data field. Unless you have the KWS Admin Privilege, the **User ID** and **Org** fields will be grayed out and cannot be changed.

6. Click **OK** to save your changes.
Viewing Work Groups Containing a Selected User ID

From the User List, you may view a list of all of the work groups to which a selected User ID has been assigned. You may also view a list of all members assigned to work groups of the selected User ID.

To view work groups containing a selected User ID:

1. Select Admin from the KWS Menu Bar.

2. Select Knowledge Workers from the Admin Menu. The Knowledge Workers Window will appear.

3. Double-click on the User ID for which you want to view its assigned work groups. A Work Groups containing <User ID> Window will be displayed that contains all the work groups to which the User ID has been assigned (Figure 7-11).

4. From this window, you may view a list of members for any of the work groups listed by double-clicking on the work group.

<table>
<thead>
<tr>
<th>ID</th>
<th>Title</th>
</tr>
</thead>
<tbody>
<tr>
<td>GSS-12</td>
<td>Senior System Group for TAPES</td>
</tr>
<tr>
<td>KWS_COTR</td>
<td>COTRs for GT Contracts for KWS Version Development</td>
</tr>
<tr>
<td>KWS_DOCS</td>
<td>Review group for KWS System documentation</td>
</tr>
<tr>
<td>KWS_PI</td>
<td>PIs on KWS project</td>
</tr>
<tr>
<td>ORGANIZATION</td>
<td>Organization Process Owners</td>
</tr>
<tr>
<td>PAYROLL</td>
<td>All Government Employees using KWS within the Business Proc</td>
</tr>
<tr>
<td>PI GROUP</td>
<td>PIs in PLB</td>
</tr>
<tr>
<td>PL-B DB GROUP</td>
<td>PL-B KWS database restructuring group</td>
</tr>
</tbody>
</table>

Figure 7-11: Work Groups containing <user ID> Window

Work Groups

A work group is two or more knowledge workers working toward a common business goal. In KWS, tasks can be assigned to an individual knowledge worker and work groups. An organization within KWS is typically composed of multiple work groups with one or more knowledge workers assigned to each work group. When a task is assigned to a work group, each individual KWS User ID within the workgroup is assigned the task.

Viewing Work Group Information

Information about work groups may be viewed within the Work Groups Window (Figure 7-12), which displays a list of organizations and their Work Groups within an MDI Window. The split-screen MDI window allows you to view the work groups within an organization, the knowledge workers assigned to a work group, and the work groups assigned to a knowledge worker.
Figure 7-12: Work Groups Window

To view work group information:

1. Select **Admin** from the KWS Menu Bar.

2. Select **Work Groups** from the **Admin** Menu. The Work Groups Window will be displayed with your organization and work groups listed.

3. A list of the work groups in an organization can be viewed by double-clicking on the Organization. The work groups in the selected organization will appear in the lower level.

4. A list of the knowledge workers in a work group can be viewed by double-clicking on the Work Group. The work group list will move to the top level window and the knowledge workers in the selected work group will be displayed in the lower level.

5. A list of work groups to which a knowledge worker belongs can be viewed by double-clicking on the knowledge worker. The knowledge worker list will move to the top level window and the list of work groups to which the knowledge worker belongs will be displayed in the lower level.

Move between levels of the window by clicking the browser arrow buttons located on the leftmost edge of the windows. If the browser arrow is gray, there are no items at the next level.

**Adding Work Groups**

To add a Work Group:

1. Select **Admin** from the KWS Menu Bar.
2. Select **Work Groups** from the **Admin** Menu. The Work Groups Window will be displayed with your Organization selected and Work Groups listed.

3. Click **Insert**. The Work Group Dialog Box will appear (Figure 7-13).

![Work Group Dialog Box](image)

**Figure 7-13: Work Group Dialog Box**

The Work Group Dialog Box contains the following data fields:

- **ID**: The name of the Work Group. This value will appear in the KWS user list when assigning tasks.

- **Title**: A descriptive title that describes the purpose of the work group.

- **Org**: The organization to which the work group belongs.

4. In the Work Group Dialog Box, enter values for the **ID** and **Title**.

5. Click **OK**. The Work Group will appear in the list for the organization.

**Deleting Work Groups**

To delete a Work Group:

1. Select **Admin** from the KWS Menu Bar.

2. Select **Work Groups** from the **Admin** Menu. The Work Groups Window will be displayed with your Organization selected and Work Groups listed.

3. Select the Work Group to be deleted.

4. Click **Delete**. The Delete? Dialog Box will be displayed.

5. Click **Yes**.

**CAUTION -** KWS Version 2.5 does not have security associated with Work Groups. If you delete a Work Group that has tasks assigned to it, the tasks will still exist in the KWS database but will not appear on any user's ToDo list. Version 3.0 will resolve this problem.
Modifying Work Group Information

To modify work group information:

1. Select Admin from the KWS Menu Bar.

2. Select Work Groups from the Admin Menu. The Work Groups will appear with your Organization selected and Work Groups listed.

3. Select the Work Group for which you want to modify information.

4. Click Modify. The Work Group Dialog Box will be displayed.

5. Enter new values for the ID and Title.

6. Click OK.

Adding Users to a Work Group

To add users to a Work Group:

1. Select Admin from the KWS Menu Bar.

2. Select Work Groups from the Admin Menu. The Work Groups Window will be displayed.

3. Double-click on the work group to which users are to added. A list of users in the work groups will be displayed in the lower level window.

4. Select Admin from the KWS Menu Bar.

5. Select Knowledge Workers from the Admin Menu. The Knowledge Workers Window will be displayed that contains a list of User IDs within your organization.

6. Select the User ID that you want to add to the work group. While holding down the mouse button, drag the selected User ID to the window containing the list of users in the work group. A Confirm MOVE or COPY Dialog Box will appear.

7. Click Copy. The User ID will appear in the Knowledge Workers in Work Group level of the Work Groups Window.

Deleting a User From a Work Group

To delete a user from a work group:

1. Select Admin from the KWS Menu Bar.

2. Select Work Groups from the Admin Menu. The Work Groups Window (Figure 7-12) will be displayed.
3. Double-click on the work group from which you want to delete a user. A list of users in the work groups will be displayed in the lower level window.

4. Select the user that you want to delete from the work group.

5. Click **Delete**. The Remove from Group? Dialog Box will be displayed.

6. Click **Yes**.

**KWS DATABASE AND FILE STORAGE SETUP**

Your KWS database connections are typically defined for you when KWS is installed. You may view and modify this information and establish connections to other KWS databases if needed. When you have more than one database connection setup, you select which one you want to connect to when you log in to KWS. See Logging in to KWS, p 1-25, for more details.

Database connections are entered using the KWS Database Setup Window (Figure 7-14). In this window you may specify the information required for connecting to the database, as well as information required for storing attachment files. If you do not have the information you need, see your KWS System Administrator for assistance.

![Figure 7-14: KWS Database Setup Dialog Box](image)
The KWS Database Setup Window contains the following data fields:

**ID**
A short name used for identifying the database.

**Name**
A long name used to describe the database.

**Database Type**
The type of the database to which you are connecting. The value must be either Oracle OCI, Oracle ODBC, or Access ODBC.

**Oracle Host**
The source string required for connecting to the database.

**Knowledge Worker ID**
The KWS User ID used for connecting to the database.

**Database Login ID**
The Oracle User ID used for connecting to the database.

**Database Login Password**
The KWS password used for connecting to the database.

**KWS Table Owner ID**
The Oracle Table Owner ID of the database.

**Public Attachment Directory**
The directory and pathname used for storing Public attachment files.

**Private Attachment Directory**
The directory and pathname used for storing Private attachment files.

**Public Referential Attachment Directory**
The directory and pathname used for storing Public Referential attachment files.

**Private Referential Attachment Directory**
The directory and pathname used for storing Private Referential attachment files.

---

**Viewing or Modifying Information About Your KWS Database Connection**

To view or modify your KWS database connection information:

1. Select **Admin** from the KWS Menu Bar.

2. Select **Setup Database Connections** from the **Admin** Menu. The KWS Databases Window will be displayed listing all of the connections you have defined (Figure 7-15).
3. Select the database for which you want to view information.

4. Click the Modify button. The KWS Database Setup Dialog Box will be displayed.

5. Click the Cancel button to exit without making modifications. Enter your desired changes and click the OK button to save changes.

![KWS Databases](image)

Figure 7-15: KWS Databases Window

**ADDING ITEMS TO THE TOOLS MENU**

The Tools Menu in the KWS Menu Bar provides access to applications you can use to enhance your KWS environment. KWS is initially installed with the Task Palette, DotlBase, and TimeAgent applications included in the Tools Menu. If desired, you can include additional applications in your Tools Menu so they can be launched directly from KWS.

*Adding Items to the Tools Menu*

**To add items to the Tools Menu:**

1. Open your KWS.INI file (located in the Windows directory) using any ASCII file editor.

2. In the Tools section of your KWS.INI file, enter the items you would like to include using the following syntax:

   `ITEM<#>=<executable filename>,<name>`

   where  
   `<#>` is the location of the item in the menu  
   `<executable filename>` is the full path and filename required for executing the application  
   `<name>` is the name you want to display in the Tools Menu.

   The following example will cause two items to display in order at the bottom of the Tools Menu.

   ```
   [TOOLS]
   ITEM1=c:\windows\calc.exe,Calculator
   ITEM2=c:\windows\cardfile.exe,Cardfile
   ```

3. Save and exit the KWS.INI file.
Index

Admin Menu
- Database: 1-8; 7-23 thru 7-25
- Entire Database, listing of Knowledge Workers: 1-9; 1-27
- Master Applications List: 1-8; 7-14 thru 7-19
- Selected Task, listing of Work Group: 1-9; 1-27

Application List
- Adding to: 1-4; 7-12 thru 7-17
- Command Line, modifying: 7-14
- Deleting an Entry: 7-14
- Private Application Names: 7-16
- Private Template, creating: 7-14
- Private Template, editing: 7-14

Appointments
- Deleting: 2-10 thru 2-12
- Entering: 2-11
- Linking Attachments to: 2-11
- Linking Do It's to: 2-12
- Modifying: 2-11

Archive
- Adding: 5-16
- Copying: 5-17
- Deleting: 5-17
- Modifying: 5-17
- Viewing: 5-17

Associations
- Access Rights: 1-4; 7-10
- Application Used To Create Context, entering: 4-4
- Copying to Another Item: 4-16
- Creating Versions of: 4-14
- Deleting: 4-10
- Description, entering: 4-3
- File, viewing/modifying/exporting: 4-12/13
- Inserting: 4-9
- Linking to Another Item: 4-7; 4-16
- Links, moving: 4-15
- Multiple Copies of: 4-13
- Profile, viewing/modifying: 4-11/12
- Saving to Removable Media: 4-19
- Searching for: 4-21
- Sensitive, creating: 4-17
- Storage Type, entering: 4-4
- Title, entering: 4-3

Type
- 4-5; 4-23 thru 4-25
- Window Options, accessing: 1-13; 1-18; 4-9

Automatic Login (Tip)
- 1-25

Available Options Menus
- 1-15 thru 1-18 Opening: 1-16

Button Bar
- 1-2; 1-4; 7-2
- Options: 1-11 thru 1-15

Calendar (see ToDo Calendar)

Cyclic Tasks
- Cycle Type, entering: 3-11
- Deleting: 3-27
- Entering: 3-11
- Inserting: 3-25
- Last Cycle, entering: 3-11
- Marking: 3-10
- Modifying: 3-26
- Template: 3-24
- Types: 3-24

Data Fields
- Application List: 7-13
- Appointments: 2-10
- Archive Detail [DoltBase]: 5-16
- Attachment Profile: 4-2 thru 4-7
  - KWS-generated: 4-7
- Cyclic Types: 3-24/25
- Do It: 5-2 thru 5-6
- Knowledge Worker: 7-18
- Work Group: 7-21
- KWS Database Setup: 7-24
- Messages: 1-22
- Print Field Setup: 7-8/9
- Task: 3-2 thru 3-18
  - KWS-generated: 3-16 thru 3-18
- Task Palette: 6-8/9
- Task Security: 3-12 thru 3-14
- Time Agent: 5-9 thru 5-13

Dialog Boxes
- Add DoltBase: 5-15
- Archive Detail: 5-16
- Application List: 7-13
- Appointment: 2-11
- Attachment Access Rights: 4-6; 4-18; 4-24
- Attachment Delete: 4-11
- Attachment Insert: 4-10
- Attachment Profile: 4-2; 4-19
- Attachment Search: 4-21; 4-23
- Confirm Move or Copy: 5-8
- Copy Links?: 4-14
- Delete?: 2-11; 4-11
- Delete Cyclic Task?: 3-27
- Delete Palette: 6-5
### Dialog Boxes (Cont’d)

<table>
<thead>
<tr>
<th>Command</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Do It</td>
<td>5-2</td>
</tr>
<tr>
<td>DolitBase Properties</td>
<td>5-19</td>
</tr>
<tr>
<td>Find [DolitBase]</td>
<td>5-20</td>
</tr>
<tr>
<td>Insert Removable Media</td>
<td>4-20</td>
</tr>
<tr>
<td>Knowledge Worker</td>
<td>7-18</td>
</tr>
<tr>
<td>KWS Database Setup</td>
<td>7-23</td>
</tr>
<tr>
<td>Login</td>
<td>1-25</td>
</tr>
<tr>
<td>Message</td>
<td>1-23</td>
</tr>
<tr>
<td>Milestone</td>
<td>3-33</td>
</tr>
<tr>
<td>Modify Attachment Links</td>
<td>4-16</td>
</tr>
<tr>
<td>New Messages</td>
<td>1-21</td>
</tr>
<tr>
<td>Open DolitBase</td>
<td>5-14</td>
</tr>
<tr>
<td>Open Palette</td>
<td>6-3</td>
</tr>
<tr>
<td>Palette Permissions</td>
<td>6-7</td>
</tr>
<tr>
<td>Save As [Task Palette]</td>
<td>6-4</td>
</tr>
<tr>
<td>Save to Removable Media</td>
<td>4-20</td>
</tr>
<tr>
<td>Step</td>
<td>3-43</td>
</tr>
<tr>
<td>Task</td>
<td>3-2  thru 3-18</td>
</tr>
<tr>
<td>Task [Task Palette]</td>
<td>6-8</td>
</tr>
<tr>
<td>Task Attributes [Task Palette]</td>
<td>6-5</td>
</tr>
<tr>
<td>Task Description</td>
<td>3-15</td>
</tr>
<tr>
<td>Task Security</td>
<td>3-12</td>
</tr>
<tr>
<td>Workflow Definition</td>
<td>4-26</td>
</tr>
<tr>
<td>Work Group</td>
<td>7-21</td>
</tr>
</tbody>
</table>

### Display Fields

<table>
<thead>
<tr>
<th>Display Field</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display Fields</td>
<td>7-4/5</td>
</tr>
<tr>
<td>Display Font</td>
<td>1-4/7-3</td>
</tr>
</tbody>
</table>

### DolitBase

<table>
<thead>
<tr>
<th>Command</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adding</td>
<td>5-15</td>
</tr>
<tr>
<td>Building Automatically</td>
<td>5-18</td>
</tr>
<tr>
<td>Opening</td>
<td>5-14</td>
</tr>
<tr>
<td>Reconciling</td>
<td>5-19</td>
</tr>
<tr>
<td>Searching</td>
<td>5-19</td>
</tr>
<tr>
<td>Starting</td>
<td>5-14</td>
</tr>
<tr>
<td>Command, entering</td>
<td>5-3</td>
</tr>
<tr>
<td>Copying</td>
<td>5-9</td>
</tr>
<tr>
<td>Deleting</td>
<td>5-7</td>
</tr>
<tr>
<td>Executing</td>
<td>5-8</td>
</tr>
<tr>
<td>Execution Mode</td>
<td>5-5</td>
</tr>
<tr>
<td>Inserting</td>
<td>5-7</td>
</tr>
<tr>
<td>Modifying</td>
<td>5-7</td>
</tr>
<tr>
<td>Moving</td>
<td>5-8</td>
</tr>
<tr>
<td>Parameters, Optional</td>
<td>5-4</td>
</tr>
<tr>
<td>Title, entering</td>
<td>5-3</td>
</tr>
<tr>
<td>Window Options</td>
<td>1-14/5-6/7</td>
</tr>
<tr>
<td>Window Size, entering</td>
<td>5-5</td>
</tr>
<tr>
<td>Working Directory</td>
<td>5-4</td>
</tr>
</tbody>
</table>

### Edit Menu

<table>
<thead>
<tr>
<th>Command</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy</td>
<td>1-5</td>
</tr>
<tr>
<td>Paste</td>
<td>1-5</td>
</tr>
<tr>
<td>Select All</td>
<td>1-5</td>
</tr>
<tr>
<td>Email</td>
<td>1-24</td>
</tr>
</tbody>
</table>

### File Associations

<table>
<thead>
<tr>
<th>Component</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>File Menu</td>
<td>1-3 thru 1-5</td>
</tr>
<tr>
<td>Messages</td>
<td>1-3; 1-21 thru 1-24</td>
</tr>
<tr>
<td>Accessing</td>
<td>1-21</td>
</tr>
<tr>
<td>Deleting</td>
<td>1-23</td>
</tr>
<tr>
<td>Marking</td>
<td>1-23</td>
</tr>
<tr>
<td>Modifying</td>
<td>1-23</td>
</tr>
<tr>
<td>Reading</td>
<td>1-22</td>
</tr>
<tr>
<td>Sending</td>
<td>1-23</td>
</tr>
<tr>
<td>Login</td>
<td>1-3; 1-25; 7-23</td>
</tr>
<tr>
<td>Preferences</td>
<td>1-3; Chapter 7; 3-41 thru 3-43</td>
</tr>
<tr>
<td>Print</td>
<td>1-26; 1-3</td>
</tr>
<tr>
<td>Exit</td>
<td>1-5</td>
</tr>
</tbody>
</table>

### File Viewer

<table>
<thead>
<tr>
<th>Component</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Font (See Display Font)</td>
<td></td>
</tr>
</tbody>
</table>

### Gannt Chart

<table>
<thead>
<tr>
<th>Component</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gannt Chart</td>
<td>3-35 thru 3-37</td>
</tr>
</tbody>
</table>

### Graphical Task Manager

<table>
<thead>
<tr>
<th>Component</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Changes, saving</td>
<td>3-40</td>
</tr>
<tr>
<td>Child Tasks, viewing</td>
<td>3-36</td>
</tr>
<tr>
<td>Display Preferences</td>
<td>3-41</td>
</tr>
<tr>
<td>Percent Complete, changing in</td>
<td>3-37</td>
</tr>
</tbody>
</table>

### Help Menu

<table>
<thead>
<tr>
<th>Component</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>About KWS</td>
<td>1-11</td>
</tr>
<tr>
<td>Contents</td>
<td>1-11</td>
</tr>
<tr>
<td>How to Use Help</td>
<td>1-11</td>
</tr>
<tr>
<td>Search for Help on ...</td>
<td>1-11</td>
</tr>
</tbody>
</table>

### Indicator Columns

<table>
<thead>
<tr>
<th>Component</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Indicator Columns</td>
<td>2-3/4</td>
</tr>
</tbody>
</table>

### KWS Database

<table>
<thead>
<tr>
<th>Component</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection</td>
<td>7-24</td>
</tr>
<tr>
<td>Exiting</td>
<td>1-5</td>
</tr>
<tr>
<td>Listing All Tasks</td>
<td>1-27</td>
</tr>
<tr>
<td>Topic</td>
<td>Page Numbers</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>-----------------------</td>
</tr>
<tr>
<td>KWS Database (Cont’d)</td>
<td>1-27</td>
</tr>
<tr>
<td>Listing Selected Tasks</td>
<td>1-27</td>
</tr>
<tr>
<td>kws.ini File</td>
<td>7-25</td>
</tr>
<tr>
<td>KWS User List</td>
<td>7-17</td>
</tr>
<tr>
<td>Modifying</td>
<td>7-17</td>
</tr>
<tr>
<td>Selected User ID in Work Groups</td>
<td>7-19</td>
</tr>
<tr>
<td>Viewing</td>
<td>7-17</td>
</tr>
<tr>
<td>KWS Window</td>
<td>1-14 thru 1-15</td>
</tr>
<tr>
<td>Button Bar</td>
<td>7-2</td>
</tr>
<tr>
<td>Configuration</td>
<td>7-2</td>
</tr>
<tr>
<td>Letting Another User Log In</td>
<td>1-25</td>
</tr>
<tr>
<td>Logging Into</td>
<td>1-25</td>
</tr>
<tr>
<td>Status Bar</td>
<td>7-2</td>
</tr>
<tr>
<td>Printing From</td>
<td>1-26</td>
</tr>
<tr>
<td>Starting</td>
<td>1-25</td>
</tr>
<tr>
<td>MDI Window</td>
<td>1-6; 3-19</td>
</tr>
<tr>
<td>Menu Bar</td>
<td>1-2; 1-3</td>
</tr>
<tr>
<td>thru 1-11</td>
<td>1-2; 1-3</td>
</tr>
<tr>
<td>Message Window</td>
<td>1-12</td>
</tr>
<tr>
<td>Milestones</td>
<td>1-7; 3-32</td>
</tr>
<tr>
<td>thru 3-33</td>
<td>1-7; 3-32</td>
</tr>
<tr>
<td>Inserting</td>
<td>3-33</td>
</tr>
<tr>
<td>Viewing</td>
<td>3-32</td>
</tr>
<tr>
<td>Notes Command</td>
<td>1-9; 1-24</td>
</tr>
<tr>
<td>Accessing Notes</td>
<td>1-24</td>
</tr>
<tr>
<td>Modifying Notes</td>
<td>1-24</td>
</tr>
<tr>
<td>Palettes</td>
<td>6-2</td>
</tr>
<tr>
<td>Predecessor/ Successor Tasks</td>
<td>3-40 thru 3-41</td>
</tr>
<tr>
<td></td>
<td>3-29 thru</td>
</tr>
<tr>
<td></td>
<td>3-32; 4-25</td>
</tr>
<tr>
<td>Creating</td>
<td>3-30</td>
</tr>
<tr>
<td>Deleting</td>
<td>3-31</td>
</tr>
<tr>
<td>Viewing</td>
<td>3-31</td>
</tr>
<tr>
<td>Print IDs (replaceable)</td>
<td>7-6</td>
</tr>
<tr>
<td>Printer Field Setup</td>
<td>7-7 thru 7-9</td>
</tr>
<tr>
<td>Printer Font</td>
<td>7-7; 1-4</td>
</tr>
<tr>
<td>Printing From KWS</td>
<td>1-26</td>
</tr>
<tr>
<td>Printer Page Setup</td>
<td>7-6; 1-4</td>
</tr>
<tr>
<td>Private Tasks</td>
<td>2-5; 3-16;</td>
</tr>
<tr>
<td></td>
<td>3-22; 6-4</td>
</tr>
<tr>
<td>Program Window</td>
<td>1-2 thru 1-3</td>
</tr>
<tr>
<td>Public Tasks</td>
<td>2-6; 3-16;</td>
</tr>
<tr>
<td></td>
<td>3-22; 3-34;</td>
</tr>
<tr>
<td></td>
<td>4-23 thru</td>
</tr>
<tr>
<td></td>
<td>4-24; 6-4</td>
</tr>
<tr>
<td>Query-by-Example (QBE)</td>
<td>4-21</td>
</tr>
<tr>
<td>Query Menu</td>
<td>4-21 thru 4-23;</td>
</tr>
<tr>
<td></td>
<td>1-5</td>
</tr>
<tr>
<td>Do It Search</td>
<td>1-6</td>
</tr>
<tr>
<td>Task Queries</td>
<td>1-6</td>
</tr>
<tr>
<td>Search Text in Window</td>
<td>1-20 thru 1-21;</td>
</tr>
<tr>
<td></td>
<td>1-6</td>
</tr>
<tr>
<td>Refreshing Windows</td>
<td>1-26</td>
</tr>
<tr>
<td>Save Window Configuration</td>
<td>7-2; 1-4</td>
</tr>
<tr>
<td>Search</td>
<td>1-20</td>
</tr>
<tr>
<td>Security</td>
<td>3-12; 3-23;</td>
</tr>
<tr>
<td></td>
<td>4-6; 4-17; 4-23</td>
</tr>
<tr>
<td>thru 4-24;</td>
<td>4-28; 6-6</td>
</tr>
<tr>
<td>KW/Group, selecting</td>
<td>3-12</td>
</tr>
<tr>
<td>Task Delete Permission</td>
<td>3-13</td>
</tr>
<tr>
<td>Task Update Permission</td>
<td>3-13</td>
</tr>
<tr>
<td>Status Bar</td>
<td>1-2; 1-4; 7-2</td>
</tr>
<tr>
<td>Status Symbol Menu</td>
<td>2-4</td>
</tr>
<tr>
<td>Steps</td>
<td>3-45</td>
</tr>
<tr>
<td></td>
<td>3-44</td>
</tr>
<tr>
<td></td>
<td>3-45</td>
</tr>
<tr>
<td></td>
<td>3-46</td>
</tr>
<tr>
<td></td>
<td>3-45</td>
</tr>
<tr>
<td></td>
<td>3-44</td>
</tr>
<tr>
<td>Storage Types</td>
<td>4-18/19; 7-16</td>
</tr>
<tr>
<td>Symbols</td>
<td>2-2 thru 2-4;</td>
</tr>
<tr>
<td></td>
<td>2-2 thru 2-4;</td>
</tr>
<tr>
<td></td>
<td>4-8</td>
</tr>
<tr>
<td>Task Description</td>
<td>3-15</td>
</tr>
<tr>
<td>Task Menu</td>
<td>3-19 thru 3-23;</td>
</tr>
<tr>
<td></td>
<td>1-6</td>
</tr>
<tr>
<td>Task Manager</td>
<td>3-19 thru 3-23;</td>
</tr>
<tr>
<td></td>
<td>1-6</td>
</tr>
<tr>
<td>Attachments, accessing</td>
<td>3-20</td>
</tr>
<tr>
<td>Do Its, accessing</td>
<td>3-20</td>
</tr>
<tr>
<td>Opening</td>
<td>3-20</td>
</tr>
<tr>
<td>Parent Tasks, accessing</td>
<td>3-21</td>
</tr>
<tr>
<td>Private Tasks, converting to Public Tasks</td>
<td>3-22</td>
</tr>
<tr>
<td>Public Tasks, inserting</td>
<td>3-21</td>
</tr>
<tr>
<td>Sibling Tasks, accessing</td>
<td>3-21</td>
</tr>
<tr>
<td>Steps, accessing</td>
<td>3-20</td>
</tr>
<tr>
<td>Task Permissions, assigning</td>
<td>3-22</td>
</tr>
<tr>
<td>Task Status, changing</td>
<td>3-22</td>
</tr>
<tr>
<td>Task Tree, viewing</td>
<td>3-20</td>
</tr>
<tr>
<td>Tasks, deleting/modifying moving and copying</td>
<td>3-22</td>
</tr>
<tr>
<td>Task Owner</td>
<td>3-8</td>
</tr>
<tr>
<td>Task Palette</td>
<td>6-2 thru 6-9</td>
</tr>
<tr>
<td>Always on Top Option</td>
<td>6-7</td>
</tr>
<tr>
<td>Arrange Icons Option</td>
<td>6-7</td>
</tr>
<tr>
<td>Copying a</td>
<td></td>
</tr>
<tr>
<td>Palette Task to KWS</td>
<td>6-4</td>
</tr>
<tr>
<td>KWS Task to Palette</td>
<td>6-4</td>
</tr>
<tr>
<td>Task Palette (Cont'd)</td>
<td></td>
</tr>
<tr>
<td>----------------------------</td>
<td>---</td>
</tr>
<tr>
<td>Creating</td>
<td>6-3</td>
</tr>
<tr>
<td>Deleting a Palette</td>
<td>6-5</td>
</tr>
<tr>
<td>Deleting a Palette Task</td>
<td>6-6</td>
</tr>
<tr>
<td>Opening</td>
<td>6-2</td>
</tr>
<tr>
<td>Permissions, setting</td>
<td>6-6</td>
</tr>
<tr>
<td>Prompt for Icon Name Option</td>
<td>6-7</td>
</tr>
<tr>
<td>Saving</td>
<td>6-4</td>
</tr>
<tr>
<td>Settings, changing</td>
<td>6-7</td>
</tr>
<tr>
<td>Starting</td>
<td>6-2</td>
</tr>
<tr>
<td>Task, viewing/editing</td>
<td>6-7</td>
</tr>
<tr>
<td>Task name, editing</td>
<td>6-6</td>
</tr>
<tr>
<td>Task Status</td>
<td></td>
</tr>
<tr>
<td>Changing</td>
<td>2-5</td>
</tr>
<tr>
<td>Entering</td>
<td>3-10</td>
</tr>
<tr>
<td>Task Template</td>
<td>3-24</td>
</tr>
<tr>
<td>Task Tree</td>
<td>3-25</td>
</tr>
<tr>
<td>Task Window</td>
<td>1-12</td>
</tr>
<tr>
<td>Tasks</td>
<td>2-4 thru 2-6; 3-2 thru 3-12</td>
</tr>
<tr>
<td>Adding Private Tasks</td>
<td>2-5</td>
</tr>
<tr>
<td>Adding Public Tasks</td>
<td>2-6</td>
</tr>
<tr>
<td>Assigned by, entering</td>
<td>3-8</td>
</tr>
<tr>
<td>Assigned to, entering</td>
<td>3-7</td>
</tr>
<tr>
<td>Date due, entering</td>
<td>3-4</td>
</tr>
<tr>
<td>Date finished, entering</td>
<td>3-6</td>
</tr>
<tr>
<td>Date started, entering</td>
<td>3-5</td>
</tr>
<tr>
<td>Deleting</td>
<td>2-6</td>
</tr>
<tr>
<td>Description Button</td>
<td>3-15</td>
</tr>
<tr>
<td>Designating as a ToDo Item</td>
<td>3-3</td>
</tr>
<tr>
<td>Duration, entering</td>
<td>3-5</td>
</tr>
<tr>
<td>ID, entering</td>
<td>3-4</td>
</tr>
<tr>
<td>Manipulating</td>
<td>2-4</td>
</tr>
<tr>
<td>Marking as Cyclic</td>
<td>3-10</td>
</tr>
<tr>
<td>Modifying</td>
<td>2-5</td>
</tr>
<tr>
<td>Percent complete, entering</td>
<td>3-7</td>
</tr>
<tr>
<td>Percent effort, entering</td>
<td>3-6</td>
</tr>
<tr>
<td>Performed by, entering</td>
<td>3-7</td>
</tr>
<tr>
<td>Priority, entering</td>
<td>3-12</td>
</tr>
<tr>
<td>Status Button</td>
<td>3-14</td>
</tr>
<tr>
<td>Status Change, entering</td>
<td>3-9</td>
</tr>
<tr>
<td>Task Owner, entering</td>
<td>3-8</td>
</tr>
<tr>
<td>Task Status, entering</td>
<td>3-10</td>
</tr>
<tr>
<td>Title, entering</td>
<td>3-3</td>
</tr>
<tr>
<td>Text Strings, search for</td>
<td>1-20</td>
</tr>
<tr>
<td>Time Agents</td>
<td></td>
</tr>
<tr>
<td>Adding</td>
<td>5-10</td>
</tr>
<tr>
<td>Copying</td>
<td>5-13</td>
</tr>
<tr>
<td>Deleting</td>
<td>5-13</td>
</tr>
<tr>
<td>Executing</td>
<td>5-9</td>
</tr>
<tr>
<td>Modifying</td>
<td>5-13</td>
</tr>
<tr>
<td>Refreshing</td>
<td>5-13</td>
</tr>
<tr>
<td>Time-Contingent Do Its</td>
<td>5-9; 5-13</td>
</tr>
<tr>
<td>Title Bar</td>
<td>1-2</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>ToDo Menu</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>ToDo</td>
<td>1-7/8; 2-6 thru 2-12</td>
</tr>
<tr>
<td>Browser</td>
<td>1-7; 2-7; 3-34</td>
</tr>
<tr>
<td>Calendar</td>
<td>1-7; 2-8</td>
</tr>
<tr>
<td>Completed Items</td>
<td>1-7; 2-7</td>
</tr>
<tr>
<td>Graph</td>
<td>1-7; 2-12</td>
</tr>
<tr>
<td>Ongoing Items</td>
<td>1-7; 2-7</td>
</tr>
<tr>
<td>Opening</td>
<td>2-8</td>
</tr>
<tr>
<td>Resizing</td>
<td>2-9</td>
</tr>
<tr>
<td>Selecting Items in</td>
<td>2-9</td>
</tr>
<tr>
<td>Tools Menu</td>
<td>1-9; 7-25</td>
</tr>
<tr>
<td>Adding Items to</td>
<td>7-25</td>
</tr>
<tr>
<td>Task Palette</td>
<td>1-9; 6-2 thru 6-9</td>
</tr>
<tr>
<td>Time Agent</td>
<td>1-9; 5-2 thru 5-13</td>
</tr>
<tr>
<td>DoItBase</td>
<td>1-9; 5-13 thru 5-20</td>
</tr>
<tr>
<td>Windows</td>
<td></td>
</tr>
<tr>
<td>Appointment</td>
<td>2-10</td>
</tr>
<tr>
<td>Attachment Links</td>
<td>4-8; 4-15</td>
</tr>
<tr>
<td>Attachment Search Results</td>
<td>4-23</td>
</tr>
<tr>
<td>Attachments</td>
<td>4-8</td>
</tr>
<tr>
<td>Color, select</td>
<td>3-42</td>
</tr>
<tr>
<td>Display Field Setup</td>
<td>7-4</td>
</tr>
<tr>
<td>Dols</td>
<td>5-6</td>
</tr>
<tr>
<td>File Extension Association</td>
<td>7-11</td>
</tr>
<tr>
<td>File Viewer, select</td>
<td>7-12</td>
</tr>
<tr>
<td>Font</td>
<td>7-3</td>
</tr>
<tr>
<td>Graphical Task Manager</td>
<td>3-34</td>
</tr>
<tr>
<td>Graph Preferences</td>
<td>3-41</td>
</tr>
<tr>
<td>Knowledge Workers</td>
<td>7-17</td>
</tr>
<tr>
<td>KWS Databases</td>
<td>7-25</td>
</tr>
<tr>
<td>KWS DoItBase</td>
<td>5-14; 5-15</td>
</tr>
<tr>
<td>KWS Palette</td>
<td>6-2/3</td>
</tr>
<tr>
<td>KWS Program Window</td>
<td>1-2</td>
</tr>
<tr>
<td>KWS TimeAgent</td>
<td>5-10</td>
</tr>
<tr>
<td>Messages</td>
<td>1-22</td>
</tr>
<tr>
<td>Milestone</td>
<td>3-33</td>
</tr>
<tr>
<td>Multiple Items</td>
<td></td>
</tr>
<tr>
<td>performing actions on</td>
<td>1-19</td>
</tr>
<tr>
<td>selecting</td>
<td>1-19</td>
</tr>
<tr>
<td>New Messages</td>
<td>1-21</td>
</tr>
<tr>
<td>Page Setup</td>
<td>7-6</td>
</tr>
<tr>
<td>Predecessor/Successor</td>
<td>3-30</td>
</tr>
<tr>
<td>Print Field Setup</td>
<td>7-8</td>
</tr>
<tr>
<td>Print IDs</td>
<td>7-7</td>
</tr>
<tr>
<td>Printer Page Setup</td>
<td>7-6</td>
</tr>
<tr>
<td>Search</td>
<td>1-20</td>
</tr>
<tr>
<td>Step</td>
<td>3-43/44</td>
</tr>
<tr>
<td>Task</td>
<td>3-19</td>
</tr>
<tr>
<td>Task Group Status</td>
<td>3-14</td>
</tr>
<tr>
<td>Task Manager</td>
<td>3-19</td>
</tr>
<tr>
<td>Windows (Cont’d)</td>
<td>Work Groups</td>
</tr>
<tr>
<td>-----------------------------------------</td>
<td>-------------------------------------------------</td>
</tr>
<tr>
<td>Time Agent Event Detail</td>
<td>7-19 thru 7-25;</td>
</tr>
<tr>
<td>ToDo</td>
<td>1-8; 3-9; 3-12;</td>
</tr>
<tr>
<td></td>
<td>3-14 thru 3-15;</td>
</tr>
<tr>
<td>Browser</td>
<td>7-19</td>
</tr>
<tr>
<td>Calendar</td>
<td></td>
</tr>
<tr>
<td>Completed Items</td>
<td></td>
</tr>
<tr>
<td>List</td>
<td></td>
</tr>
<tr>
<td>Ongoing Items</td>
<td></td>
</tr>
<tr>
<td>View Zip File</td>
<td>7-20</td>
</tr>
<tr>
<td>Work Flow Process</td>
<td></td>
</tr>
<tr>
<td>Work Groups</td>
<td>7-22</td>
</tr>
<tr>
<td>Containing &lt;user ID&gt;</td>
<td></td>
</tr>
<tr>
<td>Window Menu</td>
<td>7-21</td>
</tr>
<tr>
<td>Arrange Icons</td>
<td></td>
</tr>
<tr>
<td>Cascade</td>
<td>7-22</td>
</tr>
<tr>
<td>Close</td>
<td></td>
</tr>
<tr>
<td>Display Field Setup</td>
<td></td>
</tr>
<tr>
<td>Options (in active window)</td>
<td></td>
</tr>
<tr>
<td>Printer Field Setup</td>
<td></td>
</tr>
<tr>
<td>Refresh</td>
<td></td>
</tr>
<tr>
<td>Save Changes to Graph</td>
<td></td>
</tr>
<tr>
<td>Tile</td>
<td></td>
</tr>
<tr>
<td></td>
<td>4-24 thru 4-28;</td>
</tr>
<tr>
<td></td>
<td>4-9</td>
</tr>
<tr>
<td>Attachment</td>
<td>4-28</td>
</tr>
<tr>
<td>accessing</td>
<td></td>
</tr>
<tr>
<td>creating copies of</td>
<td></td>
</tr>
<tr>
<td>Definition, copying/linking</td>
<td>4-27</td>
</tr>
<tr>
<td>Path, defining</td>
<td>4-25</td>
</tr>
<tr>
<td>Workspace Area</td>
<td>1-2</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>